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Documentation Conventions

OPNET documentation uses specific formatting and typographic conventions to present
the following types of information:

Objects, examples, and system 1/O
Object hierarchies, notes, and warnings
Computer commands

Lists and procedures

Objects, Examples, and System 1/O

Directory paths and file names are in plain Courier typeface:

opnet\rel ease\ nodel s\std\ip

Function names in body text are in italics:

op_dist_outcome()

The names of functions of interest in example code are in bolded Courier
typeface:

/* determ ne the object I D of packet’s creation nodule */
src_nmod_objid = op_pk_creation_nod_get (pkptr);

Variables are enclosed in angle brackets (< >):

<opnet _user _hone>/ op_adni n/err_| og

Object Hierarchies, Notes, and Warnings

Menu hierarchies are indicated by right angle brackets (>); for example:

Open File > Print Setup > Properties...

Attribute hierarchies are represented by angled arrows (0O) that indicate that you must
drill down to a lower level of the hierarchy:

ITR-FM-iv
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Attribute level 1 O Attribute level 2 O Attribute level 3

Note—Notes are indicated by text with the word Note at the beginning of the
paragraph. Notes advise you of important supplementary information.

WARNING—Warnings are indicated by text with the word WARNING at the
beginning of the paragraph. Warnings advise you of vital information about an
operation or system behavior.

Computer Commands

These conventions apply to Windows systems and navigation methods that use the
standard graphical-user-interface (GUI) terminology such as click, drag, and dialog box.

» Keycombinations appear in the form “press <but t on>+x"; this means press
the <but t on> and x keys at the same time to do the operation.

» The mouse operations left-click (or click) and right-click indicate that you
should press the left mouse button or right mouse button, respectively.

Lists and Procedures

Information is often itemized in bulleted (unordered) or numbered (ordered) lists:
* In bulleted lists, the sequence of items is not important.

* In numbered lists, the sequence of items is important.

Procedures are contained within procedure headings and footings that indicate the start
and end of the procedure. Each step of a procedure is numbered to indicate the
sequence in which you should do the steps. A step may be followed by a description of
the results of that step; such descriptions are preceded by an arrow.

Procedure FM-1 Sample Procedure Format

1 Procedure step.

O Result of the procedure step.
2 Procedure step.

End of Procedure FM-1

For more information about using and maintaining OPNET documentation, see the
OPNET IT Guru Documentation Guide.

IT Guru/Release 11.0
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Document Revision History

Document Revision History

Product
Release Date Version Chapter Description of Change
February 2005 11.0 PL3 Preferences « Clarified precedence of Assignment Mechanisms.
Program * 64-bit kernels now supported on Windows.
Descriptions » Added new op_runsim preferences memstat_autogen,
memtag_all, and memtag_list.

October 2004 11.0 PL1 Preferences » Added new GUI preferences icon_autosizing.disable,
icon_autosizing.large_element_count,
icon_autosizing.max_neighbors,
network_layout.adjust_unconnected_groups,
network_layout.max_overlap_links_to_bend,
network_layout.use_simple_threshold,
title_autoplacing.directions, title_autoplacing.disable, and
title_autoplacing.try_small_font.

Program « Expanded description of parallel_sim.num_processors
Descriptions preference and added it to op_runsim.

August 2004 11.0 Preferences « Added new preferences geocentric_model and
code_editor_prog.

* Removed /G6 from the comp_flags_optim default.

» Added section on Passwords.

Program  Deleted obsolete preferences ov_date, ov_time, and
Descriptions parallel_sim.ui_selected.

« Added new op_runsim preferences log_endsim_per,
realtime_ratio, verbose_event_report, and
verbose_packet_report.

PDE Editor » Added Model Documentation to the PDF Menu Operations.

March 2004 10.5 PL1 Distributions » Added chapter describing distributions

PDF Editor

« Added chapter describing PDF Editor

IT Guru/Release 11.0
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Product
Release Date Version Chapter Description of Change
January 2004 10.5 Protocol Models « Deleted this chapter from the manual. For protocol information,
see the Standard Model User Guides and Specialized Model
User Guides in this document set.
System « Added information on File Names for Compiled Code.
Environment * Replaced .sid and .sio with .repos in File Type Suffixes.
« Added Windows file extensions for object files and libraries in
File Type Suffixes.
Environment » Moved details on Architecture Suffix to System Environment
Attributes chapter.
Program « Added the op_runsim preferences collect_model_deps_in_file,
Descriptions cosim, endsim_memstats, event_order_method,
fully_serialized_event_ids,
fully_serialized_event_execution_ids, fully_serialized_ici_ids,
fully_serialized_packet_ids, max_log_entries,
parallel_sim.event_execution_time_window,
per_module_random_stream, probe_start_time,
probe_stop_time, sim_packet_sharing, sim_process_priority,
site_position_cache_size, sla_compute_all_violations,
split_start_radio_transmission, verbose_cell_size_report,
verbose_event_timing_report, and
verbose_parallel_speedup_report.
September 2003 10.0 Revision History * Section added to this manual.
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Reference Guide

1—System Environment

1 System Environment

Operating System

This chapter describes various aspects of the interface between the IT Guru
system and its operating environment. These aspects include the operating
system, directory structure, and file naming conventions.

The IT Guru system operating environment typically resides on an engineering
workstation. Guru has been separately ported to the native operating system
(OS) of each supported hardware platform. The OS versions supported by

IT Guru, along with other system requirements, are listed on the OPNET web
site at http://www.opnet.com.

The Guru system consists of a set of well-behaved application programs, object
code libraries, and data files. In this context, well-behaved means that the Guru
components interact with the operating system and the user in a predictable
manner that is common to other programs. For instance, Guru programs run as
regular user processes and do not interfere with the operating system’s control
of the computer. In contrast, a non-well behaved program might contain its own
operating system kernel and usurp control of the computer from its native
operating system while it executes.

Whenever possible, the Guru system abides by and fosters the concept of
simple tools with well-defined interfaces that can be combined by the user with
other tools in creative ways.
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File System Organization

For convenience, Guru files are organized into at least three general locations
within the file system. These locations allow files of different types to be stored
separately, as follows:

» The OPNET directory contains Guru system software and standard models.
This directory is described in OPNET Directory (<opnet_dir>) on page ITR-
1-4.

» The administration directory contains configuration and by-product files. This
directory is described in Administration Directory (op_admin) on page ITR-1-
12.

» One or more model directories (in one or more locations) contain user-
developed models. These directories are described in section User Model
Directories on page ITR-1-17.

Components of the licensing system are not stored in the OPNET directory, but
locally, in one of the following locations:

e <primary_hard_drive>:\OPNET_I| i cense (Windows platforms)

The <pri mary_hard_dri ve>isthe firstdrive letter (usually C:) that names
a non-removable, non-network local drive partition.

e /opt/OPNET_I i cense (UNIX platforms)
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Figure 1-1 File System Organization
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OPNET Directory (<opnet_dir>)

The OPNET directory (<opnet _di r >) is the directory where the Guru release
media contents are downloaded. The OPNET directory is an important
reference location on the disk. It is usually represented by the symbol

<opnet _di r >, especially when it appears as part of a path name, as in
<opnet _di r>/ <rel ease>/ sys/i ncl ude.

The symbol <opnet _di r > represents an actual directory located somewhere
in the file system. The user (or system administrator) has the freedom to select
the location of <opnet_dir> and create the directory there; no hardwired location
is required by Guru. One of the typical locations for <opnet _di r > isin the /usr
directory (for example, / usr/ opnet ). This location is beneficial when several
users with different accounts need access to the IT Guru software. In this case,
<opnet_dir> is owned by the root or system administrator account, with read
and execute permissions set up for other accounts.

Another common location for <opnet _di r > is within a user's home directory.
This location is useful when only one user requires access to the Guru software
and it is preferred to handle all system administration tasks locally. In this case,
<opnet _di r > should not be given the name <HOME>/ itguru, because this
name may conflict with execution of the itguru program in the home directory.
Instead, choose a neutral name such as <HOVE>/ opnet .

Because the OPNET directory stores the Guru system software (including
software for different releases or different workstation architectures), there
typically is only one OPNET directory per installation site. Even when several
workstations are used to execute the Guru software, all the workstations can
share one <opnet _di r > located on a file server (via the Network File System,
NFS, or a similar system).

The OPNET directory contains only one type of subdirectory: <r el di r >. The
release directory contains the system software and standard models for a
particular release of Guru. There is always at least one release directory.

When installed, new Guru releases replace the existing files within these two
subdirectories, but the top-level organization remains unchanged. The following
figure depicts this organization.

Figure 1-2 OPNET Directory Organization
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Release Directory (<reldir>)

The release directory (<opnet _di r >/ <r el di r >) contains the complete
software and model files for a specific Guru release. A release is a distinct
version of Guru that typically incorporates new features or major bug fixes. A
release directory is identified by a name such as 11.0.A.

Each release directory contains three subdirectories:

Table 1-1 Contents of the Release Directory

This subdirectory... Contains...

sys the system software for the corresponding release
doc data files used by the documentation viewer
models the models supplied with Guru

End of Table 1-1

The following figure depicts this organization.

Figure 1-3 Release Directory Organization
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If you download a new release or software update into an existing <reldir>
directory, it replaces the existing files within these two subdirectories, but the
top-level organization remains unchanged. Typically, however, a new Guru
release will go into a new <r el di r > directory, in which case any existing

<r el di r > directories (and their contents) remain unchanged. The names and
locations of subdirectories under each <r el di r > directory should not be
modified after installation.

System Directory (sys)

The system directory (<opnet _di r >/ <r el di r >/ sys) contains the Guru
software, including all programs, libraries, and header files. The organization of
sys is copied from the Guru release media and remains fixed. The contents of
sys subdirectories vary somewhat during installation and software updates, but
remain fixed during use of the software (that is, no non-installation programs
modify the contents of the sys directory and its subdirectories).

Because sys contains all of the Guru software, it is a resource that can be
shared by multiple users. It is also possible that more than one version of Guru
will be present at a site, due to different machine architectures. The software for
different architectures is stored in individual <ar ch> subdirectories.

IT Guru/Release 11.0
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The sys directory contains these types of subdirectories:

Table 1-2 Contents of the sys Directory

This subdirectory...

Contains...

<arch> architecture-specific system software. One of these
subdirectories exists for each different workstation
architecture in use.

include header files used during the compilation of process models.

etc miscellaneous files and utilities.

configs configuration files.

icons icon databases used by Guru and by specific GUI-based
programs.

images screen and web images used by Guru.

help data files used by itguru’s help documentation.

End of Table 1-2

The following figure depicts this organization.

Figure 1-4 System Directory Organization

sys

<arch>

configs

etc

help

icons

include

images

ITR-1-6

IT Guru/Release 11.0



Reference Guide 1—System Environment

Architecture Directory (<arch>)

The architecture directory (<opnet _di r>/ <r el di r >/ sys/ <ar ch>) contains
the program executables, object code libraries, and other information needed
for a specific workstation architecture.

Each architecture directory contains one or two subdirectories:

Table 1-3 Contents of the <arch> Directory

This subdirectory... Contains...
bin program executables for the specified architecture.
lib object code libraries that constitute the Simulation Kernel and

GUI reference data files for the specified architecture.

End of Table 1-3

The following figure depicts this organization.

Figure 1-5 Architecture Directory Organization

<arch>

bin lib

In addition, there is one special architecture directory called <opnet _di r >/
<rel di r >/ sys/ uni x. This directory contains only a bin subdirectory, which
contains scripts used under UNIX to set the LD_LIBRARY_PATH preference
and to help Guru automatically locate the correct binaries for the workstation
architecture being used.

Binary Directory (bin)

The binary directory (<opnet _di r >/ <r el di r >/ sys/ <ar ch>/ bi n) contains
Guru programs, C shell scripts, and batch files. These include installation
programs, model building programs, and special utilities.

Library Directory (lib)

The library directory (<opnet _di r >/ <rel di r >/ sys/ <arch>/1i b) contains
the Guru library and reference data files.
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Include Directory (include)

The include directory (<opnet _di r >/ <rel di r >/ sys/i ncl ude) contains
the Guru header files. Header files are C language files that contain symbolic
constants, data structure definitions, and preprocessor macros. Each of the
header files contained in include has the conventional “.h” suffix. Explanations
of individual header files are not provided here because you do not need to
individually reference these files.

Miscellaneous Directory (etc)

The miscellaneous directory (<opnet _di r>/ <rel di r>/ sys/ et c) contains
miscellaneous files and utilities.

Configuration Directory (configs)

The configuration directory (opnet _di r>/ <r el di r>/ sys/ confi gs)
contains files used to specify the configuration of the user interface, such as
menu items and shortcuts. These files have the file extension “.ets”.

Icon Directory (icons)

The icon directory (opnet _di r>/ <rel di r>/ sys/i cons) is the standard
location for files containing icons used by GUI-based programs. (Another
common location is each user’s administration directory.) lcon databases can
be stored anywhere, however, so long as you specify the location to Guru by
including the icon database directory in the value of the mod_dirs preference.

Icon databases in directories listed earlier in mod_dirs override corresponding
databases in directories specified later in the list. Typically, the system and
program icon databases provided with Guru will remain in the icon directory,
unmodified and unoverridden, and user’s special icons will be stored in the user
icon databases within their administration directories. In this case, the
administration directory should appear before the icon directory in the mod_dirs
list.

ITR-1-8 IT Guru/Release 11.0
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The icon_dbs preference specifies which icon databases a particular Guru
application should use. GUI-based Guru programs use three types of icon
databases:

Table 1-4 Types of Icon Databases

Icon database Contents

sys.icons The system icon database contains icons used in most GUI-
based programs.

<program>.icons Separate program icon databases exist for each GUI-based
program (such as itguru, op_vuanim, and op_edmap). These
databases contain icons specific to the corresponding
program.

<pame>.icons User icon databases contain user-defined icons created with
the Icon Editor.

End of Table 1-4

In addition to the icons in these databases, a special “missing” icon is built into
GUI programs. A program displays this icon when it can locate neither the
specified icon (usually a user-defined icon) nor an appropriate default icon. For
information about restoring a missing icon, see Troubleshooting in the User
Guide.

Image Directory (images)

The image directory (opnet _di r>/ <rel di r >/ sys/ i mages) contains bitmap
image files used by the itguru program, including the splash screen and various
images used by web reports.

Documentation Directory (doc)

The documentation directory (opnet _di r >/ <r el di r >/ doc) contains files for
the <product> documentation and help. These files contain the IT Guru printed
documentation in online form, the Administrator Guide, tutorials, and menu files
for selecting the desired information. These files are stored in Adobe Acrobat
format. It also contains the necessary viewer software.

IT Guru/Release 11.0
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Models Directory (models)

The models directory (opnet _di r >/ <r el di r >/ nodel s) contains the Guru
models that are included on the release media. The organization of models, like
that of sys, is initially obtained from the Guru release media and generally
remains fixed. The models directory usually contains five subdirectories:

Table 1-5 Contents of the models Directory

Subdirectory Contents

std The standard models directory contains OPNET-developed
models of basic nodes and links, plus example network
models.

tutorial_ref The tutorial models directory contains a set of reference files

showing correct results for models created from the tutorials.

contrib The contributed model directory contains models created by
other users and made available to the OPNET user
community.

third_party The third-party model directory contains models created by

third-party vendors. These models must be obtained from the
individual vendors.

compat The compatibility model directory contains models from
previous releases of Guru.

vendor_models This directory contains device models based on many
different sources, including studies conducted at the Harvard
Network Device Test Laboratory and product data from the
device makers.

End of Table 1-5

You can use the models in the std and contrib subdirectories as guides or as a
basis for developing your own network models.

Standard Models Directory (std)

The standard models directory (opnet _di r >/ <r el di r >/ nodel s/ st d)
contains models developed by OPNET and shipped with Guru. These models
include the basic nodes and links used to develop networks, as well as complete
network models.

The organization of std is initially obtained from the Guru release media and
generally remains fixed. The following sections describe the subdirectories of
std and their contents.

ITR-1-10
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Tutorial Reference Models Directory (tutorial_ref)

The tutorial models directory (opnet _di r>/ <rel di r>/ nodel s/tutorial)
contains reference models for the tutorials. Reference models are completed
examples of the files created in each lesson. The required models for the tutorial
exercises are inthe opnet _di r >/ <rel di r>/ nodel s/ std/tutorial _req
directory.

Contributed Models Directory (contrib)

The contributed models directory (opnet _di r>/ <rel di r >/ nodel s/

cont ri b) contains models developed by other users and made available to the
Guru user community free of charge. These models are not supported by
OPNET Technologies, Inc., but may be useful in your modeling efforts. Each
contributed model contains a text file describing its use. You can download the
latest contributed models from the OPNET FTP site. Contact OPNET Technical
Support for information on how to access these models.

Compatibility Models Directory (compat)

The compatibility models directory (opnet _di r>/ <rel di r >/ nodel s/
compat ) holds link and node models converted from earlier Guru releases.
Because many models are modified from one release to the next, these
converted models may be needed to allow older network models to run under a
newer release. Additional details are available in the Release Notes for each
release.

Vendor Models Directory (vendor_models)

The vendor models directory (opnet _di r >/ <r el di r >/ nodel s/

vendor _nodel s) holds models based on a variety of sources, including
studies conducted at the Harvard Network Device Test Laboratories (HNDTL)
and generally-available product data from the device makers.

Note—No proprietary information was provided by device manufacturers.

Licensing System Components

The licensing system consists of three separate data files:

» license_file contains the individual licenses allocated to users. See the
License Manager chapter in the Administrator Guide for details.

» license_server_log contains the log of events kept by the license server. See
the License Server chapter in the Administrator Guide for details.

» app_stats_log contains the usage statistics displayed when you choose
Show Local Server’s Usage Statistics from the License Servers menu of the
License Manager.

IT Guru/Release 11.0
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These files are stored locally, in one of the following locations:

e <primary_hard_drive>:\OPNET_I| i cense (Windows platforms)

The <pri mary_hard_dri ve>isthe firstdrive letter (usually C:) that names
a non-removable, non-network local drive partition.

 /opt/OPNET_license (UNIX platforms)

Administration Directory (op_admin)

The administration directory (<HOME>/op_admin) contains configuration
information and files specific to an individual Guru user, such as:

» program configurations
* model directory paths
» logical key definitions

* model backups

Because the OPNET directory serves as a centralized resource for all users at
a site, it is not an appropriate place to store files that are specific to a particular
user. Such files are best stored in the home directory of each user, where they
can be easily found and are protected by the user’s directory permissions. For
this reason Guru supports individual administration directories in which users
store their personal Guru files.

The administration directory must be named op_admin so that programs can
access it via the shell variable-based path name <HOVE>/ op_adni n. This
requirement stems from Guru’s overall file system organization. Because the
OPNET directory and model directories can be placed anywhere in the file
system, Guru programs must have a fixed location from which to obtain the
locations of these directories. The administration directory serves as a fixed site
for this configuration information relative to the current user’s home directory.

ITR-1-12
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The initial organization of op_admin is established at installation. Two empty
subdirectories and two files are also created within op_admin:

Table 1-6 Contents of the op_admin Directory

Subdirectory Contents

bk The backup directory stores user model backups, which are
automatically created by the itguru program at user-specified
intervals.

tmp The temporary file directory stores any temporary files

created by Guru programs.

env_db11.0 The environment database specifies user configuration data
and preferences for Guru programs (including the above-
mentioned directory location information).

End of Table 1-6

The following figure shows the initial organization of the op_admin directory.

Figure 1-6 Initial Organization of Administration Directory

op_admin

| |
bk tmp env_db9.1

The numerical part of the environment database file name is the Guru release
to which the database applies. The release number prevents conflicts when an
earlier installation is still in use. Guru documentation sometimes refers to these
files generically by omitting the release number (for example, env_db).

Backup Directory (bk)

Guru creates two types of backup files:

» time-based backup files preserve all model files being edited at the time the
backup occurs. You can specify the backup interval (by default set at
15 minutes) with the backup_interval preference.

» version-based backup files are created each time you modify and save an
existing model file. You can specify the number of versions saved with the
backup_max_count preference.

Both types of backups are stored in the backup directory (<HOVE>/ op_admi n/
bk) with file names based on the name of the corresponding model.

IT Guru/Release 11.0 ITR-1-13
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Version-based backups are named following this format:
<nmodel _nanme>_bk. <n><file_type_suffix>

— where <n> is a consecutive number that will not exceed
backup_max_count.

Time-based backup files are named following this format:
<nmodel _nanme>_bk.<fil e type suffix>

If a name has not been assigned to a model when a time-based backup occurs,
it has the default name “unnamed”. This file overwrites any older unnamed
model backups of that type.

The file suffix identifies the type of file. A list of these suffixes appears in Model
File Naming Conventions on page ITR-1-19.

You can make a model backup a regular model file by moving or copying it into
a model directory, using one of the following commands.

Sample UNIX command-line: % nmv net1l bk.nt.mnetl.nt. m
Sample Windows command-line: C:\ > nove netl_bk.nt.mnetl.nt. m

The backup model then appears in the relevant model menus.

Temporary File Directory (tmp)

The temporary file directory (<HOVE>/ op_admi n/ t np) contains temporary
files generated by several Guru programs in the course of execution, such as
the print output files generated by itguru printing operations. There are two
locations where applications traditionally store such files—the current working
directory and the system temporary directory (t np in UNIX, and% nmp%or

C. \ TEMP in Windows). Both of these locations have drawbacks:

» The current directory is an unreliable location for storing temporary files
because it sometimes will not allow their creation due to read-only security
settings.

» Under UNIX, the tmp directory is located in the root (/) partition, which is
commonly allocated minimal free space (typically less than 16 MB). This lack
of space almost invariably leads to serious problems (such as crashed
programs) when tmp fills up with temporary files.

ITR-1-14
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Because of these problems, Guru programs do not use the current directory or
the system temporary directory to store temporary files. Instead, they store
these files in the Guru temporary file directory. This location has three
advantages:

» The permissions for this directory are reliable, because it is created when
Guru is installed.

» The amount of free space in the partition that contains this directory is usually
larger than the amount of free space in the root partition.

» There is greater flexibility for removing unnecessary files.

Temporary File Types and Names

The Guru temporary file directory contains the following types of files:

» PostScript print output files generated by other GUI-based programs. The
names of these files use the following format:

<src_type>. <process_i d>. <sequence_nunp. ps

where <src_type> is either a combination of the model and format or the
name of a user interface component, as given in the following table.

Table 1-7 Values of <src_type>

Source Data Graphics Format Report Format
Project ntgfx ntrep

Screen image fsbitmap

End of Table 1-7

» Message files used for inter-process communication between the itguru
program and executing simulations. The names of these files use the
following formats:

ct p_<process_i d>. <sequence_nun®
pt c_<process_i d>. <sequence_nunp

Message files, which contain text and special flags, normally exist in tmp only
during simulation execution. However, if a simulation terminates abnormally,
message files may be left behind. The message file names are based on the
direction of data transfer: “ctp” (child-to-parent) files are used to send
simulation information to itguru and “ptc” (parent-to-child) files are used to
send itguru information to the simulation.

IT Guru/Release 11.0
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In the preceding name formats, <process_id> is the number of the process that
generated the file and <sequence_num> is an integer representing the order in
which the file was generated by the process, beginning with 0.

Note—Do not confuse the “.ps” suffix of PostScript files with the “.ps.c” and
“.ps.o” suffixes of certain model files.

Temporary File Directory Maintenance

Most of the files stored in tmp have value for a limited time only, after which they
can be removed. Typically, the only files worth keeping are generated
PostScript files that have problems printing and captured graphics or PostScript
files that must periodically be reprinted. You should move such files from tmp
and store them elsewhere to avoid accidental removal.

During periods when a great deal of printing is being performed through itguru,
the temporary directory tends to fill up with files. It is a good idea to periodically

clear out tmp.
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User Model Directories

The IT Guru models you develop are stored in one or more directories called
model directories. The itguru program imposes no fixed location for model
directories; you have complete flexibility in selecting where in the file system
models should be stored. You indicate which directories contain models via a
list stored in the mod_dirs preference (this mechanism is discussed in section
mod_dirs on page ITR-2-22). However, there are several recommended
conventions for model directories; these are initially set up during the installation
procedure.

Because the mod_dirs preference is stored in the environment database
(<HOVE>/ op_admi n/ env_db11.0), each user can specify a different set of
model directories. Typically, you will take advantage of this by storing personal
models in one or more model directories in your home directory. As a
convenience, a model directory named op_models is created in your
administration directory and includes this directory in the list of model
directories. You can change this after installation, completely removing
op_models if desired.

Model Directory Organization

Most users want convenient access to the models provided with the Guru
release media, both for reference and use. All of these models are stored in
subdirectories of the standard models directory (<opnet _di r >/ <rel di r >/
nodel s/ st d). The most important of the standard models are the advanced
models in the base subdirectory, which include fundamental and default
models. Because most Guru users will rely on these models, the base
subdirectory is included in the list of the model directories set up during
installation. The other standard models, which include various applications such
as LANs and mobile networks, are often useful and are also included in the list
of default model directories.

The default list of model directories thus includes several directories:
* op_models in the home directory

» each of the subdirectories in the models directory

IT Guru/Release 11.0 ITR-1-17
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You can modify this simple configuration as more models are developed and a
structure for organizing models is defined. An example of a complex
configuration is shown in the following figure. It includes two subdirectories
under models, several user model directories, and several shared model
directories. This type of configuration is recommended once you become
familiar with IT Guru and need enhanced organization of models.

Figure 1-7 Example of a Complex Model Directory Organization
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i

—
\qeldiplmodels
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i
ethernet

Model Precedence

The order of directories in the mod_dirs list is important because it determines
the precedence of model searches. For instance, if network models named
mt_lan are stored in two different model directories, Guru programs will find the
model stored in the directory listed earlier in the mod_dirs list and ignore the
second model stored in a directory appearing later in the list. Thus, you should
observe the following guidelines when listing model directories (and icon
database directories, with are also listed in mod_dirs):

» Place the default directory for new models first in the mod_dirs list (as
explained in the following, Default Model Directory on page ITR-1-19).

» Place more actively used model directories and directories with custom icon
databases earlier in the list, so that their contents will take precedence in the
event of name conflicts.

» Place subdirectories of the models directory near the end of the list, because
any user models with duplicate names should take precedence over original
models.

» Place the icon directory (icons) last in the list.

ITR-1-18
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Default Model Directory

The first model directory in the mod_dirs list has a special significance and is
termed the default model directory. This directory is the default location where
new models are stored when written out or created by Guru programs. For
instance, if you enter itguru, open a new project, define a new network model,
and save it, it will be stored in the default model directory. If the default model
directory is not the appropriate location for a new model, you can move it to the
desired model directory via the UNIX mv or Windows move command. On the
other hand, models that are not new (because they already exist within the
model directories) are written out to the locations where they were stored when
Guru began execution (or the last time a Rehash operation was invoked in
Guru).

Model File Naming Conventions

Guru programs look for models in the model directories, which are listed in the
mod_dirs preference. Within each model directory, models are stored as ASCII,
binary data, or object code files, on a “one file per model” basis.

Versioning in File Names

Certain model files may be updated from one release to the next, so a version
number (v<n>) is integrated into the file name, as shown in the examples below:

ams_aall _conn_v3.pr.m

ams_support_v2.ex.c

Reference the version number to verify that you are using the most recent
version of a particular model. Version numbers may be included in the following
file types:

» process model files (.pro.m)
» header files (.h)

» packet format files (.pf.m)
 ici format files (.ic.m)

» external code files (.ex.c, .ex.h)

File Names for Compiled Code

Files that contain compiled code (such as object files) are specific to a particular
kernel or machine architecture. Thus, the names of such files contain suffixes
to characterize the code contained in the file.

IT Guru/Release 11.0 ITR-1-19
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Code Type Suffix The file names for object files, repositories, and simulation
executables include a suffix that identifies what kind of code the file contains.
This suffix is used to prevent different compilation modes from overwriting one
another’s files. The code type suffix (listed in Table 1-8) appears before the
architecture suffix, as in si nk. nt dev32. s1. o.

Table 1-8 File Name Suffixes for Code Type

Suffix Type of Code

dev32 32-bit integer, debugging mode, sequential
mtdev32 32-bit integer, debugging mode, parallel
opt32 32-bit integer, optimized mode, sequential
mtopt32 32-bit integer, optimized mode, parallel
dev64 64-bit integer, debugging mode, sequential
mtdev64 64-bit integer, debugging mode, parallel
opt64 64-bit integer, optimized mode, sequential
mtopt64 64-bit integer, optimized mode, parallel

End of Table 1-8

Architecture Suffix All OPNET modelfiles are portable across different machine
architectures. However, simulation executables (. si m), object code files

(. <md>. 0), and simulation archives (. si . a) are specific to a given machine
architecture.

Architectures are characterized by CPU type (which determines the object code
format) and OS type (which determines the variations of library functions). The
architecture suffix incorporates these data items in a two-character code, as
follows:

<CPU_char ><0S_nunber >
The following table defines the architecture codes used by OPNET:

Table 1-9 Architecture Codes

Code CPU Type Operating System Vendor
i0 Intel x86 Windows Microsoft
sl SPARC Solaris Sun
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The architecture suffix is optional. It's use is controlled by a preference,
described in arch_suffix on page ITR-2-16. The following examples show the
names of OPNET files created with arch_suffix set to both FALSE and TRUE.

arch_suffix = FALSE

et h_mac. dev32. pr. obj
eth_net.opt32.sim

File Type Suffixes

arch_suffix = TRUE

et h_mac. dev32.i 0. pr. obj
eth_net.opt32.sl.sim

Guru programs determine the type of each model file from a unique file name
suffix associated with each type. This mechanism is common in the UNIX and
Windows environments, where files are suffixed with a code for the
programming language used (for example, “.c” for C files, “.f" for FORTRAN,
and “.0” for object code). UNIX and Windows suffix conventions are integrated

within the Guru conventions.

The following table lists Guru file suffixes.

Note—Obiject files end in . obj on Windows and . o on UNIX. Libraries end in

.dl | on Windows and . so on UNIX.

Table 1-10 IT Guru File Type Suffixes (Part 1 of 6)

File Type Suffix Description Format
.ac Analysis Configuration binary data
.ace.f ACE Filter Definition ASCII text
.ace.hm ACE Host Mapping (obsolete) ASCII text
.ace.i ACE Import Definition (obsolete) ASCII text
.ace.ic.txt ACE Import Configuration Files ASCII text
.ace.mt.txt ACE Multi-Transaction Report Settings ASCII text
.ace.qpb ACE QuickPredict Bar Chart Templates ASCII text
.ace.gps ACE QuickPredict Graph Templates ASCII text
.ace.rt.txt ACE MS Word Report Settings ASCII text
.ace_dict ACE Protocol Dictionary ASCII text
.ad.m Public Attribute Description binary data
.af Automation Settings File binary data

IT Guru/Release 11.0
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Table 1-10 IT Guru File Type Suffixes (Part 2 of 6)

File Type Suffix Description Format

.agents ACE Agents files ASCII text

.ah Animation History binary data
.alias Alias Modifications ASCII text

.as Animation Script ASCII text
.atc.m ACE Application Task Characterization binary data
.bkg.i Background map Image binary data
.bmp BMP Image binary data

.cds Cartographic Data Set binary data

.cml Custom Model List ASCII text

.csv Comma Separated Values Data File ASCII text
.demand.d Derived Demand Model binary data
.demand.m Demand Model binary data

dict TIF Dictionary binary data
.edge Edge Devices Information ASCII text

.ef Environment File ASCII text

el Iso-Line/Cartographic Data Set binary data
.em.x EMA Application executable form
.esd.m External System Definition Model binary data

.ets External Tool Support File ASCII text
.ets.so External Tool Support shared library
flm Filter Model binary data (editable form)
flx Filter Model binary data (executable form)
.gdf General Purpose Data File ASCII text

.gif GIF Image binary data
.hcon.| Hardware Configuration Library ASCII text

.hip Help File ASCII text
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Table 1-10 IT Guru File Type Suffixes (Part 3 of 6)

File Type Suffix Description Format
.html HTML File ASCII text
Ja Import Assistance File ASCII text
.c.m ICl Format binary data
.icons Icon Database binary data
.image Generic Image binary data
.imp.log Import Log ASCII text
Jk.d Derived Link Model binary data
Jdk.m Link Model binary data
.m.conv Model Conversion Script

.ma Model Assistance File ASCII text
.map.i Image Map binary data
.mce.m Mainframe Workloads binary data
.md.m Modulation binary data
.mid Maplnfo Data Interchange Format File ASCII text
.mif Maplnfo Data Interchange Format File ASCII text
.nd.d Derived Node Model binary data
.nd.m Node Model binary data
.nds Network Diff Selection ASCII text
.nt.log Simulation Log ASCII text
.nt.m Network Model binary data
.nt.so/.nt.dll Network Repository shared library
.of Output Fragments binary data
.orb Satellite Node Orbit binary data
.08 Output Scalars binary data
.ot Output Tables binary data
.otf Fragmented Output Tables binary data
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Table 1-10 IT Guru File Type Suffixes (Part 4 of 6)

File Type Suffix Description Format

.ov Output Vectors binary data

.ovd Output Vector Dictionary ASCII text

.pa.m Antenna Pattern binary data

.path.d Derived path object binary data

.path.m Path object binary data

.pb.m Probe List binary data

.pbr.m Report Probe Model binary data

.pbs.m SLA Probe Model binary data

.pd.m Probability Density Function (PDF) binary data (editable form)
.pd.s Probability Density Function (PDF) binary data (simulation loadable form)
.pdf Portable Document Format (Adobe Acrobat file) binary data

.pf.m Packet Format (obsolete) binary data

.pk.m Packet Format binary data

.ppl.m Public Profile Model binary data

.pps.m Private Profile Storage binary data

.pr.m Process Model binary data form

.prj Project Model object code form
.prop.d Propagation Model binary data

.prop.p Propagation Parameter Set binary data
.prop.r.so TMM Propagation Model shared library

.py ETS Code Python source code
.pyc ETS Code Python byte code
.repos Repository shared library
.repos.so Simulation Repository shared library
.rspdb Response database binary data

.sce.f Server Workload Filter Library binary data
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Table 1-10 IT Guru File Type Suffixes (Part 5 of 6)

File Type Suffix Description Format
.sce.m Server Workloads binary data
.sce.t Server Workload Template binary data
.sce.x Server Workload Export XML

.scf Satellite Configuration binary data
.sched Task Scheduler data (Automation module) binary data
.sched.log Scheduled Tasks Log ASCII text
.sd Simulation Description ASCII text
.sddb Self Description database binary data
.sel.f Logical Object Selection Filter ASCII text
.selset Selection Set file

.seq Simulation Sequence binary data
.sim Simulation Executable executable program
.supr.xmi NetDoctor Suppressions XML

tim Traffic Import Model object code
trj Mobile Node Trajectory ASCII text
.urep.xml User Report Table ASCII text
val.r NetDoctor Rule (Pre-10.0) ASCII text
val.rpt NetDoctor Report Template (Pre-10.5) ASCII text
val.rr NetDoctor Rule ASCII text
val.xrpt NetDoctor Report Template XML

vd.m OPNET Vector Drawing binary data
vdf View Definition File ASCII text
.wdomain.d Derived Wireless Domain binary data
.wdomain.m Wireless Domain binary data
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Table 1-10 IT Guru File Type Suffixes (Part 6 of 6)

File Type Suffix Description Format
.wrc Ul Configuration Resource binary data
xml XML File XML

Xsl XSL file XML

End of Table 1-10
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Customizing the User Interface

You can make the following changes to the Guru user interface:
» Add shortcuts for menu items or change existing ones

* Add optional operations

You accomplish these changes by editing the files that control the interface.
These files have the file extension “.ets” (external tool support).

Editing Keyboard Shortcuts

Shortcuts are key combinations that substitute for selecting a particular menu
item. For example, pressing F1 has the same effect as choosing What's This?
from the Help menu. You can change the defined shortcuts or add new ones.

Procedure 1-1 Adding or Changing a Shortcut
1 From the system prompt, move to the <r el di r >/ sys/ confi gs directory.

2 Locate the .ets file that contains the operation definition of the operation you will
create a shortcut for. Check each of the following files in turn, until you find the
desired operation definition:

« std_itguru_project_operations.ets

std_help_operations.ets

std_edit_operations.ets
« std_shortcut_operations.ets

O Each of these files consists of numerous operation definitions, as shown in the
following example.

# button list for Project Editor
File format: operation |ist

start_operation

menu header: “File”

menu string: “C ose Project”

operati on: exec_builtin close_project
posi tion: 2

shortcut: “etrl-w

separ at or “yes”

end_operation

start_operation

menu header: “File”

menu string: “Save Project”

operati on: exec_builtin save_project
posi tion: 4

shortcut: “ctrl-s”

end_operation

3 Use the text editor’s search capability to locate the operation you want to modify.
The text string shown as “menu string” duplicates the menu item shown in Guru.
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4 Change the shortcut defined, or add a line for a new shortcut. Shortcut keys can
be function keys (<F1>, <F2>) or control key combinations (specified as ctrl-<key>
in the operation definition).

5 Save the changes to the file, close the text editor, and start Guru.

6 Test the new shortcut. Ensure that:
* It appears on the menu list next to the operation.
* It has the functionality intended.

* It appears in the Shortcuts list. This list is displayed when you choose Shortcuts
from the Help menu.

End of Procedure 1-1

Adding Optional Operations

Guru includes code for some optional operations that are not normally included
in the menus, such as the Edit Comment Log operation. You can add action
buttons or menu items for these operations.

Procedure 1-2 Adding an Optional Operation
1 From a system prompt, move to the <rel di r >/ sys/ confi gs directory.
2 In atext editor, openthe std_itguru_project operations. ets file.

3 Add operation definitions for the optional operations to the file. The lines shown
below create the following effects:

» User lock and comment log operations are added to the File menu. User lock is
the last item in the list; comment log is next to last. The position of the menu item
in the list is controlled by the position variable.

 Buttons for both operations appear in the button bar. The position of the button
in the button bar is determined by the order of the operation definition in the file
(for example, the first operation listed will be the left-most button).

start_operation

menu header: “File”

menu string: “Conment Log”

operation: exec_builtin open_coment | og
posi tion: 9998

i con: comrent s

end_operation

start_operation

menu header: “File”

menu string: “User Lock”

operati on: exec_builtin toggle_user_lock
posi tion: 9999

icon: I ock_unl ock

end_operation

4 Save the changes to the file, close the text editor, and start Guru.
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5 Test the new operation. Ensure that:
* It appears on the menu list in the desired position.
* It appears in the button bar in the desired position.

* It has the functionality intended.

End of Procedure 1-2
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2 Preferences

Preferences provide a uniform system for passing options and parameters to
Guru programs. In most cases, you can set the values of preferences from the
Preferences menu item on the Edit menu, as described under Preferences on
page ITU-4-33 of the User Guide. This section describes how preferences work
and gives other methods of setting their values. The later sections describe the
common preferences.

Scope

Preferences can be common or program-specific in scope. Common
preferences are supported by most or all Guru programs. These preferences
are grouped in sets based on their use. The most general of these sets is
described in Standard Preferences on page ITR-2-15 The remaining sets are
described in Preference Sets on page ITR-2-27.

Program-specific preferences apply to one program and provide information
needed by that program alone. These preferences are described with each
program in the Program Descriptions chapter.

You can use any common preference as a program-specific preference by
adding a program-name prefix, as follows

<program nane>. <attri bute_nane>
You can use both the common and program-specific versions of a preference

together. For example, your environment database might include the
assignment:

di ag_enabl e: fal se
This assignment would apply to all Guru programs. You could then override this

assignment for one run and program by specifying the program-specific version
as a command line flag:

<prog_name> -<prog_nane>. di ag_enabl e true

As implied by the preceding example, Guru gives precedence to program-
specific preferences over the corresponding common preferences.
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Data Types
There are several types of preferences, some of which are more common than
others. The four basic types are:
* integer
» double (double-precision real number)
» character string
» boolean (with possible values of TRUE and FALSE)
Other types are:
e password
» lists made from the four basic types:
— integer list
— double list
— string list
— enum (a string list with a defined set of values)
— boolean list
A list is an ordered set of zero or more items of the appropriate type. Each of
these data types has a specific syntax associated with it for performing an
assignment. The syntax varies depending on the assignment mechanism.
Passwords

The password data type is used for preferences that contain a password. To
keep your passwords secure, Guru automatically encrypts password values
before storing them in the environment database. It is very difficult (but not
impossible) to decrypt the value of a password preference to see what it is.

Encrypted passwords appear in the Preferences dialog box and in the
environment database as a case-sensitive string of characters preceded by
“op_password:” and, possibly, terminated by “=" characters. For example:

op_passwor d: X8GU0I 72t 5eX6uywant kQ@E=

If you enter a clear text password directly into the environment database, Guru
automatically encrypts the password the next time it reads the env_db file (at
program start up).

Note—Clear text passwords must never begin with the string “op_password:”.
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Assignment Mechanisms

There are several mechanisms for assigning preference values from the
environment of a program. Consistency among the different mechanisms is kept
as close as possible, given that the mechanisms must abide by traditions
common to the host operating systems. The goal is for any option or parameter
of a program to be assignable using any of these mechanisms (in descending
order of precedence):

* A custom environment (. ef ) file (in one of the mod_dirs directories)
* The command line

» Shell variables

» The default environment database (env_db)

* A product environment file (<pr oduct >. ef ). Product environment files are
located in <rel di r>\ sys\ confi gs\ gl obal _prefs

» The Windows registry

Command line flags and shell variables are universally used mechanisms for
utility programs; environment files and environment databases are Guru-
specific, but similar to the preference files used in other systems (such as the X
Window System). Each mechanism is described separately below.

Command Line Flags

Most UNIX and some Windows programs accept command line flags. It is
standard to precede command line flags with a dash. The UNIX | s directory-
listing program is an example: the - | flag tells Is that it should print an extended
listing of the files in the current directory:

ls -1

Guru programs also abide by the dash convention. Each preference that a
program accepts can be assigned a value via a command line flag composed
of the preference name preceded by a dash and followed by its value. The
following program invocation example has three flags, which set three different
preferences.

op_vuorb -orb _nane leo -smaxis 6700.0 -noon_effects

Most preferences take a value argument: in the preceding example, the
sm_axis preference is assigned the value 6700.0 and the orb_name preference
is assigned the value “leo”. On the other hand, the boolean moon_effects
preference does not need a value argument; merely including it on the
command line is equivalent to setting its value to TRUE.
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The command line syntax for each of the four basic preference types is shown
below:

Table 2-1 Command Line Syntax for Basic Preference Types

Type Syntax Example

integer -<attr_name> <int_value> -size 345

double -<attr_name> <double_value> -mean_anomaly 214.65
string -<attr_name> <string_value> -orb_name statkeep

-site_name "VLA"

boolean -<attr_name> -verbose

-<attr_name> <boolean_value> -verbose OFF

End of Table 2-1

where <boolean_value> is defined to be one of the following strings: On/Off,
True/False, and Enabled/Disabled. These boolean values are not case
sensitive. Any combination of upper- and lower-case letters is valid.

The following syntax considerations apply to preferences used as command line
flags.

Strings that are one word (with no embedded spaces or tabs) can appear
directly after the flag name. Strings consisting of multiple words must be
delimited by double quotes.

Strings that contain a dash (such as negative numbers and flags being
passed to another program) must be specified in one of the following ways:

— Enclose the value in double quotes, with a space character before the
dash. For example: - bi nd_fl ags " -g"

— Change the dash to a caret (which will be converted back to a hyphen
automatically). For example: - bi nd_f | ags “g

Boolean flags have two forms:

— A short form in which no value argument is supplied (the value TRUE is
assumed).

— Along form in which a boolean value argument is supplied.

List preferences use an extension of basic preference syntax. Instead of one
value argument following each preference name flag, there can be more than
one value. An example of a string list preference being assigned via the
command line appears below. In this case, the ef preference is assigned two
strings: “base_orb_defs” and “low_earth_defs”.

op_vuorb -ef base orb _defs | ow earth _defs

ITR-2-4
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The command line flag mechanism for preference passing is useful for
preferences that change on a run-to-run basis (for instance, the “verbose”
preference). However, it is not very convenient for large numbers of
preferences. For programs that require a large number of preferences, itis more
efficient to pass most of the preferences via the environment file mechanism
described under Environment Files on page ITR-2-8.

Shell Variables

Shell variables are an alternative way to pass preferences to Guru programs.
However, they are less convenient than the other mechanisms and are less
likely to be used. Shell variables provide a good mechanism for setting a
preference temporarily (that is, for the lifetime of the current command

interpreter) that is to be passed to a number of programs (or to many invocations
of the same program).

The following tables show assignment syntax for shell variables of the four basic
preference types. The syntax in the first table applies to the C shell (/ bi n/ csh)
available in all supported versions of UNIX. The alternate Korn shell (/ bi n/
ksh), Bourne shell (/ bi n/ sh), and T shell (/ bi n/ t sh) have a slightly different
syntax for shell variable assignments. The second table lists Windows
command interpreter (cnd. exe) syntax.

Table 2-2 UNIX Shell Variable Syntax for Basic Preference Types

Type Syntax Example

integer setenv <attr_name> <int_value> setenv size 345

double setenv <attr_name> <double_value> setenv mean_anomaly 214.65
string setenv <attr_name> <string_value> setenv orb_name statkeep

setenv site_name "VLA"

boolean  setenv <attr_name> <boolean_value> setenv verbose OFF

setenv verbose TRUE

End of Table 2-2

Note—The short form of boolean preferences permitted by command line flags
(including only the flag without a subsequent value argument) is not supported
by shell variables.
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Table 2-3 Windows Shell Variable Syntax for Basic Preference Types

Type Syntax Example

integer set <attr_name>=<int_value> set size=345

double set <attr_name>=<double_value> set mean_anomaly=214.65
string set <attr_name>=<string_value> set orb_name=statkeep

set site_name=VLA

boolean  set <attr_name>=<boolean_value> set verbose=OFF

set verbose=TRUE

End of Table 2-3

Note—Do not use quotes when setting string values in Windows, even if there
are several space-separated words in the value.

The syntax for assigning a sequence of values to list preferences using shell
variables requires delimiters to separate individual values; the delimiter
character is the colon (*:”). An example of a string list preference being assigned
via a shell variable appears below. In this case, the ef preference is assigned
three strings (“base_orb_defs”, “low_earth_defs”, and “options”).

setenv ef "base orb_defs:|ow earth_defs:options"

Under some circumstances, the automatic parsing of shell variables by Guru
programs may be undesirable. For instance, a shell variable assignment that is
not related to Guru may conflict with a preference with the same name; this
might override the correct assignment from the environment database. This is
most likely to occur for preferences with short names, such as “sys”. In such
cases, the conflict can be resolved at the expense of losing access to all shell
variables for preference assignments. To disable parsing of shell variables by
the environment package, set the special boolean preference no_shell to TRUE
(this preference will have its intended effect only if assigned within the
environment database, as shown).

no_shell: TRUE
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Environment Database

The environment database serves as a “preference file” for Guru programs. It is
a technique by which preferences can be consistently assigned desired values
with no special work to perform when a program is invoked, because the
environment database is automatically loaded and scanned by all Guru
programs. The environment database has the same syntax as a normal
environment file; it just has a special name (env_db11.0) and a special location
(<HOVE>/ op_admi n) that identifies it as the environment database. You can
change the contents of the environment database by editing it directly or via the
Preferences menu item on the Edit menu.

An example environment database appears in the following figure.

Figure 2-1 Environment Database Example

# Environnent Dat abase

opnet _dir: [ usr/ opnet

mod_dirs: lusr/users/tsmth/op_nodels,

[ usr/opnet/11.0. A/ model s/ st d/ base,
[usr/opnet/11.0. Al sys/icons

ver bose: FALSE
vudoc_prog: acroread

fn_x_cour_8pt: Courier8
fn_x_cour_10pt: Courier10
fn_x_cour_12pt: Courieri2
fn_x_cour_14pt: Courierl4
fn_x_times_18pt: Ti mes- Roman18
fn_x_helv_14pt: Hel vetical2

The opnet_dir and mod_dirs preferences are defined because they are required
by most Guru programs. The vudoc_prog and verbose preferences are set to
typical values. The other preferences being set are font mappings, which map
Guru font names to specific output device fonts available on the display. For
example, the Guru font fn_x_cour_10pt maps to the X Windows System Courier
10-point font. The naming scheme for Guru fonts is described below:

output device type (X
Windows system or font type _
PostScript) font size

/

denotes a font

attribute fn_x_cour_10pt
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The output device types can be set to x (X Windows system) or ps (PostScript);
font types include Courier, Times, and Helvetica; and font sizes range form 8 to
18 points. Any of the default fonts can be mapped to a different system font (e.g.
fn_x_cour_12pt could be set to Times-Roman 10), but the preference names
cannot be changed. You may also notice several fonts in the environment
database which appear in the form fn_x_annot_<size>. These fonts are used by
annotation text and can be set to either small (Courier 10), medium (Courier 12),
or large (Courier 14) in the text preferences. However, these default font types
and sizes can be changed in the environment database to any system font.

Font preferences are used by GUI-based programs, but do not appear in the
documentation of these programs. This is because these preferences are
dynamic preferences that are searched for in the environment at the point in
program execution when their value is needed. In contrast, static preferences
(those documented in the Program Descriptions chapter) are searched for in the
environment shortly after a program commences execution. Font requests have
been implemented as dynamic preferences to allow enhanced flexibility and
efficiency; the five font preferences shown in the preceding example are not the
only dynamic preferences used by Guru programs. Dynamic preferences are
discussed further in Static vs. Dynamic Preferences on page ITR-2-11

Environment Files

The environment file mechanism is a way of bundling together many preference
assignments and passing them to a program as a block. Environment files are
ASCII text files with a simple syntax for making assignments. Generally, each
line of an environment file constitutes an assignment to one preference. The
assignment syntax for environment files appears in the following table.

Table 2-4 Environment File Syntax for Basic Preference Types

Type Syntax Example

integer <attr_name>: <int_value> size: 345

double <attr_name>: <double_value> mean_anomaly: 214.65
string <attr_name>: <string_value> orb_name: statkeep

site_name: 'VLA'

boolean <attr_name>: <boolean_value> verbose: OFF

verbose: TRUE

End of Table 2-4
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In environment files, any amount of white space can occur between the
preference name, the colon separator, and the preference value. In fact,
assignments can spread out onto multiple lines. Comments can also appear in
the file, using the shell script standard of starting a comment with a pound sign
(“#" anywhere on a line, with or without assignments).

Figure 2-2 Environment File Example

orb_nane: | ow earth
el em type: 0scC

sm axi s: 6700. 0
eccen: 0.02
inclin: 30
start_date: 1989. 01. 01
start _time: 0.0.0.0
stop_dat e: 1989. 01. 01
stop_tine: 12.0.0.0
tinme_step: 60.0
moon_effects:  on
sun_effects: on
srp_effects: of f # this is off for speed

drag_effects: on

The syntax for assigning a sequence of values to list preferences using an
environment file requires delimiters to separate individual values; the delimiter
character is the comma (*,"). An example of a string list preference being
assigned via an environment file appears below. In this case, the ef preference

is assigned three strings (base_orb_defs, low_earth_defs, and options)

ef: base orb_defs, |ow earth_defs, options

Preference names that contain embedded spaces must be enclosed in quotes
when used in an environment file

"HLA Federate Name" : OPNET

You can create environment files with any text editor. The file names must have
a “.ef” suffix to be recognized as environment files:

pol ar . ef
equatori al . ef
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To be accessible to Guru programs, environment files must be placed in one of
the model directories referenced by the mod_dirs preference. Environment file
names must be passed to a program through the command line flag - ef . Do
not include the environment file suffix in the file name argument:

op_vuorb -ef polar

Note—A product-specific environment file (itguru. ef ) is located in the

<rel di r>/sys/confi gs/ gl obal _prefs directory. Typically, you won't
need to change this environment file.

Assignment Precedence

With five different mechanisms for passing preferences, there is a possibility
that the same preference will be assigned via more than one mechanism.
Figure 2-3 shows the order of precedence for preference passing mechanisms.
This order is fixed and unmaodifiable. Preference assignments that are
overridden by higher precedence mechanisms have no effect.

Figure 2-3 Assignment Precedence for Preferences

environment files
(in mod_dirs directories)

override...

Y

command line flags

override...

Y

shell variables

override...

Y

environment database

l overrides...

product environment files
(in<rel dir>\sys\configs\gl obal prefs)

override...

Windows registry variables
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Within a given mechanism, there is also a possibility of conflicting preference
assignments. The rules of precedence for each mechanism are similar: later
assignments of a preference override earlier assignments. Thus, for
environment files (and the environment database), assignments that appear
later in a file will override conflicting definitions that appear earlier in the file.
Likewise, command line flags that appear later on the command line will
override conflicting flags on the same line. Shell variable assignments are
similar: later assignments overwrite those made earlier.

An exception to the precedence rule is that an assignment of the form
<program name>.<preference> overrides assignments of the form
<preference>, even if the latter is from a higher precedence source. For
example, if itguru. i cons is defined in a shell variable but i cons is defined in
an environment file, OPNET uses itguru. i cons as the value of its icons
preference, even though i cons is assigned in a higher-precedence source (an
environment file).

Static vs. Dynamic Preferences

There are two types of preferences that can be assigned: static and dynamic.
Static preferences form the fixed set of options that is built into the program as
a part of its interface. Dynamic preferences hold values for program options that
the program determines it needs while executing. Dynamic preferences differ
from static ones in that they can be based on conditional events in the execution
of a program and thus cannot be considered part of the built-in, centralized
option set of a program.

Static preferences have the following characteristics:

» They are searched for in the environment shortly after a program begins
executing.

» They can be required or optional. A required static preference halts execution
of the program if you do not assign it a value. An optional static preference
has a default value assigned to it automatically by the program if you do not
assign a value.

* They are displayed in the list produced by the “help” preference (discussed
in help on page ITR-2-20).

» They are described in the Program Descriptions chapter.

Dynamic preferences have the following characteristics:

» They are searched for in the environment whenever an executing Guru
program determines a need for a preference value.
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» They can be entered in response to a prompt. When a dynamic preference
is requested by Guru and an assignment for it is not found in the program’s
environment, a prompt appears on the standard output device requesting
you to enter a value for the preference. You can either enter a value or press
the <Return> key to assign a default value. (This constitutes a fifth
mechanism for assigning dynamic preference values; it is not available for
static preferences.)

» Their use is limited to the following types of preferences:
— Font name mappings of GUI-based programs.

— The arch_suffix preference, which indicates whether a two-character
abbreviation of the host architecture (CPU type and OS) should be added
to the file type suffix of object-code model files.

— Dynamic requests for simulation preferences.

— Patch preferences (such as xpatch_polyxor_vendors and
xpatch_blitclip_vendors) that indicate deficiencies in the host
environment.

— Compatibility preferences (such as outfile and logfile) from previous
releases of Guru.

» They are not described in the Program Descriptions chapter, due to their
dynamic and conditional nature.

Name Wildcards

Guru simulations use dynamic preferences to obtain values for promoted object
attributes. In some cases, the number of dynamic preferences used by a
simulation can be large. This usually occurs when many nodes are involved,
each with promoted attributes. Manually entering values for each dynamic
preference would be tedious in such cases, especially if many of the preference
values were the same. To simplify the job of assigning multiple related
preferences at the same time, Guru programs support a name wildcard feature.

Simulation object dynamic preferences have a hierarchical naming structure in
which preference names are divided into a series of dot-separated components,
each representing one level of the model hierarchy. Every name component
belongs to one of the following categories:

» subnet name (one or more)
* node name

« attribute name

ITR-2-12

IT Guru/Release 11.0



Reference Guide

2—Preferences

The format of hierarchical object attribute names is always top-down, but the
number of name components can vary according to the type of object being
identified. Forinstance,apromotednodeattributewouldbe specifiedsimplyas
<node_nane>. <attr _nane>. On the other hand, an attribute associated with
several nested subnets would have a much longer hierarchical name, such as
t op. <subnet 1_nane>. <subnet 2_nane>. <node_nane>. <attr_nanme>.

The wildcard feature allows the wildcard character (the asterisk, “*”) to match
any number of alphanumeric characters (not including punctuation and special
characters) in dynamic preference names. Thus, parts of an attribute name can
be separately wildcarded, as follows.

The wildcard attribute name:
* * tx[4].data rate
mat ches any of these actual attribute nanmes

[ an0. nd1.tx[4].data rate
| an0. nd2. tx[ 4] .data rate
lanl. ndl.tx[4].data rate

The following wildcarding example shows an environment file statement that
makes a wildcard assignment to all channels in a network model. Notice that the
third wildcard character matches only the initial characters of the third part of the
name; wildcard matching stops when it encounters a non-alphanumeric
character (in this case, “[).

* * *[*].data rate: 9600

The assignment syntax used for wildcarded dynamic preference names is
generally the same as that used for attribute names without wildcards. However,
command line assignments of wildcarded attribute names must have special
protective symbols (double quotes) to prevent the command interpreter from
interpreting the wildcard character as a wildcard for file names. In addition, the
first character of a preference flag must be a dash (otherwise the flag will not be
recognized as a flag). The proper syntax for a command line wildcarded
attribute assignment is shown below.

net.sim"-*.* gx.priority" 20

Notice that the double quotes enclose the whole sequence of characters as the
first argument to net . si m as well as protecting the special meaning of the
asterisk character. The attribute’s value is not placed inside the quotes because
it is a separate argument.

IT Guru/Release 11.0
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Runtime Prompts

If an assignment for a dynamic preference cannot be found anywhere in the
environment, the program displays a prompt on the standard output requesting
a value. This feature is especially useful with the runtime parameterization
capability of simulations, which automatically promotes unassigned object
attributes to dynamic preferences as they are encountered. The following
example shows a typical runtime prompt.

---------------- Unset Environment Attribute -----------------
* |an0.e0.bus_tx[0].data rate: <doubl e>

* Desc:

* Press <return> to select default: 10, 000, 000

Enter val ue> 100000000

To set a particular value for a prompted preference, type a value and press the
<Return> key. By pressing <Return> without entering a value, you force the
program to assign a default value to the preference. By typing the special
keyword nopr onpt , you can prevent further prompting for dynamic preference
values.

A dynamic preference may expect a list value. If so, you can enter multiple
values on the same line, separated by commas. Terminate the list value entry
by pressing the <Return> key.

* top.ml.src.interarrival args: <arg. list>
* Desc:
* Press <return> to select default: 1.0

Enter value> 2.3, 4.818

ITR-2-14
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Standard Preferences

There are several preferences supported by all Guru programs. These standard
preferences provide common services that are useful to most programs. In
general, they manage or analyze the program environment. Many of the
standard preferences can be set only using a command line flag. These
preferences are not supported by Guru scripts or batch files. The following table
summarizes the standard preferences. Detailed definitions of each preference
follow the table.

Table 2-5 Standard Preferences

Name

Description

arch_suffix

Specifies that an architectural suffix be included as part of the name of compiled files.

console_exit_pause

Specifies that the program displays a user prompt before terminating.

dconfirm? Prints a list of all dynamic preferences used by a program.

eft Specifies a list of environment files to be loaded by the program.

env_dbl Specifies the full path name of the environment database to be used.

enva® Lists (in alphabetic order) the environment assignments that are accessible to the program.
envp1 Lists (in precedence order) the environment assignments that are accessible to the program.

geocentric_model

Specifies which geocentric coordinate system to use for the earth.

handle_exception

Specifies whether the program (instead of the operating system) should handle memory access
and other exceptions.

helpl

Generates a list of all preferences the program can accept.

mem_clear1

Specifies that the program should clear n megabytes of memory before starting.

mem_optimize1

Specifies whether optimized memory-allocation routines should be used.

mod_dirs

Specifies the full path names of the model directories to be used.

new_env_db1

Causes the program to create a new environment database before running.

no_env_db1 Causes the program to ignore the user account’s environment database (env_db11.0).
noprompt1 Causes the program to suppress prompts for the values of any unassigned dynamic preferences.
opnet_dir Specifies the full path name of the root directory for Guru.

opnet_user_home

Specifies the path name of the user home directory.

sconfirm?

Prints a list of all preferences and their values.

End of Table 2-5

1.

Can be assigned from the command line only.
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arch_suffix

When TRUE, the arch_suffix specifies that an architectural code be included as
part of the file name of compiled files. In a multi-architecture environment, this
prevents files generated for one architecture from overwriting those for another
architecture.

Data Type boolean

Default Value TRUE

Note—Setting the value of arch_suffix to FALSE causes Guru programs to
ignore the affected files that have architectural suffixes. The files provided with
Guru include architectural suffixes in their file names. Thus, if you choose not to
use the architectural suffix capability, you must rename all affected files in the
<r el di r >/ nodel s subdirectories and any user model directories for the
supplied files to be recognized by Guru programs.

console_exit_pause

dconfirm

When TRUE, specifies that the program sends a user prompt to the command
line before terminating, and ensures that the console window remains open until
you press <Return> or <Enter>. This allows you to view error and other
messages sent to standard output, even if the program terminates abruptly.

To use this feature, make sure that both console_exit_pause and the console
preference are set to TRUE (console specifies that error and output messages
are sent to the application console).

Data Type boolean

Default Value FALSE

Prints information about each dynamic preference used by the program. The
information printed is the preference’s name, the source of the preference’s
current value, and the current value itself. The dconfirm preference can be used
only from the command line.

Data Type boolean

Default Value FALSE

ITR-2-16
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ef

As with static environment variables, it is sometimes useful to confirm that
dynamic preferences are being set to appropriate values. The dconfirm
preference prints the value of each dynamic preference on the standard output
as each value is requested by the program. It does not otherwise affect
execution of the program.

The sconfirm preference is often used in conjunction with the envp and enva
standard preferences, which print the environment settings in precedence and
alphabetic order, respectively.

Figure 2-4 Sample dconfirm Preference Information

i tguru-dconfirm

------------ Dynam ¢ Environnment Attribute Confirmation --------------

Specifies a list of environment files to be loaded by the program. The order in
which environment files are listed determines the order in which they are loaded
and the precedence used if preference assignments conflict. Preference
assignments made by files appearing later in the list will overwrite (that is, have
higher precedence) than conflicting assignments made by files appearing
earlier in the list. If no file name is specified, the network name will be used.

This preference can be used only from the command line.

Data Type string list

Default Value <empty>

The preference support built into all Guru programs allows any number of
environment files to be loaded by a program, as specified by the ef preference.
The preference assignments in these files supplement those taken from the
environment database, shell variables, or command line flags.

IT Guru/Release 11.0
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env_db

enva

The ef preference is generally assigned as a command line flag. An example
assignment is shown below. Notice that the . ef suffix of the environment file
name is omitted in the preference assignment.

net.sim-ef core_defs msc_defs

Note—Although the environment database (env_db11.0) is an environment file,
it is automatically loaded due to its special role and does not need to be added
to the ef list.

Specifies the name of an environment file to be used in place of the default
environment database (env_db11.0).

This preference can be set from the command line, or as a shell variable. If this
preference is set from the command line then it must be the first argument of the
Guru program (unless new_env_db is also used).

Data Type string

Default Value

Lists (in alphabetic order) the environment assignments accessible to the Guru
program. All types of environment assignments are listed, including those made
via environment files, command line flags, shell variables, and the environment
database.

This preference can be used only from the command line.

Data Type boolean

Default Value FALSE

The enva preference produces the same list of preferences as the envp
preference described in envp on page ITR-2-19 However, the preferences in
this list appear in alphabetic order.

ITR-2-18
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envp

Lists (in precedence order) the environment assignments accessible to the
Guru program. All types of environment assignments are listed, including those
made via environment files, command line flags, shell variables, and the
environment database. The listing is ordered by the precedence of the
preference assignments, with highest precedence assignments listed first. The
standard preference enva produces the same list, but in alphabetic order.
This preference can be used only from the command line.

Data Type boolean

Default Value FALSE

Because the list of environment assignments produced by this preference is
comprehensive, it includes preferences with misspelled names, invalid values,
and even shell variables that do not apply to Guru programs. This is particularly
useful for diagnostic purposes because it can pinpoint assignment problems.
For instance, when an incorrect preference name is used, it shows up in the
envp listing, but not in the sconfirm listing. It is common for envp to be used in
conjunction with the sconfirm and dconfirm standard preferences.

Figure 2-5 Sample envp Output

it guru-envp
------------ Precedence- Order Environnment Settings List --------------
Nare: Sour ce: Val ue:
opnet _dir: shel | var [ usr/ opnet
SYS DR shel | var [ usr/opnet/sys
GBS DR shel | var [ usr/ opnet/ obs
REL DR shel | var [ usr/ opnet
DI SPLAY: shel | var uni x,
0.0
CP_ DR shel | var / opnet / pr od/ opnet
EXINT: shel | var "set ai sw=4 ts=4"
HOST_TYPE: shel | var SUN4
PVD: shel | var /tnp
LOGNAME: shel | var tsmth
PATH shel | var .
[ bin,
[ usr/ bin,
[usr/ uch,
[usr/etc,
[ usr/opnet/sys/ bin
USER shel | var tsmth
mod_dirs: env_db [usr/users/tsmth/op_nodels,
[ usr/ opnet/ nodel s/ base
opnet _dir: env_db [ usr/ opnet

IT Guru/Release 11.0
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geocentric_model

Specifies which geocentric coordinate system to use for the earth. The systems
are:

» right-sphere—The earth is modeled as a sphere, on which the x-axis
intersects the surface at 0°N 0°E, the y-axis at 0°N 90°E, and the z-axis at
90°N.

» left-sphere—The earth is modeled as a sphere, on which the x-axis
intersects the surface at 0°N 90°E, the y-axis at 0°N 0°E, and the z-axis at
90°N (x and y are reversed from the right-sphere system).

» ellipsoid—The earth is modeled as an ellipsoid, using the right-sphere
coordinate axes.

The value of this preference changes only at start-up.

Data Type enum
Constraints right_sphere, left_sphere, ellipsoid
Default Value right_sphere

handle_exception

Specifies whether Guru should handle memory access and other exceptions. If
FALSE, exception handling is left to the operating system.

The value of this preference changes only at start-up.

Data Type boolean

Default Value TRUE

help

Generates an alphabetical list of every preference the program can accept. This
list includes the preference’s name, type, default value, and purpose. This
preference can be used only from the command line.

Data Type boolean

Default Value FALSE
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mem_clear

mem_optimize

The help preference is especially useful when you are trying to use a program
that is not very familiar; the list of preferences introduces the range of options
the program accepts. The following example shows part of the list produced by
the help preference for the op_manfile program.

Figure 2-6 Sample help Preference List

% op_manfile -help

Built-in preferences of op_manfile:
(*) command-line only; (!) required

----------- Name----------- -----Type------ --Default--- --------Description--------
-all <bool ean> FALSE apply to all instances (oth
-all ow spaces_in_file_nanes <bool ean> FALSE al | ow spaces in sone m
-app_nane <string> " application name (used with
-arch_suffix <bool ean> TRUE enabl e architecture suffixes
-automation_| ock_max_wait_tine <i nt eger > 60 maxi mum time in ni
- backup_max_count <i nteger > 10 maxi num nunber of nunbered
-beep_count _confirm <i nteger> 1 audi bl e beep count for confirm

-beep_count _error <i nt eger > 2 audi bl e beep count for error
-buffered_tfile_types <string list> <enpty> list of tfiles that should
- checksum <hool ean> FALSE comput e checksumof file
-coll ect _nodel _deps_in_file (*) <string> " generate a list of nodel
-coment s_add <bhool ean> FALSE add coments to the nodel or file
-comment s_del <bool ean> FALSE delete all comrents from nodel
-comments_print <hool ean> FALSE print comrents

-consol e_exit _pause <bool ean> FALSE wait for explicit input to
-dconfirm (*) <bool ean> FALSE print dynamc attribute con
-di ag_enabl e <bool ean> FALSE enable the printing / |ogging
-dir <hool ean> FALSE apply to all nodel files in
-edit_|ock <bool ean> FALSE set the edit |ock

-edit_| ock_rode <bhool ean> FALSE enabl es use of edit | ocks on nodel s

Specifies that the program should clear out an initial n megabytes of system
memory before starting. This preference can be useful when debugging
potential memory corruption problems.

This preference can be used only from the command line, and its value changes
only at start-up.

Data Type integer

Default Value 0

Specifies whether Guru should use optimized memory allocation routines. By
default, Guru uses several routines to optimize memory allocation. To suppress
this feature, set the value of mem_optimize to FALSE. You may want to
suppress memory optimization when running simulations along with certain
debugging utilities and libraries, such as Purify.

IT Guru/Release 11.0
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mod_dirs

This preference can be used only from the command line, and its value changes
only at start-up.

Data Type boolean

Default Value TRUE

When mem_optimize is FALSE, the way OPNET handles memory allocation is
limited:

» The concept of pooled memory does not exist; thus, all allocations are
individual ones.

» Categorized memory is not used (although categories are defined).

Because of these memory allocation limitations, memory reports provided by
OPNET (in the Simulation Sequence dialog box) will differ from those given
when mem_optimize is TRUE, as follows:

* No pooled memory is listed.
» Categorized memory categories are listed, but all show a usage of zero.
« All memory usage is lumped together in one category, called General.

» Total usage is typically lower, because there is no pooled memory overhead.

Note—To set mem_optimize to FALSE for a simulation, add this preference to
the environment database or specify it in the Command line options field on the
Advanced:Sim Execution page of the Configure/Run DES dialog box.

Specifies the full path names of the directories to be used for models and icon
databases. This preference is not required by all Guru programs; however, if no
value can be found in the environment, many programs will abort with an error.

Data Type string

Default Value

Many Guru programs perform operations on models and must know where
models are stored in the host file system. In addition, GUI-based programs must
know where to look for the icons used by the interface. Typically, the mod_dirs
preference is assigned a value in the environment database (env_db<r el >),
especially because the default contents of the environment database include
this assignment.
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Example mod_dirs assignments appear in the following diagram. Because this
preference is a list of strings, individual elements of its value are separated by
the appropriate delimiters.

Guru programs use the order in which directories are listed in mod_dirs to
establish precedence among model files and icon databases with conflicting
names. See Model Directory Organization on page ITR-1-17 for a description of
this process and guidelines for listing model directories.

Figure 2-7 Sample mod_dirs Assignments

via an environment file:

# * %% env_db * %%

mod_dirs:  [usr/users/tsmth/op_nodels,
[usr/opnet/11. 0. Al nodel s/ st d/ base,
[usr/opnet/11. 0. Al nodel s/ st d/ et her net,
[usr/opnet/11.0. Al sys/icons

via a UNIX shell variable:

% setenv nod_dirs "/usr/users/tsmth/op_nodel s:\
[usr/opnet/11. 0. Al nodel s/ st d/ base: \
[usr/opnet/11.0. Al nodel s/ std/ et hernet:\
[usr/opnet/11.0. Al sys/icons"

%itguru

via a Windows shell variable:

C\> set mod_dirs=\usr\users\tsmth\op_nodels:\
\usr\opnet\ 11. 0. A\ nodel s\ st d\ base: \
\usr\opnet\ 11. 0. A\ nodel s\ st d\ et hernet : \
\usr\opnet\11. 0. A sys\icons

C\>itguru

via a command line flag:

itguru -nmod_dirs /usr/users/tsmth/op_nodels \
[usr/opnet/11. 0. Al nodel s/ st d/ base \
[usr/opnet/11.0. Al nodel s/ std/ ethernet \
[usr/opnet/11.0. Al sys/icons

new_env_db
Causes the Guru program to create a new environment database file based on
the current environment.

This preference can be used only from the command line, and must be the first
argument of the Guru program.

Data Type boolean

Default Value FALSE
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no_env_db

noprompt

Causes the Guru program to ignore the user account’s environment database.
When used on the command line, this preference must be the first argument of
the Guru program, or the first one after new_env_db.

Data Type boolean

Default Value FALSE

Guru programs obtain the values of preferences from several sources, including
the user account’s environment database. In certain cases, it is useful to ignore
the environment database by setting no_env_db to TRUE. One such case
occurs for the root user account, which does not have an environment
database.

Causes the Guru program to suppress prompts for the values of any
unassigned dynamic preferences. Instead, all such unassigned preferences are
automatically assigned the associated default values.

This preference can be used only from the command line.

Data Type boolean

Default Value FALSE

Dynamic preferences that are not assigned values in the program environment
normally cause the program to print a prompt on the standard output device,
requesting you to enter a value. This feature is especially useful in simulations,
where values for promoted object attributes are sought from dynamic
preferences, thus giving the simulation a “runtime” parameterization capability.

There are occasions, however, when a simulation will have several promoted
object attributes to which you would rather not explicitly assign values. This
situation usually arises during simulation debugging iterations, when the same
simulation is run repeatedly to analyze a specific aspect of its execution. Under
these conditions, it may be unnecessary to assign specific values to each
promoted object attribute. The noprompt preference allows you to have default
values assigned automatically to all dynamic preferences that would otherwise
cause prompts.
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opnet_dir

Specifies the full path name of the OPNET directory (<opnet _di r >) for Guru
programs. This preference is not required by all Guru programs; however, if no
value can be found in the environment, many programs will abort with an error.

Data Type string

wn

Default Value

Guru programs must have knowledge of where the Guru files are located in the
host file system, because these programs may access system binary and ASCII
data files while executing. Typically, opnet_dir is assigned a value in the
environment database (env_db11.0) , especially because the default contents
of the environment database include this assignment.

Figure 2-8 Sample opnet_dir Assignments
via an environment file:

## * % % Ear]\/ (jk) * % %
opnet _dir: / usr/ opnet

via a UNIX shell variable:

% setenv opnet _dir /usr/opnet
% itguru

via a Windows shell variable:

C.\> set opnet _dir=\usr\opnet
C\>itguru

via a command line flag:

itguru -opnet_dir /usr/opnet

opnet_user_home

Specifies the full path name of the user home directory. By default, Guru uses
the path specified by a shell variable like $3HOME or %HOMEDRIVE%/
%HOMEPATH%; this preference lets you override the default.

This preference can be set only from the command line. If Guru is using the
specified directory for the first time, it creates / op_admni n and / op_nodel s
subdirectories and then runs the op_addlicense program.

Data Type string

wn

Default Value
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sconfirm

Prints a list of all preferences and their values. The list gives the name, the
source of the current value, and the current value itself for each preference of
the program. This preference can be used only from the command line.

Data Type boolean

Default Value FALSE

When using Guru, it is sometimes useful to confirm that its preferences are
being set to appropriate values. This is especially a concern when several
preference mechanisms are being used simultaneously, leaving some question
as to the final value of a preference. The sconfirm preference prints a list of all
preferences and their assigned values on the standard output shortly after the
program starts executing. It does not otherwise affect execution of the program.

The sconfirm preference is often used in conjunction with the envp and enva
standard preferences, which print the environment settings in precedence and
alphabetic order, respectively.

The following example shows part of an sconfirm preference list. There are four
sources given for the preference values:

« cnd | i ne—The preference is set by a command line flag.

» def aul t —The preference is not set by any environment mechanism (and
thus has its default value).

» <env_file>—The preference is set by the named environment file, which
either is specified by the -ef command line flag or is the environment
database.

 shell var—The preference is set by a shell variable.
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Preference Sets

Figure 2-9 Sample sconfirm Preference List

%itguru-ef nore_defs -sconfirm

------------ Static Environnent Attribute Confirmations --------------

Nare: Sour ce: Val ue:
opnet _dir: shel | var [ usr/ opnet
mod_dirs: env. file usr/users/tsmth/op_nodels,

[ usr/ opnet/ nodel s/ base

ef: cmd |ine more_def s
arch_suffix: defaul t TRUE
an_nono_sym defaul t TRUE
backup_i nterval : defaul t 15
backup_max_count : defaul t 10
beep_enabl e: defaul t TRUE
bi nd_fI ags: defaul t <nul | >
code_area_hei ght: env. file 410
code_area_width: env. file 500
comp_flags: defaul t <nul | >
core_dunp: defaul t FALSE
dbl _click: defaul t 250
di ag_enabl e: env. file TRUE
di sp_host : defaul t uni x
di sp_server: defaul t 0.0

In Figure 2-9, several preferences obtain their values from an environment file
specified by the command line flag - ef nor e_def s. The contents of the file
nor e_def s. ef appear below.

# nore_defs. ef Environnent File

diag_enabl e: TRUE
code_area_hei ght: 410
code_area_width: 500

Most Guru programs share common preferences. These can be grouped into
preference sets according to their use. For example, some preferences assist
in tracking program behavior, while others deal with manipulating graphical
options of the user interface. The preferences in these sets are described here
and referred to in the discussions of programs that accept them.
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The preference sets are listed in the following table.

Table 2-6 Preference Sets

Name Coverage

Development Software development utility options

Diagnostics Error handling and memory usage

File File handling and search paths

GUI Graphical user interface options

Licensing License System interface

Printing Print output format and spooling options

Standard Preference processing options (described in Standard

Preferences on page ITR-2-15)

User Lock User-initiated model write locking
Web Reporting HTML report options
XML XML import and export

End of Table 2-6

All of these preference sets are described in this section except the standard
set, which is described in Standard Preferences on page ITR-2-15.

Development

Development preferences are used in the process of developing software
modules: e.g., object code files, archive-based object code libraries, or
executable programs. These attributes manipulate the operating system
commands that compile, archive, and bind (link). Only OPNET programs that
create software modules accept these attributes, and some of these programs
only accept a subset of the attributes (for instance, just the compile and archive-
related attributes).
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When compiling C++ code in OPNET, there are several development
preferences that must be set to correctly compile and link the code. Table 2-7
specifies these attributes and their values for each operating system and
compiler, depending on whether op_mksim or op_runsim is being used to
create the simulation executable file.

Table 2-7 Compiling and Linking Program Preferences for C++

(O Version Compiler op_mksim op_runsim
Solaris 2.7 or CC (SunPro) comp_prog_cpp: comp_unix_cpp comp_prog_cpp: comp_unix_cpp
later 5.0 and later bind_static_prog: bind_unix bind_shobj_prog: bind_so_CC
gcc1 2.X  comp_prog_cpp: comp_g++ comp_prog_cpp: comp_g++
bind_static_prog: bind_g++ bind_shobj_prog: bind_so_g++
3.0andlater  comp_prog_cpp: comp_g++ 3 comp_prog_cpp: comp_g++_3
bind_static_prog: bind_g++ bind_shobj_prog: bind_so_g++
Windows NT 4.0, Visual C++ comp_prog_cpp: comp_msvc comp_prog_cpp: comp_msvc
2000, XP bind_static_prog: bind_msvc bind_shobj_prog: bind_so_msvc
End of Table 2-7

1. When using gcc for C code, use these settings: comp_prog: comp_gcc, bind_static_prog: bind_gcc, bind_shobj_prog: bind_so_gcc

bind_shobj_flags

Specifies flags to be passed to the “binder” program when creating a shared
object.

Data Type string

wn

Default Value

bind_shobj_flags_devel

Specifies flags to be passed to the “binder” program when creating a shared
object for a development simulation kernel.

Data Type string

Default Value “/DEBUG /DEBUGTYPE:BOTH”
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bind_shobj flags_optim

Specifies flags to be passed to the “binder” program when creating a shared
object for an optimized simulation kernel.

Data Type string

Default Value

bind_shobj_libs

Specifies optional libraries to be passed to the “binder” program (i.e., the ECI
translator that causes object code files to be linked into an executable program).
The binder program is indirectly invoked through the ECI program specified by
the bind_shobj_prog preference. The value of bind_shobj_libs should be a list
of one or more library names separated by spaces. Library names can be simple
file names from the current working directory or (preferably) full path names.

Data Type string

Default Value

bind_shobj_libs_devel

Specifies optional libraries to be passed to the “binder” program (i.e., the ECI
translator that causes object code files to be linked into an executable program)
for use with a development simulation kernel. The binder program is indirectly
invoked through the ECI program specified by the bind_shobj_prog preference.
The value of bind_shobj_libs_devel should be a list of one or more library names
separated by spaces. Library names can be simple file names from the current
working directory or (preferably) full path names.

Data Type string

Default Value
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bind_shobj_libs_optim

Specifies optional libraries to be passed to the “binder” program (i.e., the ECI
translator that causes object code files to be linked into an executable program)
for use with an optimized simulation kernel. The binder program is indirectly
invoked through the ECI program specified by the bind_shobj_prog preference.
The value of bind_shobj_libs_optim should be a list of one or more library
names separated by spaces. Library names can be simple file names from the
current working directory or (preferably) full path names.

Data Type string

wn

Default Value

bind_shobj_prog

Specifies the ECI translation program or script to invoke to create a shared
object library.

Data Type string

wn

Default Value

bind_static_flags

Specifies optional flags to be passed to the “binder” program when creating a
static executable.

Data Type string

Default Value

bind_static_flags_devel

Specifies optional flags to be passed to the “binder” program when creating a
static executable for a development simulation kernel.

Data Type string

Default Value “1Z7 10d”

IT Guru/Release 11.0 ITR-2-31



2—Preferences Reference Guide

bind_static_flags_optim

Specifies optional flags to be passed to the “binder” program when creating a
static executable for an optimized simulation kernel.

Data Type string

Default Value

bind_static_libs

Specifies optional libraries to be passed to the “binder” program (i.e., the ECI
translator that causes object code files to be linked into an executable program).
The binder program is indirectly invoked through the ECI program specified by
the bind_static_prog preference. The value of bind_static_libs should be a list
of one or more library names separated by spaces. Library names can be simple
file names from the current working directory or (preferably) full path names.

Data Type string

Default Value

bind_static_libs_devel

Specifies optional libraries to be passed to the “binder” program (i.e., the ECI
translator that causes object code files to be linked into an executable program)
for a development simulation kernel. The binder program is indirectly invoked
through the ECI program specified by the bind_static_prog preference. The
value of bind_static_libs_devel should be a list of one or more library names
separated by spaces. Library names can be simple file names from the current
working directory or (preferably) full path names.

Data Type string

Default Value

ITR-2-32 IT Guru/Release 11.0



Reference Guide 2—Preferences

bind_static_libs_optim

Specifies optional libraries to be passed to the “binder” program (i.e., the ECI
translator that causes object code files to be linked into an executable program)
for an optimized simulation kernel. The binder program is indirectly invoked
through the ECI program specified by the bind_static_prog preference. The
value of bind_static_libs_optim should be a list of one or more library names
separated by spaces. Library names can be simple file names from the current
working directory or (preferably) full path names.

Data Type string

Default Value

bind_static_prog

Specifies the ECI translation program or script to invoke to create static
executables. Changing the default value of this preference may necessitate a
change of the flags passed to the ECI program by the bind_static_flags
preference.

Data Type string

Default Value

check_newer_process_model_files

Specifies which dates OPNET consults when deciding whether to recompile a
file. if FALSE, only object file dates are checked. When TRUE, both object and
process model file dates are checked.

Data Type boolean

Default Value TRUE

comp_flags_c++_specific

Specifies optional flags passed to a C/C++ compiler when compiling C++ code.
These flags will be combined with the flags specified by other comp_flags_
preferences (comp_flags_common and others, as needed) and passed to the
compiler program.
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The value of this preference is compiler-specific and must have a format that is
accepted by the compiler being used. For example, compiler flags are typically
preceded by a dash.

Note—If a dash-preceded value for this preference is being specified on a
command line, either the dash must be represented by a carat (-
bind_static_flags ~g) or the value must be enclosed in double quotes, with a
space character preceding the dash (for example, -bind_static_flags “ -g”).

Data Type string

Default Value

comp_flags_c_specific

Specifies optional flags passed to a C/C++ compiler when compiling C code.
These flags will be combined with the flags specified by other comp_flags_
preferences (comp_flags_common and others, as needed) and passed to the
compiler program.

The value of this preference is compiler-specific and must have a format that is
accepted by the compiler being used. For example, compiler flags are typically
preceded by a dash.

Note—If a dash-preceded value for this preference is being specified on a
command line, either the dash must be represented by a carat (-
bind_static_flags ~g) or the value must be enclosed in double quotes, with a
space character preceding the dash (for example, -bind_static_flags “ -g”).

Data Type string

Default Value

comp_flags_common

Specifies optional compiler flags (such as include paths) to be used for all
compilations. These flags will be combined with the flags specified by other
comp_flags_ preferences (as needed) and passed to the compiler program.
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The value of this preference is compiler-specific and must have a format that is
accepted by the compiler being used. For example, compiler flags are typically
preceded by a dash.

Note—If a dash-preceded value for this preference is being specified on a
command line, either the dash must be represented by a carat (-
bind_static_flags ~g) or the value must be enclosed in double quotes, with a
space character preceding the dash (for example, -bind_static_flags “ -g”).

Data Type string

Default Value

comp_flags_devel

Specifies optional compiler flags to be used when compiling code in debugging
mode. These flags will be combined with the flags specified by other
comp_flags_ preferences (comp_flags_common and others, as needed) and
passed to the compiler program. The default value represents the debugging
flags for Sun and Microsoft compilers.

The value of this preference is compiler-specific and must have a format that is
accepted by the compiler being used. For example, compiler flags are typically
preceded by a dash.

Note—If a dash-preceded value for this preference is being specified on a
command line, either the dash must be represented by a carat (-
bind_static_flags ~g) or the value must be enclosed in double quotes, with a
space character preceding the dash (for example, -bind_static_flags “ -g”).

Data Type string
Default Value Windows: /Zi /Od
UNIX: -g

comp_flags_mt

Specifies optional compiler flags to be used when compiling code in parallel
mode. These flags will be combined with the flags specified by other
comp_flags_ preferences (comp_flags_common and others, as needed) and
passed to the compiler program.
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The value of this preference is compiler-specific and must have a format that is
accepted by the compiler being used. For example, compiler flags are typically
preceded by a dash.

Note—If a dash-preceded value for this preference is being specified on a
command line, either the dash must be represented by a carat (-
bind_static_flags ~g) or the value must be enclosed in double quotes, with a
space character preceding the dash (for example, -bind_static_flags “ -g”).

Data Type string

Default Value

comp_flags_optim

Specifies optional compiler flags to be used when compiling code in optimized
mode. These flags will be combined with the flags specified by other
comp_flags_ preferences (comp_flags_common and others, as needed) and
passed to the compiler program. The default value represents some
optimization flags for Sun and Microsoft compilers.

The value of this preference is compiler-specific and must have a format that is
accepted by the compiler being used. For example, compiler flags are typically
preceded by a dash.

Note—If a dash-preceded value for this preference is being specified on a
command line, either the dash must be represented by a carat (-
bind_static_flags ~g) or the value must be enclosed in double quotes, with a
space character preceding the dash (for example, -bind_static_flags “ -g”).

Data Type string
Default Value Windows: /Ox /Ob2 /DOPD_NO_DEBUG
UNIX: -xtarget=ultra
-xO3
-xbuiltin=all
-xlibmil

-DOPD_NO_DEBUG

comp_globals_export

When creating shared object libraries, specifies whether or not the library will
require functions and variables declared in other libraries. If true, any variable
declared with IMPORT_GLOBAL will look in other libraries for definition.
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Required under Windows only.

Data Type boolean

Default Value FALSE

COMp_per_process_errors

comp_prog

Specifies whether cc_err output files from each compilation should have a
process ID appended to their names. This allows multiple compilations to be
executed in parallel without the error files being overwritten.

Data Type boolean

Default Value TRUE

Specifies the name of the ECI translation program or script to invoke to compile
C source code. Changing the value of this preference may necessitate a change
of the flags passed to the C compiler program by the comp_flags_c_specific
preference.

Data Type string

Default Value comp_unix

comp_prog_cpp

Specifies the name of the ECI translation program or script to invoke to compile
C++ source code. Changing the value of this preference may necessitate a
change of the flags passed to the C++ compiler program by the
comp_flags_c++_specific preference.

Data Type string

Default Value comp_unix_cpp

comp_trace_info

Modifies compiled source code to include additional trace information.

Data Type boolean

Default Value TRUE
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core_dump

debug_mk

ema_verbose

Forces an OPNET program to retain its state in a core file in the current directory
if the program encounters a program fault (segmentation violations, floating
exceptions, or bus errors). These are typically caused by an improperly trapped
condition (for instance, dividing by zero). When such errors occur, use the
op_vuerr utility to see where the error occurred. If you contact OPNET by phone,
you might be asked to run the UNIX program debugger dbx. The core dump
created by this preference allows the error to be partially analyzed without
having to recreate it while the program is running under dbx. Setting this
preference does not affect the normal operation of OPNET programs.

This preference is usable only on UNIX platforms.

Data Type boolean

Default Value FALSE

Specifies that an OPNET program print to standard output the exact compiling
and linking commands (including flags) it sends to the operating system. This
can be useful when you have trouble compiling or linking process-model or
other code.

Note—Printing the actual command will typically cause the top-level compiling
or linking operation to fail. Therefore, you should have this preference set to
TRUE only while performing diagnostics or debugging.

Data Type boolean

Default Value FALSE

Specifies that EMA application code generated by an OPNET tool should
include assignments for all object attributes, even those attributes with default
values. Non-verbose EMA application code only includes assignment for
attributes that have non-default values.

Data Type boolean

Default Value FALSE
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kernel_type

Specifies which kernel is to be dynamically linked into simulations by
op_runsim. Either four or eight kernel types are available, depending on
platform:

Windows and Solaris

development. This kernel allows ODB use, profiling, and detailed function
call stack (FCS) information in errors and warnings.

optimized. This kernel runs much faster than development, but does not
allow ODB use. Also, no profiling data is collected for kernel procedures,
nor will any OPNET APIs be listed in the FCS information. Model code
can still be profiled or can still include FCS information, if needed.

development_parallel. This kernel is similar to development, plus it
allows multiple events to be executed in parallel.

optimized_parallel. This kernel is similar to optimized, plus it allows
multiple events to be executed in parallel.

Solaris only

development_64bit. This kernel is similar to development, plus it uses 64-
bit addresses to give a larger space for executables.

optimized_64bit. This kernel is similar to optimized, plus it uses 64-bit
addresses to give a larger space for executables.

development_parallel_64bit. This kernel is similar to
development_parallel, plus it uses 64-bit addresses to give a larger
space for executables.

optimized_parallel_64bit. This kernel is similar to optimized_parallel, plus
it uses 64-bit addresses to give a larger space for executables.

Depending on the value of kernel_type, the op_runsim program will invoke one
of the following programs to link and run simulations:

op_runsim_dev

op_runsim_opt

op_runsim_mtdev

op_runsim_mtopt

op_runsim_dev64

op_runsim_opt64

op_runsim_mtdev64

op_runsim_mtopt64
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This preference is also used by op_mkso to determine which type of shared
object file to create, by op_mko to build appropriate object files, and by
op_mksim to build static simulations.

Data Type string

Default Value development

mem_track

Specifies that the memory allocation and deallocation tracking features of the
program should be enabled for use within the host workstation debugger. If
mem_track is enabled, internal program functions can be invoked to print lists
of the allocation sources and deallocation sinks within the program. This is
accomplished by invoking the function Vos_Memstats_Print_Sources
(obj_name, mode) where the string argument obj_name is the name of a
particular memory object and mode is either O (for a list of allocation sources) or
1 (for a list of deallocation sinks). To obtain a list of significant memory object
names, invoke the function Vos_Memstats_Print_Table (1, 2). If mem_track is
disabled, these functions are not functional.

Data Type boolean

Default Value FALSE

mem_track _object

Specifies the name of a particular object to track memory allocation and
deallocation. Specifying an object allows for efficient tracking if only one object
is of interest. Used when mem_track is enabled.

Data Type string

Default Value

ov_diff_tolerance

Specifies a tolerance, expressed as a percentage value, to use when testing the
equality of graphs. Vectors whose mean values differ by less than this tolerance
will be considered equal.

Data Type integer

Default Value 5
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ov_mem_size

Specifies the maximum size of the output vector data buffer in megabytes.
When a buffer reaches the specified limit, its entries are written to disk, and it
resumes the collection of new values. Setting this preference to larger values
than the default trades off less writes to disk versus more memory usage. If
fragments are allowed to grow too large, the simulation may need to use swap
space which will reduce execution speed.

Type integer

Default Value 4

prof_output

Specifies a file name or other destination to which function profiling information
should be sent.

Data Type string

Default Value “console”

prof_output_separator

Specifies text to be placed between function profile fields.

Data Type string

wn

Default Value

prof_track

Specifies that function profiling information be reported where possible. When a
simulation is run, OPNET reports the number of times each function was called,
and how many seconds were spent within that function.

Data Type boolean

Default Value FALSE
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prof_track func

Specifies a single function for which to report tracking information (if prof_track
is enabled)

Data Type string

Default Value

prof_track recurse

Collects profiling information on recursive function calls (if prof_track is

enabled).
Data Type boolean
Default Value TRUE

progress_bar_positioning

Specifies the positioning of progress bars. If “recenter”, progress bars are kept
centered on the current window. If “fixed”, they remain in a fixed global position.

Data Type enum
Constraints recenter, fixed
Default Value “recenter”

show_compilation_output

Specifies whether OPNET should display the output of each compilation, even
if successful. When TRUE, compilation output is always displayed.

Data Type boolean

Default Value FALSE

show_compilation_success_dialog

Specifies whether OPNET should display a dialog box listing the expected
targets and the compilation status of each.

Data Type

boolean

Default Value

TRUE
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verbose_mk

Specifies that all commands issued to compile and bind code be displayed.

Data Type boolean

Default Value FALSE

Diagnostics

Diagnostics preferences control the handling of program errors and provide
additional diagnostic services. All Guru programs accept diagnostic
preferences, thus letting you make error handling consistent throughout Guru by
placing value assignments for these preferences in your environment database.

beep_count_confirm

Specifies the number of beeps generated to confirm completion of selected
operations (typically long operations that may result in failure). To disable
confirmation beeps altogether, set this preference to 0.

Data Type integer

Default Value 1

beep_count_error

Specifies the number of beeps generated to indicate an error condition. To
disable error beeps altogether, set this preference to 0.

Data Type integer

Default Value 2

diag_enable

When TRUE, specifies that diagnostic errors are to be detected, printed (either
on the standard output device or within the program), and logged (in the
<HOVE>/ op_adni n/ err _| og file). Diagnostic errors indicate program
conditions that are incorrect, but recoverable, and that are not normally checked
during program execution. (Typically, diagnostic error conditions are rare and
automatic checking would reduce performance excessively.) It is useful to
enable this preference during development and debugging sessions to ensure
notification of all errors.

Data Type boolean

Default Value FALSE
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rec_err_suppress

When TRUE, specifies that recoverable errors and warnings should be
suppressed from printing (either on the standard output device or within the
program). Even when printing is suppressed, recoverable errors and warnings
continue to be detected and logged in the <HOVE>/ op_adm n/ err _| og file
and can be viewed using the op_vuerr utility. Enabling this preference is useful
when programs generate many expected errors.

Data Type boolean

Default Value FALSE

warning_suppress

Specifies that warnings should be suppressed from printing (either on the
standard output device or within the GUI). If warning_suppress is enabled,
warnings are still detected and logged in the <HOME>/ op_admi n/ err _| og
file, and can be viewed using the op_vuerr utility. Enabling this preference is
useful in situations where programs generate many expected warnings.

Data Type boolean

Default Value FALSE

File

File preferences indicate options that affect file handling, backups, and search
paths. Several standard preferences appear among the file preferences when
you edit program preferences—arch_suffix, ef, opnet_dir, and mod_dirs. These
are described in Standard Preferences on page ITR-2-15.

backup_interval

Specifies the length of the interval between automatic backups of Guru models.
Setting this preference’s value very high will effectively prevent automatic
backups from occurring during the session.

Data Type integer
Default Value 15
Units minutes
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backup_max_count

Specifies the maximum quantity of numbered version backups kept for a given
file. Each time you save a model with the same name, the overwritten file is
stored in your op_admin/bk directory with a name of the form:

<nodel _name>. v<vers_nune. <mdl _t ype>. m The most recent file
versions are kept; when the maximum count of backups would be exceeded by
a new version, the earliest version is removed from the bk directory.

Data Type integer
Default Value 10
Units versions

buffered_tfile types

Specifies a list of tfile types and whether or not each type should be buffered.
The preference value should be a comma-separated list of file extensions. Each
file type listed will be buffered unless the extension is preceded by an
exclamation point (!). For example,

.ot, .otf, !.sddb"

means that output table and output table fragment files should be buffered and
self-description database file should not be buffered.

Data Type string list

Default Value <empty>

file_read _abort_suppress

Specifies whether OPNET should suppress model file reading errors. When
TRUE, such errors are suppressed.

Data Type boolean

Default Value FALSE

force_posix_locale

Specifies whether OPNET should run in the POSIX locale. When TRUE, POSIX
locale is forced.
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The value of this preference changes only at startup.

Data Type

boolean

Default Value

FALSE

verbose_session_log

Specifies whether to use verbose session logging. When TRUE, verbose
session logging is enabled.

Data Type

boolean

Default Value

FALSE

GUI

Graphic user interface (GUI) preferences specify options that affect the
graphical user interface of programs, including display device parameters,
window appearance, and interaction styles. They also provide control of shell
scripts and batch files.

Several dynamic preferences appear among the GUI preferences when you edit
program preferences. These are described in Static vs. Dynamic Preferences
on page ITR-2-11.

annot_fonts.large

Specifies the font used for large text annotations.

Data Type

string

Default Value

“family:Lucida Console-size:9”

annot_fonts.medium

Specifies the font used for medium text annotations.

Data Type

string

Default Value

“family:Lucida Console-size:8"
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annot_fonts.small

Specifies the font used for small text annotations.

Data Type string

Default Value “family:Lucida Console-size:7”

async_cmd_mode

Specifies that the program should accept asynchronous commands. Currently,
itguru is the only program that supports this preference.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

async_cmd_port

Specifies a port for asynchronous commands. Currently, itguru is the only
program that supports this preference.

The value of this preference changes only at start-up.

Data Type integer

Default Value 3567

async_cmd_trace

When TRUE, specifies that tracing of asynchronous commands should be
enabled. Currently, itguru is the only GUI program that supports this preference.

Data Type boolean

Default Value FALSE
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browser_prog

Specifies the full path name of an HTML browser program for viewing web
reports.

Data Type string

Default Value

check_subnet_bounds

Specifies whether to enforce subnet bounds checking on the positions of
contained sites. When TRUE, subnet bounds are checked.

Data Type boolean

Default Value TRUE

code_editor_prog

Specifies the full path name of the text editor program to use for editing C/C++
source code. The special value “editor_prog” means that the text editor
specified by the editor_prog preference should be used.

Data Type string

Default Value “editor_prog”

console

When TRUE, specifies that the application console should be used for stdout
and stderr messages.

Data Type boolean

Default Value FALSE

creation_mode

Specifies the mode for creating objects with the mouse. "repeat” allows the user
to continue to create instances of the object until the operation is ended with a
right-click. "single" automatically ends the operation after only one object is

created.
Data Type enum
Default Value repeat
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disable_message confirmations

When TRUE, specifies that OPNET should not display interactive message
confirmations.

Data Type boolean

Default Value FALSE

disable_message_tips

When TRUE, specifies that OPNET should not display pop-up message tips.

Data Type boolean

Default Value FALSE

disable_object_operations

When TRUE, specifies that OPNET should not show operation buttons in the
Advanced Object Attributes editor.

Data Type boolean

Default Value FALSE

disable_object_palette_configuration

When TRUE, specifies that OPNET should not show the Configure button in
object palettes.

Data Type boolean

Default Value FALSE

disable_object_palette_model_properties_display

When TRUE, specifies that OPNET should not display model details when an
icon is right-clicked in the object palette.

Data Type boolean

Default Value FALSE
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display

Specifies an identifier for a display host and server for remote graphics. The
GUI-based program will send its X Window System graphics requests to the
server indicated by this preference. The X server must be configured to permit
graphics access from the host running the GUI-based program (this can be
checked and modified via the X Window System xhost program). The host
computer running the GUI-based program must be able to reach the display
host via the IP network protocol.

The value of this preference must be of the form:
<hostname>:<display_number>.<screen_number>. The hosthame can be an
IP address or a configured machine name. The display number and screen
number are zero-based integers and are usually zero.

Data Type string

Default Value “0.0”

doubleclickinterval

Specifies the maximum time, in seconds, between two mouse clicks for the
clicks to be interpreted as a “double click” rather than as two “single clicks.”
Users with fast input styles can set this preference to a shorter interval to avoid
false double-clicks. Users with slow input styles can set this preference to a
longer interval to ensure that slow double-clicks are detected.

Data Type integer

Default Value 0.25

drag_obj_threshold

Specifies the maximum number of objects to show while dragging. When the
number of objects being dragged is less than this value, a separate drag outline
is drawn for each object. When the number is equal to or greater than this value,
only two outlines are drawn—a small one representing the object the cursor is
on and a large rectangle encompassing all of the dragged objects.

Data Type integer

Default Value 32
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edit_pad.default_height

Specifies the initial height of OPNET text editor windows, in pixels.

Data Type

integer

Default Value

480

edit_pad.default_width

Specifies the initial width of OPNET text editor windows, in pixels.

Data Type

integer

Default Value

640

edit_pad.drag_and_drop

Specifies whether drag-and-drop editing is used by the built-in text editor. When
TRUE, drag-and-drop editing is permitted.

Data Type

boolean

Default Value

FALSE

edit_pad.font

Specifies the font used by the built-in text editor.

Data Type string
Default Value Windows:  “family:Lucida Console-size:8”
UNIX: “family:courier-face:medium-size:12”

edit_pad.selection_background_color

Specifies the background color for selected text in the built-in text editor.

Data Type

string

Default Value

RGB000
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edit_pad.selection_color

Specifies the text color for selected text in the built-in text editor.

Data Type string

Default Value RGB333

edit_pad.show_line_number

Specifies whether the built-in text editor shows line numbers for the displayed
text. When TRUE, line numbers are shown.

Data Type boolean

Default Value TRUE

edit_pad.text_background_color

Specifies the background color for text in the built-in text editor.

Data Type string

Default Value RGB333

edit_pad.text_color

Specifies the color of text in the built-in text editor.

Data Type string

Default Value RGB000

edit_pad.word_wrap

Specifies whether the built-in text editor should wrap lines of text when reaching
the edge of the display area. When FALSE, lines are not wrapped and thus
continue out of sight.

Data Type boolean

Default Value FALSE
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editor_config

editor_keep

editor_prog

Specifies the name of the editor configuration file used by the program. This file
defines the operations and menu layouts for the program.

The value of this preference changes only at start-up.

Data Type string

Default Value

Specifies how to handle temporary files used to transfer text between the
program and an external text editor such as vi, emacs, or notepad. When
FALSE, the files are automatically removed when the text editor quits. When
TRUE, the files are kept in the user's <op_adm n>/t np directory.

Data Type boolean

Default Value FALSE

Specifies a text editor to be used when editing text files other than source code.
(Use the code_editor_prog preference to specify a source code editor.) The
default text editor is the Guru text edit pad. To use an external editor such as vi,
emacs, or Notepad, set this preference to the path name of the editor to be
used.

If an external editor is specified, the program invokes it with one argument,
which is the name of a file containing the text to be edited. The modified text
must be in this same file when the text editor quits.

Guru includes two shell scripts for UNIX (vi_exec, and emacs_exec) and one for
Windows (notepad_exec.bat) that allow you to use external text editors within
Guru programs.

Data Type string

Default Value “builtin”
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expanded_subnets_iconic

When FALSE, expanding a subnet removes the subnet icon and creates a
bounding box based on the subnet’s extent. When TRUE, the subnet icon
remains in place and no bounding box appears. (Note that an object in the
expanded subnet may overlap the icon, so it may not be visible.)

Data Type boolean

Default Value FALSE

expanded_subnets_thickness

Specifies the thickness of the borders of expanded subnets, in pixels.

Data Type integer

Default Value 2

font

Specifies a default font used by various Ul components.

Data Type string

Default Value

html_export_max_image_width

Specifies the maximum width, in pixels, for exported HTML pages.

The value of this preference changes only at startup.

Data Type integer

Default Value 1024

http_port

Specifies the port number for ASN and web hot links. Set to -1 to disable.

The value of this preference changes only at startup.

Data Type integer

Default Value 81
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icon_autosizing.disable

Specifies whether automatic resizing of site icons in the workspace is enabled
or disabled. When FALSE, autosizing is enabled.

Data Type boolean

Default Value FALSE

icon_autosizing.large_element_count

Specifies a threshold for disabling icon autosizing. When the number of nodes
in a subnet exceeds this threshold, icon autosizing is disabled to avoid
excessive screen-redraw delays.

Data Type integer

Default Value 500

icon_autosizing.max_neighbors

Specifies the maximum number of overlapping neighbors OPNET will consider
before minimizing an icon. This number is interpreted loosely, but increasing it
will make automatic minimization less likely, and vice versa.

Data Type integer

Default Value 30

icon_dbs

Specifies which icon databases should be used by Guru GUI-based programs.
Although you could specify icons for all such programs at once, the programs
will start up faster if you specify icons separately for each program. For example,
to specify icon databases for op_vuanim in the environment database, you
would add the line:

op_vuani micon_dbs: sys, op_vuanim
Any number of icon databases can be listed, including user-created or user-

modified ones. Programs search the databases for an icon in the sequence in
which the databases are listed and use the first instance of the icon found.
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The value of this preference changes only at start-up.

Data Type string

Default Value

image_capture.border_width

Specifies how wide the black border placed around image captures should be.

Data Type integer

Default Value 0

image_capture.include_window _title

Specifies whether to include the window title when a window image is captured.
When TRUE, the title is included.

Data Type boolean

Default Value TRUE

image_capture.screen_hot_key

Specifies a special key combination to start an image capture of a selected area
of a window, as described in Capture Operations on page ITU-15-3.

Data Type string

Default Value ctrl-shift-t

image_capture.show_in_browser

Specifies whether an image of a window or screen rectangle should be
displayed in a browser after capture. When TRUE, the captured image is

displayed.
Data Type boolean
Default Value FALSE
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image_capture.window_hot_key

Specifies a special key combination to start an image capture of the active

window.
Data Type string
Default Value ctrl-t

load_image

Specifies an image to be displayed while the application starts up.

The value of this preference changes only at startup.

Data Type string

wn

Default Value

mark_nondefault_attrs

Specifies whether OPNET should use color in the Edit Attributes dialog box to
highlight attributes that do not inherit their default value. When TRUE, attributes
whose values are Intended or Changed have a colored background.

Data Type boolean

Default Value FALSE

mark_nondefault_attrs.changed_color

Specifies the color used to highlight values that have been changed in the
current instance of an Edit Attributes dialog box.

Data Type string

Default Value #FFDFBF
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mark_nondefault_attrs.intended_color

Specifies the color used to highlight values that do not inherit their attribute’s
default value, but which have not been changed in the current instance of an
Edit Attributes dialog box.

Data Type string

Default Value #BFBFFF

model_name

Specifies the name of a model to initially open when an application is invoked.
The value of this preference changes only at start-up.

Data Type string

Default Value

move_delta

Specifies the number of pixels the mouse must move to initiate a drag and drop
operation. This preference allows you to set the sensitivity of objects to being
moved (dragged). Too small a value for this preference may allow an object to
move slightly when your only intention was to click or double-click the object.

Data Type integer
Default Value 10
Units pixels

netbiz_show_promote_button

Specifies whether a Promote button is displayed in the attribute dialog boxes of
a Netbiz application. When TRUE, the Promote button is displayed.

Data Type boolean

Default Value FALSE

ITR-2-58 IT Guru/Release 11.0



Reference Guide 2—Preferences

network_add_world_map_to_new_models

Specifies whether a world map should be included in the top subnet of newly
created network models. When TRUE, the map is automatically included.

Data Type boolean

Default Value TRUE

network_layout.adjust_unconnected_groups

Specifies whether the spacing of unconnected groups of nodes in a subnet
should be adjusted. This preference applies to automatic layout operations
using the balanced algorithm (such as during a topology import or as part of the
Layout Nodes Automatically (Balanced) operation). Setting this preference to
FALSE turns off adjustment of unconnected groups and might speed up the
layout operation.

Data Type boolean

Default Value TRUE

network_layout.max_overlap_links_to_bend

Specifies the maximum number of overlapping links between nodes that will be
represented with bends by an automatic balanced layout operation (such as
during a topology import). The default value of —1 means no limit.

Data Type integer

Default Value -1

network_layout.use_simple_threshold

Specifies the number of sites in a subnet that will trigger the use of a simple, but
efficient, layout algorithm instead of the more balanced algorithm. The simple
algorithm corresponds to the Layout Nodes Automatically (Simple) operation.
Topology imports use this preference to determine which layout algorithm to

use.
Data Type integer
Default Value 1000
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network_links_infer_threshold

Specifies whether OPNET should scale link thickness using a threshold inferred
from the thresholds of attached nodes. When TRUE, link thickness will be
narrowed as the icons of the attached nodes are scaled down during zoom

operations.
Data Type boolean
Default Value FALSE

network_path_add_subnet_single_left_click

Specifies whether subnets can be added to a path object with a single left click,
rather than from a right-click menu. When TRUE, the left-click method is

enabled.
Data Type boolean
Default Value FALSE

network_positions_in_deg_min_sec

Specifies how the Project Editor displays degree-position attributes when a
subnetwork’s grid properties are expressed in degrees. If TRUE, degrees are
displayed in degrees-minutes-seconds format (e.g., 39 52' 46.30"). If FALSE,
degrees are displayed in decimal format (39.8795). You can set an object’s x
position and y position attributes using either format, regardless of this
preference’s setting.

Data Type boolean

Default Value FALSE

network_show_links_to_parent_subnet_objects

Specifies whether OPNET should show links from an object in one subnet to
objects in parent and sibling subnets. When TRUE, such links are shown.

Data Type boolean

Default Value TRUE

ITR-2-60 IT Guru/Release 11.0



Reference Guide

2—Preferences

network_use_trx_prompt

Specifies whether OPNET should open the transceiver/port chooser dialog box

when a user is manually hooking up links. When TRUE, the transceiver/port

chooser is opened. When FALSE, the transceivers and port are chosen
automatically.

Data Type boolean

Default Value TRUE

network_visualization.minimized_icon_pixel_threshold

Specifies the size threshold (in pixels) at which icons should be minimized. If an

icon is scaled to this size or smaller, the icon will be drawn according to the site’s
“minimized icon” preference.

Data Type integer

Default Value 12

network_visualization.minimized_icon_size

Specifies the size of a minimized icon, in pixels.

Data Type integer

Default Value 6

network_visualization.show_demand_labels

Specifies whether demands are labeled when drawn in the workspace.

Data Type enum

Default Value never

Constraints always, never
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network_visualization.show_labels_icon_pixel_threshold

Specifies the size threshold (in pixels) for labeling nodes. If a node’s icon is
larger than this size and the network_visualization.show_node_labels
preference is set to “for_icons_larger_than_specified”, the node’s label is
displayed. To change the minimum icon size, go to the View menu and choose
Edit Visualization Preferences... The Edit Visualization Preferences dialog box
appears. Select the Icons larger than radio button and change the number in the
text box to the minimum icon size you want.

Data Type

integer

Default Value

12

network_visualization.show_link_arrowheads

Specifies which links are drawn with arrowheads.

Data Type

enum

Default Value

for_simplex_links_only

Constraints

always, for_simplex_links_only, never

network_visualization.show_link_labels

Specifies whether links are labeled when drawn in the workspace.

Data Type

enum

Default Value

never

Constraints

always, for_off_page_links_only, never

network_visualization.show_node_labels

Specifies whether nodes are labeled when drawn in the workspace. The size for
the “for_icons_larger_than_specified” option is specified by the
network_visualization.show_labels_icon_pixel_threshold preference.

Data Type

enum

Default Value

for_non_minimized_icons

Constraints

always, for_non_minimized_icons, for_full_icons,
for_icons_larger_than_specified, never
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network_visualization.show_path_labels

Specifies whether paths are labeled when drawn in the workspace.

Data Type enum
Default Value never
Constraints always, never

obj_dbox_headers

Specifies text strings to be displayed in the Edit Attributes dialog box of objects.
Each string contains four pieces of information, separated by commas:

» <label_text>—A label indicating the value displayed, such as “Type "or
“Model: "

» <label_tooltip>—The text that appears in the tooltip when a user rests the
cursor over the label.

» <value_tooltip>—The text that appears in the tooltip when a user rests the
cursor over the label.

» <value_text>—The data that appears in the value field. You can specify data
from the model’s attribute list and self-description for this field.

For details about the text strings used in this preference, see Customizing
Header Information on page ITU-9-35 in the User Guide.

Data Type string list

Default Value <empty>

orbit_draw_style

Specifies whether satellite orbits are drawn as dashed or solid lines.

Data Type enum
Default Value dashed
Constraints dashed, solid
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panels_close_behavior

Specifies the behavior of the close box in analysis panels, as follows:

» query—Clicking the close box opens a dialog giving the option to hide or
remove the panel, or cancel the operation.

» hide—Clicking the close box hides the panel.

» remove—Clicking the close box removes the panel.

Data Type enum
Default Value query
Constraints query, hide, remove

panels_tile_columns_size

Specifies the number of columns to use when tiling analysis panels.

Data Type integer

Default Value 1

panels_tile_rows_size

Specifies the number of rows to create when tiling analysis panels.

Data Type integer

Default Value 1

panels_tile_sizing_automatic

Specifies how analysis panels are sized when being tiled. When TRUE, panel
sizes are calculated based on the number of panels and the window size. When
FALSE, panels are tiled using the sizes specified by panels_tile_x_size and
panels_tile_y_size.

Data Type boolean

Default Value TRUE
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panels_tile_spacing

Specifies the desired spacing between tiled analysis panels, in pixels.

Data Type integer

Default Value 1

panels_tile_x_size

Specifies the desired horizontal size of tiled analysis panels, in pixels.

Data Type integer

Default Value 35

panels_tile_y size

Specifies the desired vertical size of tiled analysis panels, in pixels.

Data Type integer

Default Value 35

program_banner

Specifies the text that appears as the title of the program window. The title is
usually taken from the program’s configuration file, which will be overridden if
this preference is given a value.

The value of this preference changes only at start-up.

Data Type string

Default Value

program_resources

Specifies program resources (. wr ¢ files) to be used in addition to those
specified in the <pr oduct >. et s file.

The value of this preference changes only at start-up.

Data Type string list

Default Value <empty>
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project_backup_on_dont_save

Specifies whether OPNET should back up project files when exiting the Project
Editor. When TRUE, projects are backed up regardless of whether they were
saved. When FALSE, projects are backed up only if saved.

Data Type boolean

Default Value FALSE

project_editable_attributes

Specifies a list of attributes that can be modified even if a project is read-only.

Data Type string list

Default Value <empty>

project_readonly

Specifies whether projects should be opened as read-only. When TRUE,
projects cannot be modified (except for attributes listed by
project_editable_attributes).

Data Type boolean

Default Value FALSE

recent_files_limit

Specifies the maximum number of recent files to list for each type of editor in the
File > Recent Files list.

Data Type integer

Default Value 5

report_top_n

Specifies the number of objects that will be included in the top results reports
(including SLA reports).

Data Type integer

Default Value 5
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scenario_name

Specifies the name of a scenario to open initially in the Project Editor. (This is
only useful if the model_name preference has been supplied and the Project
Editor is used to open the model.)

The value of this preference changes only at start-up.

Data Type string

Default Value

select_live_network

When TRUE, objects are selected dynamically as you drag the mouse in the
Project Editor workspace. When FALSE, objects are not selected until you
release the mouse button.

Data Type boolean

Default Value TRUE

self desc_validate

Specifies whether self-descriptions should be validated. When TRUE, Guru
validates all self-descriptions before importing a network. When FALSE, Guru
will trust the information currently stored in the self-description database, even
though it might be out-of-date with respect to node model changes, additions,
and removals.

Data Type boolean

Default Value TRUE

show_ca_count

Specifies whether the Count column should be displayed in compound object
attribute dialog boxes.

Data Type boolean

Default Value FALSE
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show_units

Specifies whether the Units column should be displayed in object attribute

dialog boxes.
Data Type boolean
Default Value FALSE

sim_duration_default

Specifies the default duration for simulations, in hours.

Data Type double

Default Value 1

splash_image

Specifies an image to be displayed in the main application window.

The value of this preference changes only at start-up.

Data Type string

Default Value

system_window_behavior

Specifies how the system (main application) window should behave. The
following behaviors are available:

» show_if_last—the system window will unhide and come to the front when the
last editor window is closed, thus allowing the user to open a new editor
window.

e quit_if_hidden—the application will quit without showing the system window
when the last editor window is closed. The user must restart the application
to open a new editor.

» hide_on_startup—same as quit_if_hidden, plus the application will start up
with the system window hidden if an editor has been opened via a preference
setting.
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* hide_when_inactive—same as hide_on_startup, plus the system window will
hide automatically whenever an editor is opened. The system window must
be explicitly opened via the Windows > System Window operation.

Data Type enum

Default Value show_if_last

title_autoplacing.directions

Specifies allowable directions (relative to an icon) for placing a site label.

Data Type enum
Default Value bottom/top/right/left
Constraints bottom/top/right/left, bottom/top, bottom/right/left, bottom

title_autoplacing.disable

Specifies whether automatic placement of site labels in the workspace is
enabled or disabled. When FALSE, autoplacement is enabled.

Data Type boolean

Default Value FALSE

title_autoplacing.try_small_font

Specifies whether automatic placement of site labels can try to use a smaller
font to make a label fit. When FALSE, a smaller font is not tried.

Data Type boolean

Default Value FALSE

tool_name

Specifies the name of an OPNET tool (such as the Project Editor) to initially
open when the program starts.

The value of this preference changes only at start-up.

Data Type string

wn

Default Value
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tool_open_save_behavior

Specifies whether a file chooser should be used when editors are opened and
saved. If used, the starting directory will be specified by the tool_open_start_dir
preference. The following behaviors are available:

browse_button_some—the Open and Save dialog boxes include a Browse
button, for only those editors so specified in the itguru. et s file.

browse_button_all—the Open and Save dialog boxes include a Browse
button, for all editors.

never_browse—never include a Browse button in the Open and Save dialog
boxes, regardless of any itguru. et s file specification.

always_browse—automatically open a file browser without providing the
standard Open or Save dialog boxes.

Data Type enum

Default Value browse_button_some

tool_open_start_dir

Specifies the starting directory for the file browser opened when editors are
opened and saved (if specified by the tool_open_save_behavior preference).

The value of this preference changes only at start-up.

Data Type string

Default Value

tool_override_dir_behavior

Specifies whether typed files in the same directory as a browsed-to model file
also should be included in the Flles window of the Open dialog box. The
following behaviors are available:

same_name—typed files with the same base name are included.
specific_file—only the browsed-to file is included.

all_files—all typed files in the directory are included (these files override any
identically named files in other mod_dirs directories).
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The value of this preference changes only at start-up.

Data Type enum

Default Value same_name

tooltip.annot_attributes

Specifies the list of attributes to show in tool tips for annotations.

Data Type string list

Default Value <empty>

tooltip.demand_attributes

Specifies the list of attributes to show in tool tips for demands.

Data Type string list

Default Value <empty>

tooltip.link_attributes

Specifies the list of attributes to show in tool tips for links.

When a new environment database file is created by the new_env_db attribute,
this preference is given the value "tool tip, name".

Data Type string list

Default Value <empty>

tooltip.object_update

Specifies whether to determine all object attributes before building the tool tip
for an object. If this preference is set to FALSE, then occasionally incorrect or
outdated information may appear in an object’s tool tip. Setting this value to
TRUE may result in slower performance.

Data Type boolean

Default Value FALSE
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tooltip.path_attributes

Specifies the list of attributes to show in tool tips for paths.

Data Type string list

Default Value <empty>

tooltip.site_attributes

Specifies the list of attributes to show in tool tips for sites (fixed, mobile, and
satellite nodes).

When a new environment database file is created by the new_env_db
preference, this preference is given the value "tooltip".

Data Type string list

Default Value <empty>

tooltip_delay

Specifies the delay after the cursor stops moving before the tool tip display
appears.

The value of this preference changes only at start-up.

Data Type integer
Default Value 1000
Units milliseconds

tutorial_top

Specifies whether or not the tutorial window is above all other windows on the
desktop, regardless of whether or not it is the active window.

This preference has no effect in the UNIX environment.

Data Type boolean

Default Value TRUE
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ui.hide_all_windows

Specifies whether Guru should display any windows. When TRUE, all windows
are hidden while the program runs.

Note—Because no windows are visible, Guru cannot be shut down normally.
You must use an automation script, the Windows Task Manager, or the UNIX
ki I'l command to stop the program.

This preference can be used only from the command line, and its value changes
only at start-up.

Data Type boolean

Default Value FALSE

ui.remember_window_sizes_and_positions

Specifies whether application windows should open with the same size and
position they had last. When TRUE, size and position are remembered. When
FALSE, windows open with their default size and position.

Data Type boolean

Default Value TRUE

ui_colors.tool_back

Specifies the background color of tool windows.

The value of this preference changes only at start-up.

Data Type string

Default Value RGB222 (light gray)

ui_colors.tool_fore

Specifies the color for foreground objects in tool windows, such as selection
markers and the text used for node names and grid numbering.

The value of this preference changes only at start-up.

Data Type string

Default Value RGBO000 (black)
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ui_colors.transparent_pixel_color

Specifies the color for transparent pixels when exporting images to formats such

as TIFF or GIF.
Data Type string
Default Value RGB222

ui_fonts.header

Specifies the header font used by various Ul components.

Data Type string

Default Value Windows: “family:Times New Roman-face:bold-size:18”
UNIX: “family:helvetica-face:bold-size:18”

ui_fonts.large

Specifies the large font used by various Ul components.

Data Type string

Default Value Windows: “family:MS Sans Serif-face:bold-size:12”
UNIX: “family:courier-face:medium-size:14”

ui_fonts.medium

Specifies the medium font used by various Ul components.

Data Type string

Default Value Windows: “family:MS Sans Serif-size:10”
UNIX: “family:courier-face:medium-size:12”

ui_fonts.small

Specifies the small font used by various Ul components.

Data Type string

Default Value Windows: “family:MS Sans Serif-size:8”
UNIX: “family:courier-face:medium-size:10”
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ui_fonts.tiny

Specifies the tiny font used by various Ul components.

Data Type string

Default Value Windows: “family:MS Sans Serif-size:7”
UNIX: “family:courier-face:medium-size:8”

ui_layout.hide_buttons

Specifies whether OPNET should hide action buttons. (This preference is useful
for providing more workspace on small screens.) When TRUE, action buttons
are hidden.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

use_tooltip_as_link_title

Specifies whether OPNET should display the first line of the tooltip text as a
label for links (subject to the setting of network_visualization.show_link_labels).
When TRUE, tooltip text is used as a label. When FALSE, the link name is used

as a label.
Data Type boolean
Default Value FALSE

verbose_report

Specifies that reports generated by the Generate Text Report command in the
Process, Packet Format, and IC| Editors should be done in verbose mode. In

non-verbose mode, only the name, type, value, and default value of an object
attribute is printed.

Data Type boolean

Default Value FALSE
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vudoc_prog

win_height

win_width

win_x

Specifies the path name of the Acrobat Reader program. Under UNIX, the value
of this preference typically remains blank because the program is installed in a
fixed location (sys/doc/viewer). Under Windows, Guru sets this value when it is
installed.

Data Type string

Default Value

Specifies the default height (in pixels) for tool windows that do not have a natural
size. This preference will not affect tool windows whose positions are
remembered if the ui.remember_window_sizes_and_positions preference is
TRUE.

Data Type integer

Default Value 600

Specifies the default width (in pixels) for tool windows that do not have a natural
size. This preference will not affect tool windows whose positions are
remembered if the ui.remember_window_sizes_and_positions preference is
TRUE.

Data Type integer

Default Value 760

Specifies the default x position (in pixels) for the first tool window. This
preference will not affect tool windows whose positions are remembered if the
ui.remember_window_sizes_and_positions preference is TRUE.

Data Type integer

Default Value 40
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win_x_inset

Specifies the minimum horizontal distance (in pixels) from the left or right screen
edge that is reserved when a window is opened.

Data Type integer

Default Value 0

win_x_stagger

Specifies the horizontal offset (in pixels) for subsequent tool windows after the
first one is opened.

Data Type integer

Default Value 15

win_y
Specifies the default y position (in pixels) for the first tool window. This
preference will not affect tool windows whose positions are remembered if the
ui.remember_window_sizes_and_positions preference is TRUE.
Data Type integer
Default Value 40
win_y inset

Specifies the minimum vertical distance (in pixels) from the top or bottom screen
edge that is reserved when a window is opened.

Data Type integer

Default Value 0

win_y_stagger

Specifies the vertical offset (in pixels) for subsequent tool windows after the first
one is opened.

Data Type integer

Default Value 35
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window_icon

Specifies the name of the icon to use for application windows.

Data Type string

Default Value “opnet_logo_small”

wrap_world_links

Licensing

Printing

printcmd

Specifies whether links should visually extend more than 180 degrees in
longitude. When TRUE, links are drawn using the shortest route between sites,
even if this means wrapping from the left side of the screen to the right. When
FALSE, all links are drawn continuously across the map.

Data Type boolean

Default Value TRUE

Licensing preferences indicate options that affect the licensing operations of
OPNET programs. These are described in the License Manager chapter of the
Administrator Guide. One additional preference that can be used with the
License Manager, tool_name, is a GUI preference, and is described in GUI
below.

The printing preferences control the generation of print output files (both
graphics and reports) and the spooling of print output files to a PostScript
printer. Guru programs that have the capability of generating print output files
accept these preferences.

Specifies the printer spooling program that will be invoked with PostScript
output files generated by graphical or report printing operations. The default
value of this preference is Ipr, the standard printer spooling program of the
Berkeley versions of UNIX. Another typical value assigned to this preference is
Ip, the standard printer spooling program of the System V versions of UNIX. In
addition to the printer spooling program name, the value of this preference can
include command line flags that appear before the name of the file being
spooled (for example, lpr -h).

Data Type string

Default Value "lpr"
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printername

Specifies the default printer. This will typically be the name of the default printer
specified in the UNIX environment.

Data Type string

Default Value

print_graph_method

Specifies how visible graphs will be printed:
» monochrome—black and white, with symbols used to identify traces.
» white-background—grayscale or color, with a white background.

 full-color—grayscale or color, with the background color assigned to the

graph.
Data Type enum
Default Value monochrome

print_page_limit

Specifies the maximum number of pages that will be printed in one print request.

Data Type integer

Default Value 100

User Lock

The user lock preferences provide options that affect the interpretation of user
model write locks by Guru programs. Guru programs that write out model files
accept these preferences.

edit_lock_mode

Specifies that models currently in use will have an edit lock placed on the
appropriate model files.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE
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named_locks

Specifies that a development name is to be used as the owner name for user
locks on model files. If this preference is set to TRUE, and the development
name is not specified by the user_lock_devhame preference, a prompt for the
development name will appear in the parent shell of the affected program. If this
preference is disabled, the user’'s account name is used as the owner of user
locks.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

user_lock_devname

Specifies the development name to be used as the owner name for user locks
on model files. The value of this preference is ignored if the preference
named_locks is FALSE.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

Web Reporting

The web reporting preferences provide options that affect the creation of HTML-
based reports by Guru.

web_rep_graph_enable

When TRUE, enables generation of web-compatible (GIF) graphics from
analysis panels.

Data Type boolean

Default Value FALSE
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web_rep_graph_height

Specifies the default height of a web-based report, in pixels.

Data Type integer

Default Value 300

web_rep_graph_width

Specifies the default width of a web-based report, in pixels.

Data Type integer

Default Value 500

web_rep_home_url

Specifies the URL of the simulation reports home page.

Data Type string

Default Value

web_rep_storage_dir

Full path of directory used to store web-based report files.

Data Type string

Default Value

web_rep_vendor_urls

Specifies a list of vendor links to be added to the web report home page,
allowing you to customize your report home page or link to other web-based
reports.

There must be exactly three consecutive lines in the following order for each
vendor:

* Vendor name

 Vendor URL
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* Vendor image name

Data Type string

Default Value

XML
The XML preferences provide options that affect the import and export of XML
files by OPNET programs.

xml_export_postproc_function

Specifies the name of a function to invoke for XML export post-processing.

Type string

Default Value “Nt_Xmle_Postproc_Default”

xml_export_postproc_library

Specifies the name of a library containing the XML export post-processing

function.
Type string
Default Value “nt_xmle_postproc”

xml_export_postproc_verbose_attrs

Specifies whether OPNET should export all attributes, regardless of intended
status. When TRUE, all attributes are exported.

Type boolean

Default Value FALSE

xml_import_postproc_function

Specifies the name of a function to invoke for XML import post-processing.

Type string

Default Value “Nt_Xmli_Postproc_Default”
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xml_import_postproc_library

Specifies the name of a library containing the XML import post-processing

function.

Type

string

Default Value

“nt_xmli_postproc”
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3 Program Descriptions

This chapter describes how to operate the programs, shell scripts, and batch
files that comprise IT Guru. It describes the external interface of each program
and utility, including the preferences that the programs accept.

The main Guru program (itguru) and several others use a graphical user
interface (GUI), which is described in the User Interface chapter of the User
Guide. Detailed instructions for using itguru to build models and run simulations
are given in the User Guide.

The following table lists the programs and utilities in the order in which they are
discussed in this chapter. Programs marked (U) are used under UNIX; those
marked (W) are used under Windows.

Table 3-1 IT Guru Programs and Utilities (Part 1 of 2)

Name Type Description
op_clrtmp (V) shell script Removes all files from the temporary file
i directory of the user’s administration directory

op_clrtmp.bat (W) batch file (<HOME>/op_admin/tmp).

op_flse program Releases licenses to the License Manager
when license-controlled programs are exited.

op_install shell script Provides a method for automating opnet
installation.

op_license_manager shell script Opens opnet in the manage license mode.

op_license_server program Issues licenses to licensed applications.

op_license_util program Does management operations for license
servers.

op_manfile program Does management operations related to the
tracking and identification of IT Guru model
files, including file location, locks, and header
contents.

op_runsim program Generates and runs simulations using model
information created with IT Guru.
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Table 3-1 IT Guru Programs and Utilities (Part 2 of 2)

Name Type Description

op_vuanim GUI program Permits viewing animation flows from an
executing simulation or an animation history
file.

op_vuerr program Prints function stack traceback and other
program error information.

itguru GUI program Permits editing and viewing IT Guru models,

executing simulations, and analyzing simulation
output results.

End of Table 3-1
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op_clrtmp

Description

Preferences

The op_clrtmp shell script and op_clrtmp.bat batch file remove all files from the
temporary file directory in your administration directory (<HOVE>/ op_admi n/

t np).

Several IT Guru programs generate temporary files in the course of executing.
These files are stored in the temporary file directory (<HOVE>/ op_adm n/

t np), as described in the section Temporary File Directory (tmp) on page ITR-
1-14. Some temporary files are removed as soon as the program that created
them completes execution. Other temporary files remain in this directory until
they are explicitly removed. The latter type of temporary file is usually PostScript
output that was being spooled to a laser printer (these files are retained so that
they do not have to be regenerated if the printing process happens to fail).

After many invocations of IT Guru programs or many print operations, the
temporary file directory can grow large, containing many files. When this occurs,
all directory files can be removed manually (with the UNIX command r m *, for
example). However, this approach is risky because it does not verify that the
user is actually in the proper directory. Thus, an incorrect assumption about
which directory is current can lead to accidental removal of valuable files.

A more reliable way to remove the files in the temporary directory is provided by
the op_cl r t np shell script (UNIX) and op_cl rt np. bat batch file (Windows).
These utilities can be invoked from any directory and will remove all files from
<HOVME>/ op_adnmi n/ t np, without risk of removing files in other directories.

Figure 3-1 Example Usage of op_clrtmp

% | s <HOVE>/ op_admi n/tmp

prtdoc. 268. 0. ps prtdoc. 5170. 1. ps prgf x. 23542. 0. ps
prtdoc. 268. 1. ps prrep.136. 0. ps prgf x. 23570. 0. ps
prtdoc. 268. 2. ps prgfx.136. 1. ps ptc_29273.0
prtdoc. 5170. 0. ps ndgf x. 136. 2. ps

% op_clrtnp

% | s <HOVE>/ op_admi n/tmp
%

The op_clrtmp and op_clrtmp.bat utilities use no preferences.

IT Guru/Release 11.0
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op_flse

Description

Preferences

The op_flse program releases licenses to op_license_server when an
application is exited.

The op_flse program is executed as a background process by all licensed
applications. It is the component of the licensing system that is responsible for
releasing licenses back to the License Manager. The op_flse program releases
licenses and not the applications themselves because the applications may
occasionally exit in uncontrolled circumstances, and so lock up a permit.

A license represents the right to use the application for one session. The status
of licenses is stored within the license file, a data file located in

e <primary_hard_drive>\OPNET_license\license_fil e(Windows
platforms)

o /opt/OPNET_license/license_fil e (UNIX platforms)

See the License Manager chapter in the Administrator Guide for details on
licenses.

When a licensed application exits, the corresponding op_flse process running
in the background detects the application process’s death and sends a
message to op_license_server indicating that the application’s license is how
free. Upon receipt, op_license_server changes the status of the license,
allowing it to be reissued.

The op_flse program is not intended for direct execution by users.

WARNING—Do not kill op_flse processes. If you do, the associated licenses
will never be returned to op_license_server.

The op_flse program uses the following preference sets:

» Standard preferences

» Diagnostics preferences

For details on the standard preferences set, see Standard Preferences on

page ITR-2-15. For details on other sets, see Preference Sets on page ITR-2-
27.

The op_flse program-specific preferences are not described here because they
are used only by licensed applications.
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op_install

Description

Preferences

The op_install program provides a method for automating OPNET installation.
op_install is a script that guides you through the installation process. It should
be run from the installation CDs.

For detailed instructions, see the installation sheets that came with the CDs or
the technical support area of the OPNET Technologies web site.

None, because this is a C Shell script.
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op_license_manager

Description

Preferences

The op_license_manager script opens opnet in the manage license mode.
When opnet opens in the manage license mode, it does not use a license, but
offers limited functionality. You can do license management tasks, but no other
operations. The mode is useful for a few reasons:

* You can do license management tasks without depriving others of a license.

* You can reliably delete a particular license. If you launch opnet and then
open the License Manager, you may find that the license you have been
allocated is the one you wanted to delete. You cannot delete an in-use
license.

You can also open opnet in this mode by launching it with the manage_licenses
preference.

None, because this is a C Shell script.
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op_license_server

Description

The op_license_server program runs as a service (on Windows platforms) or as
a daemon process (on UNIX platforms), issuing licenses to licensed

applications. A daemon process is one that executes continuously without being
attached to a user shell.

op_license_server manages the allocation of licenses. See the License
Manager chapter of the Administrator Guide for details.
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op_license_util

Description

Preferences

The op_license_util utility does management operations for license servers.

op_license_util supports the following single-operation modes. These are
specified by invoking op_license_util with the corresponding preferences:

» Check the status of a server ports (- port _check)
» Killalicense server (-1i cense_server _kill)

Figure 3-2 Example Usage of op_license_util

% op_license_util -port_check
The status of the ports on "titan"
usabl e for the license server:

port _a: unavail abl e
port_b: avail able
port_c: available

%op_license_util -license_server kill TRUE -license_server unreliable -1icense_port
port b

This program supports the following preference sets:
» Standard preferences

» Diagnostics preferences

» Licensing preferences

» Printing preferences

For details on the Standard preferences set, see Standard Preferences on
page ITR-2-15. For details on other sets, see Preference Sets on page ITR-2-
27.

For details on the Licensing preference set, see Chapter 3 Licensing on
page AG-3-1 in the Administrator Guide.

This program also supports the following additional preferences.

ITR-3-8
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license_server_Kkill

port_check

Specifies that the license server process be killed. This operation sends a
message to the license server, causing it to log its status just before exiting. This
operation prevents op_license_util from presenting an interactive user interface.
Only a user account that has write permissions on the license file can do this
operation. The values of the license_server and license_port preferences are
used to determine the location of the license server process. If these
preferences are not set, the license file is checked for the location of the license
server.

This preference can be used only from the command line.

Type boolean

Default Value FALSE

Specifies that the status of the three UDP/IP ports potentially used by the

licensing system be checked for availability on the local host computer. A list of
the three ports and their statuses is printed on the standard output device. This
operation prevents op_license_ util from presenting an interactive user interface.

This preference can be used only from the command line.

Type boolean

Default Value FALSE
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op_m

anfile

Description

The op_manfile program does management operations related to the tracking
and identification of IT Guru model files, including file location, locks, header
contents, and model security.

IT Guru model files have three portions: a file header, file comments, and model
data. The header portion of a model file contains tracking and identification
information for the file, such as the time at which the file was created. The
comment portion contains user-entered text descriptions of the file's data
contents and modification history. Model-derived object code files also contain
embedded, non-modifiable file headers. The header portion contains the
following information about the file:

* model type
» creation time and date
* name and release of the creating IT Guru application

» cearliest release of the creating IT Guru application that is compatible with the
file’s format

* |ast modification time and date

» version number of the file (that is, the number of times the file has been
written to disk)

» user account name and host computer name associated with the last
modification

» status of the file’s edit lock (edit locks are automatically set by IT Guru
applications that are editing a model file, to prevent concurrent editing of the
same file)

» status of the file’s user lock (user locks are manually set by users to indicate
temporary ownership and prevent other users from modifying the model
during a development phase)

* model security access information (status, number of registered sites,
access level of the local site, and world access status)

* model suite information (suite name and description, often including the
model vendor’'s name and contact information)

The header information can be useful in establishing the background of a model
file. IT Guru applications that manipulate model files can modify the above
information, but the only way to view this information is using op_manfile.
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The op_manfile program provides the following operations, each of which must
be specified from the command line. Only one operation can be done per
op_manfile session.

Table 3-2 op_manfile Operations

Description Preference

Find one or more models based on the file base name -find

Print the file header -header_print
Repair the file header -header_repair
Update the file header -header_update
Set the file version number -version_set
Add comments to a file -comments_add
Delete comments from a file -comments_del
Print file comments -comments_print
Set the edit lock -edit_lock
Release the edit lock -edit_unlock
Set the user lock -user_lock
Release the user lock -user_unlock
Display the file’s checksum -checksum
Register a model for access -register

End of Table 3-2

All op_manfile operations require a least one target model file, to which they are
applied (some operations can support multiple target files). The target model file
of op_manfile is specified by the preference m, mf, or f. Some commands (such
as register) also take an optional source model file, which is specified by the
preferences from, from_f, or from_mf. The general format of an op_manfile
command is as follows:

op_manfil e <operation> <target> <source>

Figure 3-3 shows an example of how to use the op_manfile program to register
the suite of models of which oscar_mode_a is a member. For more information
about registering protected models, see Chapter 17 Model Security on

page ITU-17-1.
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Figure 3-3 Example Usage of op_manfile (1)
op_manfile -register -suite -moscar_node_a

Send the following transaction code to the nodel vendor:
Transacti on code> OEDF. 98DB. 6438. F41A

Enter the approval code sent by the nodel vendor:
Approval code> 6833. FA47. 17Cl1. BA1A. 7C75. CODC

- op_manfile issued the following command: ---
/'bin/cp /dtayl or/op_model s/ oscar _node_a. nd. m\
/ dt ayl or/ op_adm n/ bk/ oscar _node_a. nd. m

Success.

The next example illustrates using the op_manfile program to print out header
information for a node model named atm16_crossconn.

Figure 3-4 Example Usage of op_manfile (2)

C. op_manfile -matnl6_crossconn -header _print

| ast nodification

file path C:\ CPNET\ 10. 5. A\ nodel s\ std\atm at nLl6_crossconn. nd. d
file type Derived Node Mdel
creation

date : Wd Feb 28 14:11:09 1996

application : op_cvdl b2

rel ease : 10.0. A PL2 (build 2308)

file data v. : 8.5.A

date . Fri Cct 03 22:26:29 2003

Versi on .27

user . opnet

host . sunbl ade60
edit lock

status unl ocked
user | ock

status unl ocked
security

status not protected
suite info (none avail abl e)

Preferences

The op_manfile program uses the following preference sets:
» Standard preferences

» Development preferences—core_dump, mem_track, mem_track_object,
prof_track, prof_track_func, and prof_track_recurse only

» Diagnostics preferences

ITR-3-12
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all

app_name

* File preferences—backup_max_count only
» Licensing preferences

» User Lock preferences

For details on the standard preferences set, see Standard Preferences on
page ITR-2-15.For details on the Licensing preference set, see

Chapter 3 Licensing on page AG-3-1 in the Administrator Guide. For details on
other sets, see Preference Sets on page ITR-2-27.

The op_manfile program uses the following program-specific preferences.

Specifies that the selected operation be expanded in its scope, in an operation-
specific manner. This preference modifies the following operations: edit_lock,
edit_unlock, find, header_print, user_lock, and user_unlock.

For a lock-related operation, the all preference causes the operation to be
applied to all model files located in the model directories (thus, specific files do
not need to be specified by the f, m, or mf preferences).

For the find operation, the all preference causes all models with duplicate
names in different model directories to be found. (Normally, a model found in a
higher-precedence model directory will override and effectively hide duplicate
models found in lower-precedence model directories).

For the print_header operation, the all preference causes the printing of multiple
headers present within a file, instead of just the first header in the file. (Only
simulations can contain multiple headers, due to the headers associated with
each model-derived object code module in the simulation file).

Type boolean

Default Value FALSE

Specifies the name of the application identified in the target file header as the
creator of the file. This preference’s value is used by op_manfile when a file
header is created with the header_add preference or when a file header is
updated with the header_update preference.

Type string

Default Value

IT Guru/Release 11.0
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checksum

Specifies that the checksum numbers of the target file be computed and printed.
This operation can be applied to any type of file via the f preference, including
program executables. The output of the operation is two integer checksum
numbers, identified as Add and Xor because of their respective computation
methods. File checksum numbers are used to determine whether a release file
has been corrupted. Contact Technical Support to compare your checksums
with the expected values.

Type boolean

Default Value FALSE

comments_add

Specifies that one comment be added to the target file. You enter the text of the
comment after a prompt that appears on the standard output device. Comments
are limited to one line of text; pressing the <Return> key completes the
comment. Comments are tagged with the date, user account name, and file
version associated with their addition to the file.

Type boolean

Default Value FALSE

comments_del

Specifies that all comments in the target file be deleted.

Type boolean

Default Value FALSE

comments_print

Specifies that all comments contained in the target file be printed to the standard
output device. Each comment is separated by a line of underscore, and is
tagged with the date, user account name, and file version number associated
with the comment’s addition to the file.

Type boolean

Default Value FALSE
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edit_lock

edit_unlock

find

Specifies that the target file’s edit lock be set, as if the file were being edited by
the program. This tags the file as “read only” and prevents all IT Guru programs
from modifying it. This operation is not typically used; instead, you can
temporarily lock a file with the user_lock preference.

Type boolean

Default Value FALSE

Specifies that the target file's edit lock be reset, thus allowing modification by
IT Guru programs. If the program exits abnormally, files that were being edited
by the program may retain edit locks. This situation can be rectified with the
edit_unlock preference.

Type boolean

Default Value FALSE

Specifies the full name and path of the target file on which operations will be
done. The file names must include file type suffixes and absolute or relative
paths.

Type string

Default Value

Specifies that op_manfile search the model directories for the target file(s) and
print information about their locations on the standard output device. The
location information includes the target file names (with suffix), types, and model
directories.

This operation does not request the selection of one target file if multiple model
files match a base name specified by the m preference; it locates all model files
that satisfy the target name. This operation cannot be used with the f
preference.

Type boolean

Default Value FALSE
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Specifies the base name of the source model from which to copy protection
information (that is, the model name without the file suffix or path). The
op_manfile program locates the specified model file in the model directories. If
more than one model file is found with this base name and the specified
operation requires one source file, op_manfile will request the selection of one
file from a menu of options printed on the standard output device.

Type string

wn

Default Value

from_f

Specifies the full name and path of the source model from which to copy
protection information. The file name must include file suffix and absolute or
relative path.

Type string

wn

Default Value

from_mf

Specifies the full name and file suffix of the source model from which to copy
protection information. The file hame should not include a path (the specified
model file will be located in the model directories).

Type string

Default Value

header_add

Specifies that header information be added to the target file.

Type boolean

Default Value FALSE
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header_print

Specifies that the header information of the target file be printed on the standard
output device. The header includes information about the file path and type,
creation, last modification, and security.

Type boolean

Default Value FALSE

header_repair

Specifies that the header information of the target file be repaired. If the program
issues an error message indicating that a model file is corrupted, this operation
may be able to repair the damage if it is limited to the header.

Type boolean

Default Value FALSE

header_update

Specifies that the header information of the target file be updated. An update
modifies all “last modification” fields in the header, including date, version
number, user account name, and host computer name. The creating application
name is also modified if the app_name preference is set.

Type boolean

Default Value FALSE

Specifies the base name of the target files on which operations will be done (that
is, the model name without the file type suffix or path). The op_manfile program
locates the specified model file in the model directories. If more than one model
file is found with this base name and the specified operation requires one target
file, op_manfile will request the selection of one target file from a menu of
options printed on the standard output device.

Type string

Default Value
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mf
Specifies the full name and file suffix of the target file on which operations will
be done. The file name should not include a path (the specified model file will
be located in the model directories).
Type string
Default Value
register
Registers a protected model file. Registration allows access to the model by
users at a specified site (IT Guru installation).
Type boolean
Default Value FALSE
suite
Specifies that all model files in the same suite as the specified model should be
registered. The suite preference must be used with the register preference.
Type boolean
Default Value FALSE
user_lock

Specifies that the target file’s user lock be set. This tags the file as belonging to
the user account that set the lock and prevents IT Guru programs being run by

other user accounts from modifying the file.

Type

boolean

Default Value

FALSE

user_unlock

Specifies that the target file’s user lock be reset, thus allowing programs run by
any user account to modify it.

Type

boolean

Default Value

FALSE
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version_set

Specifies that the target file’s version number be set to the specified integer
value (the default value of -1 specifies that no change be made).

Type

integer

Default Value

-1
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op_runsim

Description

The op_runsim program generates and runs simulations using model
information created with itguru.

The op_runsim program collects model information, creates an executable
model simulation, and executes that simulation. The program is the underlying
mechanism that is invoked when you execute a simulation from itguru. You can
also invoke op_runsim directly from the command line; both methods produce
the same results. When invoked from the Project Editor or Simulation Tool,
op_runsim runs in the background, allowing you to use other itguru tools while
it executes the simulation.

Simulation parameters are specified in op_runsim through the preferences
described in Preferences on page ITR-3-21. Many of these preferences
correspond to the simulation attributes used in itguru.

At simulation execution time, op_runsim loads the repository corresponding to
the specified network model. If the repository is missing or has an older date
than a component object file, op_runsim automatically creates or rebuilds it. The
necessary object files must already exist; op_runsim will not compile them
(except when the c preference is used).

To invoke op_runsim, enter the program name and network model name, plus
any other desired preference values. The net_name preference is required.
Because simulations are usually run repeatedly, with changes to only a few of
the preferences, it is often convenient to create an environment file containing
the unchanging preference values and pass its name to op_runsim along with
the preference values that change with each run.

Note—You must have an unexpired (free or in-use) IT Guru product license to
run simulations. If op_runsim cannot find a valid license installed on your
system, it terminates with an error message.
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Preferences

The following example shows how to invoke op_runsim using an environment
file to supply values for unchanging preferences.

Figure 3-5 Example Usage of op_runsim

op_runsim-net _name eth_net -ef ethnet

Contents of environment file ethnet:

# Specifications for ethernet sinulation “eth _net”

pr obe: et h_probes
ov_file: et h_out
seed: 115

durati on: 100000

ani mvi ew, TRUE

ani m hi st: eth_anim

The op_runsim program uses the following preference sets:

» Standard preferences

» Development preferences—all except ema_verbose
» Diagnostics preferences

» Licensing preferences

» User Lock preferences
For details on the standard preferences set, refer to Standard Preferences. For
details on the Licensing preference set, see License Manager in the

Administrator Guide. For details on other sets, refer to Preference Sets on
page ITR-2-27.

The op_runsim program uses the following program-specific preferences.

anim_attempts

Specifies the maximum number of times op_runsim will attempt to send an
animation request packet to the op_vuanim program. If this count is exceeded,
op_runsim will disable animation and will no longer transmit animation requests.
(For more information, see the related preferences anim_view and
anim_timeout.)

Type integer

Default Value 5
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anim_hist

Specifies that animation be enabled within op_runsim and that animation
requests be captured in a file for later viewing by the op_vuanim program. The
file will be given the name specified as this preference’s value, with the file type
suffix “.ah” (animation history).

Type string

wn

Default Value

anim_host

If animation is enabled, specifies a host computer running the op_vuanim

program to which op_runsim will send animation request packets. The default
value indicates that op_vuanim is running on the same host as the simulation.
(For more information, see the related preferences anim_view and anim_port.)

Type string

Default Value localhost

anim_port

Specifies an offset to be added to the default animation UDP/IP port number
(3211) when op_runsim attempts to contact the op_vuanim program. This
allows communication to be established between op_runsim and op_vuanim
even if the default port is already in use. (For more information, see the related
preferences anim_view and anim_host.)

Type integer

Default Value 0

anim_timeout

If animation is enabled, specifies the time-out interval for animation request
packets. The op_runsim program will wait this length of time for a response from
the op_vuanim program before resending the request. (For more information,
see the related preferences anim_view and anim_attempts.)

Type double
Default Value 3.0
Units seconds
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anim_view

attr_reqs_file

child_id

Specifies that animation be enabled within op_runsim and that animation
requests be sentto a concurrently running op_vuanim program. (The anim_host
and anim_port preferences may also be set to specify the location of the
op_vuanim program to which the animation requests will be sent.)

Type boolean

Default Value FALSE

Specifies an environment file in which to save promoted attribute requests.
When op_runsim is invoked, it may initially prompt you to enter values for
promoted object attributes. If this preference is set, these attribute assignments
are saved in an environment file with a name composed from the argument
value and the “.ef” file type suffix.

Type string

wn

Default Value

Specifies that all object files referenced by the network model are to be
recompiled and the repository rebuilt prior to building the simulation. This option
is useful when a simulation needs to be comprehensively rebuilt from its basic
components, as in situations where it is not known which models have been
changed since the last build.

Type boolean

Default Value FALSE

Specifies the child ID of op_runsim, which the program uses to identify itself
when communicating with the itguru program (simulations spawned by the
Project Editor or Simulation Tool are child processes of itguru).

This preference is used by itguru only; do not set it when running op_runsim
from a shell.

Type integer

Default Value -1
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collect_model_deps_in_file

cosim

debug

duration

Specifies a file in which op_runsim will generate a list of model files referenced
during a simulation. If no file is specified, the dependency list is not generated.
See Dependencies Page (Simulation Components) on page 1TU-13-36 for
more details.

This is a command-line-only preference whose value changes only at start-up.

Type string

wn

Default Value

Specifies a simulation description file that op_runsim will use to find the other
simulators for a cosimulation. If no file is specified, cosimulation is not
performed.

This is a command-line-only preference whose value changes only at start-up.

Type string

wn

Default Value

Specifies to execute the simulation under the control of the OPNET Simulation
Debugger (ODB), which provides a character-oriented command interpreter
shortly after execution commences.

Type boolean

Default Value FALSE

Specifies the intended duration of the simulation. The value is interpreted in
terms of simulation time, rather than real execution time. Simulation events
scheduled for times later than the duration value will be discarded when the
simulation ends. A simulation may end before the duration value is reached due
to a program abort or process-requested termination.

Type double

Default Value 1000.0000
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endsim_memstats

When TRUE, specifies that a memory statistic report will be automatically
generated when the simulation terminates. This report is similar to that
generated by the ODB nenst at s command. If the simulation was launched
from the OPNET GUI, the output is displayed in the Memory Stats pane of the
Simulation Sequence dialog box; otherwise, output goes to the console.

Type boolean

Default Value FALSE

event_order_method

Specifies how the processing order for events occurring at the same simulation
time is determined. If strict, events are ordered by the following keys:

1) Object (module) priority
2) Interrupt priority

3) Natural (event) order

If partial, events are ordered either by object priority (for events in different

objects) or interrupt priority (for events in the same object), with ties resolved by
event order in both cases.

Type enum

Default Value strict

Constraints strict, partial

event_speed_parameter

This preference provides an advanced event management system that can be
tuned to maintain peak performance when simulating very large systems.

Larger values will result in faster simulations. The trade-off is that higher values
of event_speed_parameter require additional memory.
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At the end of each simulation, OPNET calculates a value for this preference and
reports it in the Simulation Log. Optimal values depend on the type and size of
models. You may want to experiment with different values and compare the
simulation's performance. In general, increasing this parameter will not yield
significant performance gains for small, lightly-loaded systems.

Type

integer

Default Value

100,000

fully_serialized_event_ids

fully_serialized_event_execution_ids

When TRUE, op_runsim replaces the event ID scheme (in which IDs are
serialized by module) with the global serialization used prior to OPNET 10.0.

Type

boolean

Default Value

TRUE for sequential kernels;
FALSE for parallel kernels

When TRUE, op_runsim replaces the event ID scheme (in which IDs are
serialized by module) with the global serialization used prior to OPNET 10.0.

Type

boolean

Default Value

TRUE for sequential kernels;
FALSE for parallel kernels

fully_serialized_ici_ids

When TRUE, op_runsim replaces the ICI ID scheme (in which IDs are serialized

by module) with the global serialization used prior to OPNET 10.0.

Type

boolean

Default Value

TRUE for sequential kernels;
FALSE for parallel kernels
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fully_serialized_packet_ids

When TRUE, op_runsim replaces the packet ID scheme (in which IDs are
serialized by module) with the global serialization used prior to OPNET 10.0.

Type boolean

Default Value TRUE for sequential kernels;
FALSE for parallel kernels

jitd_cmd_line
Specifies a command line to use for launching a just-in-time debugger (Solaris
only).
Type string
Default Value
jitd_enable

When TRUE, enables just-in-time debugging (Solaris only).

Type boolean

Default Value FALSE

livelock _thresh

Specifies the threshold used to determine when a process model has entered a
livelock condition (that is, the process model is continually making transitions
without reaching an unforced state). The threshold value is a maximum count
for the number of transitions that can be done on one process model invocation
without causing a warning.

Type integer
Units transactions
Default Value 8192
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log_endsim_perf

Specifies that Guru should generate a simulation log entry based on the final
performance report.

Type boolean

Default Value FALSE

log_file

Specifies the name of the simulation log file (<name>.log).

Type string

wn

Default Value

max_log_entries

Specifies the maximum number of entries in the DES log.

Type integer

Default Value 200

mem_track

Specifies to enable memory allocation and deallocation tracking features of the
Simulation Kernel for use within ODB. If mem_track is enabled, the ODB
commands nmensr ¢ and mensnk can be used to obtain lists of the allocation
sources and deallocation sinks within a simulation. If mem_track and
mem_track object (see below) are disabled, mensr ¢ and mensnk are not
functional.

Note—This preference is part of the Development preference set, but is also
documented here due to its special role in simulations).

Type boolean

Default Value FALSE
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mem_track _object

Similar to mem_track, above, except that mem_track_object enables detailed
memory allocation and deallocation tracking features for a particular memory
object type, such as a packet or process handle. If mem_track and
mem_track object are disabled, memsrc and memsnk are not functional.

Note—This preference is part of the Development preference set, but is also
documented here due to its special role in simulations.

Type boolean

Default Value FALSE

memstat_autogen

memtag_all

Specifies how often the simulation will generate memory statistics. When the
simulation is run from the GUI, updates go to the Memory Stats tabbed page of
the Simulation Sequence dialog box. When the simulation is run from the
command line, a memstats table is printed to the console. The following values
are possible (where F represents a positive float and N represents a positive
integer):

» ‘“progress” —when a progress report is generated

* ‘“enter_0" —at time 0, before the first event is executed

» ‘“leave_0" —at time 0, after all events have been executed

» ‘“enter_F"—every time F, before events are executed

» ‘“leave_F"—every time F, after all events in the timecell are executed

* ‘“every_N"—every N events

Type string

Default Value

Specifies whether the simulation should tag memory allocations for tracing on
the Memory Sources tabbed page of the Simulation Sequence dialog box.
When TRUE, all allocations are tagged. When FALSE, no allocations are
tagged.

Type boolean

Default Value FALSE
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memtag_list
Specifies a list of memory categories for which the simulation should tag
memory allocations. This tagging is used for memory source tracing on the
Memory Sources tabbed page of the Simulation Sequence dialog box.
Type string list
Default Value
net_name

Specifies the name of the network model that will be loaded by the simulation.
This preference is required for op_runsim. For static simulations, this preference
can be left unset (in which case, it defaults to the name of the static simulation).
The value of net_name is used as a default for the anim_hist, ef, log_file, os_file,
ov_file, and probe preferences.

This preference is required, and can be used only from the command line.

Type string

wn

Default Value

num_collect_values

Specifies the default maximum number of values to collect for each statistic
during a simulation. This value can be changed for a given scenario in the
Configure/Run DES dialog box.

Type integer

Default Value 100

opnet_port

Specifies the IPC port to be used for communication with itguru. This preference
is used only when op_runsim is invoked from within itguru.

Type integer

Default Value 0
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os_file
Specifies the name of the output scalar file to be used to log scalar values from
op_runsim. The “.0s” suffix of the file should not be included in the preference
value. If this preference is unassigned, the simulation will not log scalar values.
Type string
Default Value
ov_file

Specifies the name of the output vector file to be used to record vector statistic
values from op_runsim. The . ov suffix of the file should not be included in the
preference value. If this preference is unassigned, op_runsim will write vector
values in a file with the same name as the network model.

Type string

Default Value

ov_mem_size

Specifies the maximum size of the output vector data buffer in megabytes.
When a buffer reaches the specified limit, its entries are written to disk, and it
resumes the collection of new values. Setting this preference to larger values
than the default trades off less writes to disk versus more memory usage. If
fragments are allowed to grow too large, the simulation may need to use swap
space which will reduce execution speed.

Type integer

Default Value 4

parallel_sim.event_execution_time_window

Specifies a window of simulation time, the events within which can be
considered for concurrent execution.

Type double
Default Value 0.0
Units seconds
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parallel_sim.num_processors

Specifies the number of processors to be used by the Simulation Kernel. This
preference applies only to the parallel kernels. If this preference is set to 0 or
Maximum, the simulation will try to determine the number of CPUs available and
use them all. This value can be changed for a given scenario in the Configure/
Run DES dialog box.

WARNING—Requesting simulations to use more CPUs than are physically
present and available will degrade simulation performance dramatically.

Type integer

Default Value 1

per_module_random_stream

When FALSE, specifies that all random numbers are generated from the same
stream. Thus, adding new distributions into a simulation will modify existing
ones.

When TRUE, specifies that each module maintains an independent random
stream. Thus, adding new nodes or modules will not affect existing modules.
This also makes it easier for parallel simulations to have reproducible results.

Type boolean

Default Value FALSE for sequential kernels;
TRUE for parallel kernels

probe

Specifies the name of the probe file to be used to guide collection of statistics
and subsequent recording of vector data by op_runsim. The “.pb.m" suffix of the
probe file should not be included in the preference value.

Type string

Default Value

probe_error_enable

Enables warning messages about probe mismatches during simulation loading.

Type boolean

Default Value FALSE
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probe_start_time

If positive, specifies a simulation time before which no probing takes place. The
start times of individual probes will be taken into account only if later than this

time.
Type double
Default Value -1.0
Units seconds

probe_stop_time

If positive, specifies a simulation time after which no probing takes place. The
stop times of individual probes will be taken into account only if earlier than this

time.
Type double
Default Value -1.0
Units seconds

rand_num_ext_res

realtime_ratio

Causes op_runsim to generate random numbers with extended resolution (that
is, with a wider range of possible outcomes). To generate random numbers that
are compatible with IT Guru releases prior to 4.0, assign this preference the

value FALSE.
Type boolean
Default Value TRUE

Specifies a speed ratio (relative to real time) that op_runsim uses to control the
speed of a cosimulation. Note that the requested speed might be unachievable,
in which case the simulation will run as close to the requested speed as

possible. For example:

0 — run simulation at full speed

1 —runin real time

0.1 — run 10 times slower than real time (that is, one-tenth of the real-time

speed)
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e 5 —run 5 times faster than real time

Type double

Default Value 0

rec_err_suppress

Specifies that the simulation should suppress the printing and logging of
recoverable errors.

Type boolean

Default Value FALSE

record_gstats

Specifies that op_runsim should record all global statistics in the output vector
file, regardless of the probe definitions.

Type boolean

Default Value FALSE

reports

Specifies a set of web report probe files to use during simulation.

Type string list

Default Value <empty>

repositories

Specifies the set of code repositories to load for simulation.

If you specify repository files, op_runsim uses them instead of the default set.
This means that:

* op_runsim reports “loading repositories” instead of “building network
repository” at the beginning of a simulation.
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seed

» If your model calls functions not in the specified set, op_runsim reports
failure.

Type string list

Default Value <empty>

Specifies the seed value to be used by op_runsim’s random number generator.
one random number stream is used by all stochastic mechanisms in the
Simulation Kernel.

Type integer

Default Value 0

sim_packet_sharing

Specifies the packet sharing mode used by the simulation kernel. To reduce
simulation run time and conserve memory, packets can be shared when copies
are needed (for example, when transmitted to multiple receivers). When
packets are copied, only the packet header is copied at first. The packet copy
references the fields in the original packet. Later, if a field of either the original
packet or the copy is to be changed, all of the packet fields are copied to the
packet copy. The possible values for this preference are:

» Full—All packets are shared. This is the most efficient setting, but requires
that the structure fields not be modified directly when in a packet.

» Conservative—[default] All packets are shared except those with information
that can be accessed directly by a model (such as structure field content).

+ Disabled—Packets are never shared.

Type enum
Default Value conservative
Constraints conservative, disabled, full
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sim_process_priority

Specifies the scheduling priority of the discrete event simulation process within
the operating system.

Type enum

Default Value normal

Constraints normal, high, low (Windows)
normal, low, lowest (UNIX) !

1. Non-superusers on UNIX cannot increase the priority of a process.

sim_time_quantum

Specifies the smallest quantum of time that the Simulation Kernel will resolve.
For instance, if 1 ms is specified, simulation events will only occur on 1-ms
boundaries. Events scheduled for times that are not multiples of the specified
guantum will be rounded to the nearest quantum multiple. If this preference is
not specified, simulation time values are not quantized and have the full
resolution of double-precision floating-point variables.

Type double
Units microseconds
Default Value 0.0

site_position_cache_size

Specifies how many positions are cached by each mobile site, in addition to the
current position. Although caching multiple positions can help the simulation run
faster, the speed increase uses additional memory. Requires Wireless module.

Type integer

Default Value 3

sla_compute_all_violations

Normally, OPNET does not compute compliance for statistics that are
bucketized by default as count, sum over time, or time average. If TRUE,
OPNET will compute compliance for all statistics.

Type boolean

Default Value FALSE

ITR-3-36 IT Guru/Release 11.0



Reference Guide

3—Program Descriptions
sla_reports

Specifies Service Level Agreement report probe files to use during simulation.

Type

string

Default Value

split_start_radio_transmission

Specifies whether to split the start of a radio transmission into separate events
for each potential receiver. This is used to obtain parallel processing of packets
in wireless simulations. See Parallel Simulation on page WM-3-11 for details.

Type

boolean

Default Value

FALSE for sequential kernels;
TRUE for parallel kernels

update_interval

Specifies the interval of simulation time that is to elapse between printing

simulation update messages, which are generated when the verbose_sim
preference is set to TRUE.

Type double
Units seconds
Default Value 100.0

verbose_cell_size report

When TRUE, specifies that the simulation generate a report giving the
distribution of events per time cell. In parallel simulations, this report also

contains the number of events processed in parallel. See Cell Size Report on
page ITU-13-42 for details.

This preference is available only in sequential development kernels.

Type boolean

Default Value FALSE
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verbose_event_report

When TRUE, specifies that the simulation generate a report giving details about
event generation.

This preference is available only in sequential development kernels.

Type boolean

Default Value FALSE

verbose_event_timing_report

When TRUE, specifies that the simulation generate a report giving the average
event processing rate per time cell. This report provides a view of the event
execution happening in a simulation to analyze its potential for good parallel
simulation. See Event Timing Report on page 1TU-13-44 for details.

This preference is available only in sequential development kernels.

Type boolean

Default Value FALSE

verbose_ load

When TRUE, specifies that op_runsim print messages describing model files as
they are loaded. The messages are printed to the standard output.

Type boolean

Default Value FALSE

verbose packet_report

When TRUE, specifies that the simulation generate a report giving details about
packet creation.

This preference is available only in sequential development kernels.

Type boolean

Default Value FALSE
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verbose_parallel_speedup_report

verbose_sim

When TRUE, specifies that the simulation generate a report predicting the
potential increases in execution speed for various numbers of processors. This
report can be used to estimate the value of using parallel simulation. See

Parallel Speedup Report on page ITU-13-41 for details.

This preference is available only in sequential development kernels.

Type

boolean

Default Value

FALSE

Specifies that op_runsim print update messages to the standard output during
mainline execution (that is, in the post-loading phase). The messages indicate
the number of events that have executed, the elapsed real and simulated times,

and the efficiency of the simulation in events-per-second.

Type

boolean

Default Value

FALSE
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op_vuanim

Description

The op_vuanim program is a GUI-based, license-controlled application used to
view animation flows from an executing simulation or an animation history file.

Animation flows are dynamic sequences of graphics operations that depict the
changing state of a simulation. Animation flows are generated by simulations,
but can only be viewed within the GUI environment of the op_vuanim program.
One simulation run is limited to generating one corresponding animation flow.
An executing simulation can store its animation flow in an animation history file
or directly communicate it to an executing op_vuanim process via the IP
communication protocol.

Animation flows define one or more viewers, which are rectangular areas in
which graphics operations (termed animation requests) are done. Animation
requests always depict dynamic elements in the context of a model diagram.

The op_vuanim program supports several operations for manipulating
animation flows. Most of these operations can be applied to an animation flow
from either an executing simulation or a history file. This program allows you to
do the following:

» Specify an animation history file to be read.

o Start, stop, or pause playback of the current animation flow.

» Restart playback of the current animation flow.

* Increase or decrease the speed of the current animation flow’s playback.

» Step forward to the current animation flow's next request or to the current
animation’s request associated with the next simulation event or time.

» Clear out the current animation flow.
» Limit display of animation requests to the current viewer.

» Print the state of the animation flow playback to the standard output device
for diagnostic purposes.

» Standard GUI-based operations (such as capturing a screen bitmap in a
TIFF, GIF, or EPSI file).

Instructions for op_vuanim are presented in the Viewing Results chapter of the
User Guide.

ITR-3-40

IT Guru/Release 11.0



Reference Guide

3—Program Descriptions

Preferences

anim_port

auto_play

The op_vuanim program uses the following preference sets:
» Standard preferences

» Development preferences—core_dump, mem_track, mem_track_object,
prof_track, prof_track_func, and prof_track_recurse only

» Diagnostics preferences
» Licensing preferences

» GUI preferences—all except creation_mode, drag_obj_threshold,
editor_config, move_delta, and show_units

For details about the standard preferences set, see Standard Preferences on
page ITR-2-15. For details about the Licensing preference set, see the License
Manager chapter of the Administrator Guide. For details about other sets, see
Preference Sets on page ITR-2-27.

The op_vuanim program uses the following program-specific preferences.

Specifies the animation port, the numeric ID of a communication port that is
established by an op_vuanim process. To send animation requests to a
Op_vuanim process, an executing simulation must be informed of the host on
which the process is executing and the animation port established by the
process. The animation port is based on the port mechanism of the UDP/IP
protocol stack used as the communication channel between simulations and
op_vuanim processes. The value of this numeric ID is an offset applied to the
UDP port ID of the default animation port (which is 3211).

Type integer

Default Value 0

Specifies that animation should be played automatically when the program
starts.

Type boolean

Default Value FALSE
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m

Specifies the base name of an animation history file to be pre-loaded as the
initial animation flow within op_vuanim. The program searches for the specified
animation history file in the model directories. Do not include the file path or file
type suffix in the value of this preference.

Type string

wn

Default Value

map_backing_store

Specifies that map backgrounds displayed in animation viewers be cached as
bitmaps using the off-screen server memory (“backing store”) of the X Window
System display device. Caching a map as a bitmap can provide for substantially
faster redrawing of the affected animation viewer, if the map is complex. If
caching is not done, then redrawing a map entails many line drawing
operations.

Setting this preference to TRUE may cause requests to the X Window System
display for large amounts of off-screen server memory. This is typically not a
problem on workstations, but X terminals with 4 MB or less of display memory
may experience memory shortages.

Type boolean

Default Value TRUE

vector_buf_size

Specifies the number of vector entries per allocated buffer.

Type integer

Default Value 1024
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op_vuerr

Description

The op_vuerr program prints out function stack traceback and other program
error information. The error information is extracted from an error log maintained
by programs supplied by OPNET or based on OPNET object code libraries.

The op_vuerr program provides a direct way to view the most recently logged
errors from IT Guru programs. It opens up the error log, searches out the last
error (or last n errors, if specified), and prints out the traceback information on
the standard output device. The program can be executed from any directory.

Typically, IT Guru programs handle error conditions and program crashes using
a unified error package. This package indicates the error by updating a
message area (if the program has a graphical user interface) or by printing
messages on the standard output device. In all cases, errors are also logged in
an ASCII file named er r _| og within the administration directory (<HOVE>/
op_adni n).

Each entry in err _I og has the following components:

» Error classification, which indicates the severity of the error. The possible
classifications are:

— Warning—A situation that may lead to problems and that should be
checked by the user.

— Recoverable Error—A problem that does not prohibit the program from
proceeding, but that may result in cancellation of the current operation.

— Program Abort—A problem that prohibits the program from reliably
proceeding and therefore causes the program to immediately abort.

— Program Fault—A problem that causes the operating system to
immediately abort the program in an uncontrolled manner.

» Date and time when the error occurred.

» Program in which the error occurred.

» Package of functions in which the error occurred.
» Function in which the error occurred.

» Description of the error, including variable values and related information
which can serve to identify the error’s cause.

» Contents of the program-maintained function stack, which can be used by
technical support personnel to help identify the location and cause of the
error.
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The error log continues to grow as program errors occur and traceback
information is added to the file. The error log is cumulative so as to provide a
reliable description of a recent sequence of errors that users or technical
support personnel can use to investigate the cause of the errors.

Typically, the error log will grow to many thousands of lines after a month of
heavy use of IT Guru programs, so you should check the log’s size regularly if
disk space is at a premium. The error log file can be removed at any time to
reduce disk space usage; it will be recreated as needed when the next error is
logged.

Figure 3-6 Example Usage of op_vuerr
op_vuerr

<<< Program Abort >>>

Ti me: Fri May 17 17:31:48 1999

Program op_runsim (Version 7.0.B)

Package: Simul ation Kernel

Function: simerr_print (severity_ level, str0, strl)

Error: Error encountered rebuilding repository -- unable to proceed
(0), EV (-1), MOD (NONE), PROC (sim.load_repos_| oad)

— * ¥ ok * %

* Function call stack: (builds down)

Cal | Bl ock
Count Line# Function

0) 1 267 main (argc, argv, envp)

1) 1 204 siminit (argc, argv, envp)

2) 1 148 simload_nodel s (net_name)

3) 1 571 simload_repos_load (net_nane)

4) 2 171 simerr_print (severity level, str0, strl)

5) 3 224 Vos_Error_Print (level, package, errorQ, errorl, error2)

Each line in the function call stack contains a call count and a block line number
in addition to the function name and arguments. The call count specifies the total
number of times that the function has been called since the start of program
execution. The block line number specifies the last source-code line number
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which was known to have executed within that function at the time of the error.
The block line number is not a fine-grained measure and does not necessarily
list the exact line number executed within the function at the time of the error.

The example in Figure 3-7 shows this.

Figure 3-7 Sample Code with Four Error Locations

1 int function()

3 nt x, vy, z;
4 int *ptr;
5
6 z =0 A
; for (x = 0; x < 10; x++)
?o for (y =0; y < 10; y++) B
11 z +=y,
12 Z += X C
13 }
14
15 return z; D
16
Preferences
The op_vuerr program uses the following preference sets:
o Standard preferences
» Development preferences—core_dump, mem_track, mem_track_object,
prof_track, prof_track_func, and prof_track_recurse only
» Diagnostics preferences—beep_count_confirm and beep_count_error only
For details on the standard preferences set, see Standard Preferences on
page ITR-2-15. For details on other sets, see Preference Sets on page ITR-2-
27.
The op_vuerr program uses the following program-specific preference.
num_err

Specifies the number of errors to be extracted from the error log and printed to
the standard output device. The most recent n errors are printed by op_vuerr
(the last n entries in the error log), where n is the value of this preference.

Type integer

Default Value 1

IT Guru/Release 11.0 ITR-3-45



3—Program Descriptions

Reference Guide

itguru
The itguru program is a GUI-based, license-controlled application used to edit
and view IT Guru models, execute simulations, and analyze simulation output
results.

Description
This is the main program of IT Guru. Itis here that you use the Project Editor to
conduct modeling and simulation projects.
The itguru program supports a large array of preferences that affect its
operation, as described in the following subsection. Detailed operational
instructions for Guru are presented throughout the User Guide. An introduction
to using Guru is presented in the online tutorial.
Preferences

The itguru program uses the following preference sets:
» Standard preferences
» Development preferences
» Diagnostics preferences
» File preferences
* GUI preferences
» Licensing preferences
» Printing preferences
» User Lock preferences
» Web Reporting preferences
» XML preferences
For details on the Standard preferences set, see Standard Preferences on
page ITR-2-15. For details on the Licensing preference set, see
Chapter 3 Licensing on page AG-3-1 in the Administrator Guide. For details on
the other sets, see Preference Sets on page ITR-2-27.
This program also supports preferences for specific add-on modules; these
preferences are described in the corresponding module manuals.
The itguru program uses the following program-specific preferences.
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aliases_verify

When set to TRUE, itguru verifies that all node aliases in the current scenario
are unique. itguru does this whenever you change a node alias, import a
topology or import an alias set. A text edit pad lists any duplicate aliases found.

Type boolean

Default Value TRUE

an_mono_sym

Specifies that analysis panels drawn on monochrome displays should visually
distinguish separate traces with uniqgue marker symbols (such as triangles and
circles). The value of this preference also applies to multi-trace panels that are
printed, because print output is monochrome.

Type boolean

Default Value TRUE

apply_all_aliases

Specifies the persistence of aliases assigned to network objects in the
Unrecognized Traffic Assistant after traffic import. By default, node aliases are
persistent program-wide. Setting this preference to FALSE makes node aliases
persistent project-wide.

Type boolean

Default Value TRUE

auto_fire

When TRUE, specifies that analysis panels should automatically display their
traces. If this preference is set to FALSE, trace drawing must be manually
triggered by selecting the Show Statistic check box in the Edit Panel dialog box.

Type boolean

Default Value TRUE
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bgutil_errlog_incident_limit

Specifies the incident limit for the link load import error logs.

Type integer

Default Value 10

bgutil_gbu_bucket_size

Specifies the bucket size to be used for ASCII (. gbu, . gbu2) imports. This
preference can be set also from the Import Link Baseline Loads from ASCII
Flles dialog box.

Type string

Default Value “As Is”

bgutil_gbu_bucket_type

Specifies the bucket mode to be used for ASCII (. gbu, . gbu2) imports. This
preference can be set also from the Import Link Baseline Loads from ASCII
Flles dialog box.

Type string

Default Value “Average”

bgutil_gbu_file_list

Specifies a list of files to be imported as ASCII (. gbu, . gbu?2) files. This
preference can be set also from the Import Link Baseline Loads from ASCII
Flles dialog box.

Type string list

Default Value <empty>

bgutil_gbu_from_time

Specifies the start of the time window for filtering ASCII (. gbu, . gbu?2) data.
This preference can be set also from the Import Link Baseline Loads from ASCII
Flles dialog box.

Type string

Default Value “ALL VALUES”
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bgutil_gbu_overwrite

Specifies whether ASCII (. gbu, . gbu?2) imports should overwrite existing data.
When TRUE, existing data is overwritten. This preference can be set also from
the Import Link Baseline Loads from ASCII Flles dialog box.

Type boolean

Default Value TRUE

bgutil_gbu_to_time

Specifies the end of the time window for filtering ASCII (. gbu, . gbu2) data. This
preference can be set also from the Import Link Baseline Loads from ASCII
Flles dialog box.

Type string

Default Value “ALL VALUES”

bgutil_ignore_alias_case

Specifies whether to ignore the case of alias names when importing background
utilization (link loads). When TRUE, case is ignored.

Type boolean

Default Value TRUE

comp_target_type.development_parallel_32

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

comp_target_type.development_parallel_64

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.
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The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

comp_target_type.development_sequential_32

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value TRUE

comp_target_type.development_sequential_64

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value TRUE

comp_target_type.optimized_parallel_32

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE
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comp_target_type.optimized_parallel_64

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

comp_target_type.optimized_sequential_32

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

comp_target_type.optimized_sequential_64

Specifies whether to generate this type of object file when compiling. Together
with the other comp_target_type preferences, this allows you to produce
multiple targets from a single source.

The value of this preference changes only at start-up.

Data Type boolean

Default Value FALSE

disk_cleanup.clean_automatically

Specifies whether OPNET should automatically maintain the files it creates on
disk. When TRUE, “old” files are automatically removed from disk as specified
by the other disk_cleanup preferences. This preference can be changed also
with the File > Delete Temporary Files... operation.

Data Type boolean

Default Value TRUE
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disk_cleanup.clean_duplicate_scenarios

Specifies whether OPNET should automatically maintain the number of
automation-generated scenarios in a project. When TRUE, duplicate scenarios
older than specified by disk_cleanup.clean_duplicate_scenarios_days are
automatically removed from disk when disk cleanup is executed. This
preference can be changed also with the File > Delete Temporary Files...
operation.

Data Type boolean

Default Value TRUE

disk_cleanup.clean_duplicate_scenarios_days

Specifies the number of days that automation-generated scenarios will be kept
before being automatically removed from disk. This preference is used only
when disk_cleanup.clean_duplicate_scenarios is TRUE. Its value can be
changed also with the File > Delete Temporary Files... operation.

Data Type integer

Default Value 30

disk_cleanup.clean_error_log

Specifies whether OPNET should automatically maintain the size of the error
log. When TRUE, error log entries older than specified by
disk_cleanup.clean_error_log_days are automatically removed from disk when
disk cleanup is executed. This preference can be changed also with the File >
Delete Temporary Files... operation.

Data Type boolean

Default Value TRUE

disk_cleanup.clean_error_log_days

Specifies the number of days that error log entries will be kept before being
automatically removed from the log. This preference is used only when
disk_cleanup.clean_error_log is TRUE. Its value can be changed also with the
File > Delete Temporary Files... operation.

Data Type integer

Default Value 30
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disk_cleanup.clean_session_log

Specifies whether OPNET should automatically maintain the size of the session
log. When TRUE, session log entries older than specified by
disk_cleanup.clean_session_log_days are automatically removed from disk
when disk cleanup is executed. This preference can be changed also with the
File > Delete Temporary Files... operation.

Data Type boolean

Default Value TRUE

disk_cleanup.clean_session_log_days

Specifies the number of days that session log entries will be kept before being
automatically removed from the log. This preference is used only when
disk_cleanup.clean_session_log is TRUE. Its value can be changed also with
the File > Delete Temporary Files... operation.

Data Type integer

Default Value 30

disk_cleanup.clean_temporary_files

Specifies whether OPNET should automatically maintain the temporary files in
<HOVE>\ op_adni n\ t np. When TRUE, temporary files older than specified by
disk_cleanup.clean_temporary_files_days are automatically removed from
disk. This preference can be changed also with the File >

Delete Temporary Files... operation.

Data Type boolean

Default Value TRUE

disk_cleanup.clean_temporary_files_days

Specifies the number of days that temporary files will be kept before being
automatically removed from disk. This preference is used only when
disk_cleanup.clean_temporary_files is TRUE. Its value can be changed also
with the File > Delete Temporary Files... operation.

Data Type integer

Default Value 7
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edit_attr_undo_warning_prompt

If TRUE, specifies that OPNET should display a warning dialog for non-
undoable attribute-edit operations.

Type

boolean

Default Value

TRUE

ets_options

Specifies a list of unlicensed ETS-based product options.

The value of this preference changes only at start-up.

Type

string list

Default Value

<empty>

event_speed_parameter

This preference provides an advanced event management system that can be
tuned to maintain peak performance when simulating very large systems.
Larger values will result in faster simulations. The trade-off is that higher values

of event_speed_parameter require additional memory.

Optimal values depend on the type and size of models. You may want to
experiment with different values and compare the simulation's performance. In

general, increasing this parameter will not yield significant performance gains
for small, lightly-loaded systems.

Type

integer

Default Value

100,000

file_abort_read_suppress

Prevents a program abort when itguru reads a corrupted node model.

Type

boolean

Default Value

FALSE
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flow_import_errlog_incident_limit

Specifies the maximum number of log messages recorded during flow imports
for a particular category, class, and subclass.

Type integer

Default Value 100

hpov_default_server

Specifies the default HP OpenView network topology server to be used for
imports.

Type string

wn

Default Value

import_default_interface_type

Specifies the default interface type assigned during a topology import if a port
or link’s interface type is not specified or cannot be identified. The interface
type’s protocol and (optionally) speed can be specified by this preference (for
example, ethernet:10BaseT is a valid default interface type).

Type string
Default Value empty
Constraints Must be a valid protocol type and speed, if appropriate

import_default_machine_type

Specifies the default machine type assigned during a topology import if an
object’s machine type is not specified or cannot be identified (for example,
switch is a valid default machine type).

Type string
Default Value empty
Constraints Must be a valid machine type
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import_mem_stats_log

Specifies whether OPNET logs memory usage statistics during topology import
operations. When FALSE, memory statistics are not logged.

Type boolean

Default Value FALSE

ip_address_change_notify_limit

Specifies the maximum number of change messages displayed when auto-
assigning or clearing IP addresses.

Type integer

Default Value 0

javascript_enable

Specifies whether OPNET can use Javascript in the creation of results web
reports. When TRUE, Javascript can be used.

Type boolean

Default Value TRUE

ma_errlog_incident_limit

Specifies the maximum number of incidents to be reported in a model assistant

error log.
Type integer
Default Value 10
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manage_licenses

Specifies that itguru start with the License Manager running. In this mode, itguru
does not use a license, opens the License Manager automatically, and allows
only limited functionality. This mode is useful when you are doing license
management functions only. You must use this mode if you are deleting all
licenses, because the License Manager will not allow you to delete a license that
is in use.

Type boolean

Default Value FALSE

model_assistant_adjust_view_after_apply

Specifies whether autozoom is applied to the workspace display following
application of a model assistant file. When TRUE, the display is automatically
zoomed to the affected objects.

The value of this preference changes only at start-up.

Type boolean

Default Value FALSE

model_assistant_configuration_file

Specifies a configuration file for the model assistant.

The value of this preference changes only at start-up.

Type string

Default Value

net_report_link_detail_attrs

Specifies which link model preferences should be included in the link details
section of the network summary report. If this preference and
net_report_link_tooltip_alias are set to the default values, the link details section
lists the name and link type of each link, organized by subnet. When modifying
this preference, enter model attribute names exactly as shown in the Attributes
dialog box.

Type string list

Default Value tooltip
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net_report_link_summary_attrs

Specifies which link model attributes should be included in the link summary
section of the network summary report. If this preference and
net_report_link_tooltip_alias are set to the default values, the link summary
section lists the total number of links and the number (count) by link type. When
modifying this preference, enter model attribute names exactly as shown in the
Attributes dialog box.

Type string list

Default Value tooltip

net_report_link_tooltip_alias

Specifies the tooltip preference used in link sections of the network summary
report. This is different from the Ul tooltip (the explanatory text in a yellow box
that appears when you place the cursor over buttons).

Type string list

Default Value Link Type

net_report_node_detail_attrs

Specifies which node model attributes should be included in the node details
section of the network summary report. If this preference and
net_report_node_tooltip_alias are set to the default values, the node details
section lists the name and device type of each node, organized by subnet.
When modifying this preference, enter model attribute names exactly as shown
in the Attributes dialog box.

Type string list

Default Value tooltip

net_report_node_summary_attrs

Specifies which node model attributes should be included in the node summary
section of the network summary report. If this preference and
net_report_node_tooltip_alias are set to the default values, the node summary
section lists the total number of nodes and the number (count) by device type.
When modifying this preference, enter model attribute names exactly as shown
in the Attributes dialog box.

Type string list

Default Value tooltip
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net_report_node_tooltip_alias

Specifies the tooltip preference used in node sections of the network summary
report. This is different from the Ul tooltip (the explanatory text in a yellow box
that appears when you place the cursor over buttons).

Type string list

Default Value Device Type

network_diff.default_live_spec

Specifies the default specification file for Live Network Difference behavior.

Type string

Default Value “op_live_diff”

network_diff.default_report_spec

Specifies the default specification file for Network Difference reports.

Type string

Default Value “op_network_diff”

network_diff.output_dir

Specifies the directory to which Network Difference report files will be written.

Type string

Default Value

network_diff.suppress_live_legend

Specifies whether OPNET should suppress the legend that appears in the lower
left-hand corner of the workspace while Live Network Differences is active. This
legend describes the active tracking mode and the meaning of each of the icons
used to mark the various network objects. When FALSE, the legend is shown.
When TRUE, the legend is suppressed.

Type boolean

Default Value FALSE
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network_palette

Specifies a custom model list or set of keywords to be used initially with the
object palette in the Project Editor. If this list is empty, no keywords or model list
are set when IT Guru starts and the object palette displays icons for all models
in your model directories. Specifying this preference can save time when you
open the object palette, because the palette displays fewer models through
which to search.

The value of this preference must be one of the following:

* One or more valid keywords. Multiple keywords must be separated by
spaces.

» The reserved word custom_model_list followed by a space and the name of
an existing custom model list.

You can specify keywords or a custom model list with this preference, but not
both at once.

Type string list

Default Value

Constraints see description

network_palette.fixed_subnet_icon

Specifies the icon used for fixed subnet objects in the object palette. You can
specify an icon from any database listed in the “icon_dbs” line in your

itguru. et s file. If this preference is an empty string, the fixed subnet object will
not appear in the object palette.

Type string
Default Value “subnet”
Constraints see description

network_palette.group_aggregation

Specifies the self-description core characteristic used to group objects in the
object palette when model aggregation is enabled.

Type string

Default Value “System Object ID”
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network_palette.keep_above

Specifies whether OPNET should prevent the object palette from being hidden
behind the editor window. When TRUE, the object palette is kept in front of the
editor window (but not other windows).

Type boolean

Default Value TRUE

network_palette.mobile_subnet_icon

Specifies the icon used for mobile subnet objects in the object palette. You can
specify an icon from any database listed in the “icon_dbs” line in your

itguru. et s file. If this preference is an empty string, the mobile subnet object
will not appear in the object palette.

Type string

Default Value “subnet (mobile)”

network_palette.only_one

Specifies whether OPNET should limit a network model to only one open object
palette at a time. When FALSE, any number of object palettes can be open for
a network model. When TRUE, an attempt to open a second object palette will
bring the existing object palette window to the front and activate it.

Type boolean

Default Value FALSE

network_palette.satellite_subnet_icon

Specifies the icon used for satellite subnet objects in the object palette. You can
specify an icon from any database listed in the “icon_dbs” line in your

itguru. et s file. If this preference is an empty string, the satellite subnet object
will not appear in the object palette.

Type string

Default Value “subnet (mobile)”

IT Guru/Release 11.0 ITR-3-61



3—Program Descriptions

Reference Guide

nmx_no_dynamic

Specifies whether to allow use of DNS for HP NetMetrix traffic import. Setting
this preference to TRUE forces NetMetrix to ignore DNS for resolution of
addresses found in the archives being read.

Otherwise, if NetMetrix was installed to use DNS, importing archives can be
very lengthy, as every Internet address found in the archive will be checked to
find the corresponding host name. If the address is bogus or the corresponding
site cannot be found, the search ends after a lengthy time-out, giving the
impression that the import is going nowhere.

Type

boolean

Default Value

TRUE

nt_model_post_conversion_library

Specifies a library containing a post-conversion pre-processor function used to
perform any additional cleanup work after automatic model conversion.

Type

string

Default Value

wn

nt_model_post_conversion_proc

Specifies a post-conversion pre-processor function used to perform any
additional cleanup work after automatic model conversion.

Type

string

Default Value

wn

nt_model_pre_conversion_library

Specifies a library containing a pre-conversion pre-processor function used to
perform any setup work for automatic model conversion.

Type

string

Default Value
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nt_model_pre_conversion_proc

Specifies a pre-conversion pre-processor function used to perform any setup
work for automatic model conversion.

Type

string

Default Value

num_collect_values

parallel_sim.num_processors

product

Specifies the default maximum number of values to collect for each statistic
during a simulation. This value can be changed for a given scenario in the
Configure/Run DES dialog box.

Type

integer

Default Value

100

Specifies the number of processors to be used by the Simulation Kernel. This
preference applies only to the parallel kernels. If this preference is set to 0 or

Maximum, the simulation will try to determine the number of CPUs available and
use them all. This value can be changed for a given scenario in the Configure/

Run DES dialog box.

WARNING—Requesting simulations to use more CPUs than are physically
present and available will degrade simulation performance dramatically.

Type

integer

Default Value

1

Specifies an OPNET product, which determines the feature set of the opnet
program. The possible product types are

OPNET Development Kit (“odktools™)

Modeler (“modeler”)
SP Guru (“spguru”)

IT Guru (“itguru”)

SP Sentinel (“spsentinel”)

IT Sentinel (“itsentinel”)
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» CAPEX (“capex”)
* Netbiz (“netbiz”)

« WDM Guru (“wdmguru™)

The value of this preference changes only at start-up.

Type enum

Default Value itguru

product_options

Specifies a list of modules that add additional functionality to IT Guru.

Type string

Default Value

Constraints must be a valid product option

repositories

Specifies the set of code repositories to load for simulation.

Type string list

wn

Default Value

show_import_help

Specifies whether OPNET should display an import help dialog when failing to
connect to a server. When TRUE, the help dialog is displayed.

Type boolean

Default Value TRUE
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show_map_edit_mode_help_msg

Specifies whether OPNET should display a help message when entering map
edit mode in the Project Editor. When TRUE, the help message is displayed.

Type boolean

Default Value TRUE

spreadsheet_prog

Specifies the path name of the spreadsheet program that launches when data
or a report summary is exported. The value can be simply the program name if
the program is in a directory specified by the path variable.

If no value is specified, the export operation still takes place, but the
spreadsheet program does not launch. The data is exported to a text file stored
in the op_admin/tmp directory.

The value of this preference changes only at start-up.

Type string

Default Value

static_bk_util.archive_dir

Specifies a list of directories in which background utilization (link load) data files
are stored. IT Guru looks in this directory when you import data from a
NetworkHealth (.dci) data file, an MRTG configuration (.cfg) file, or a General
Background Utilization (.gbu) file.

Type string

Default Value

top_n_results_min_significant_digits

Specifies the minimum number of significant digits in a Find Top Results report.

Type integer

Default Value 0
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traffic_archive_dir

Specifies the path to a directory in which HP NetMetrix archive files can be
found.

Type string

Default Value

traffic_default_interval

Specifies the interval (in seconds) used to subdivide imported traffic when
intervals are not otherwise known.

Type double
Default Value 30
Units seconds

traffic_import_suppress_unrecognized_sources_dialog

Specifies whether OPNET displays the unrecognized sources dialog box after
a traffic flow import. When FALSE, the dialog box is displayed; when TRUE, it

is suppressed.

Type boolean

Default Value FALSE

traffic_preprocessor_prog

Specifies a list of external preprocessing scripts used to convert ASCII traffic
files to Flexible CSV (.tr2) format. These scripts appear in the Import Traffic
dialog box’s Traffic Preprocessor menu.

Note—You must include the full path name for any scripts located outside your
user path.

Type string list

Default Value
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traffic_servers

Specifies a list of available servers (that is, hostnames) on which op_servd and
op_rtid are installed. Through these programs, OPNET can access the traffic
files on remote machines (as specified by traf fi ¢c_ar chi ve_di r in the
op_rtid.ef environment file on the remote machine).

Type string

Default Value

undo_stack_size

Specifies the maximum number of undoable operations.

Type integer

Default Value 10

use_metric

Specifies whether the Startup Wizard should use metric units as a default.

Type boolean

Default Value TRUE

use_network_editor_warning

Specifies whether OPNET should display migration information when starting
the Network Editor.

Type boolean

Default Value TRUE

use_scenario_prompt

Specifies that IT Guru should prompt for a scenario name when creating a new

project.
Type boolean
Default Value TRUE
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use_startup_wizard

Specifies that the Startup Wizard will launch automatically each time a new
scenario is created.

You can also control the Startup Wizard via the Run Startup Wizard item in the
Tools menu and the “Use Startup Wizard for each new scenario” check box in
the initial Startup Wizard dialog box. These methods supersede this preference:
unchecking the check box will prevent the Startup Wizard from launching even
if this preference is set to TRUE, and selecting the menu item will launch the
Startup Wizard even if this preference is set to FALSE.

Type boolean

Default Value TRUE

value_notch_filter_tolerance

Specifies the range used by the value_notch filter to generate an output statistic.
Given an input statistic T, and an ordinate value x, the value_notch filter
eliminates T if it is approximately equal to x. “Approximately equal” is defined
as being greater than x — value_notch_filter_tolerance and less than x +
value_notch_filter_tolerance. Otherwise the value_notch filter simply sends TO
to the output statisticTout.

Type boolean

Default Value TRUE

word_processing_prog

Specifies the path name of the word processing program that launches when a
text report is generated. The value can be simply the program name if the
program is in a directory specified by the path variable.

If no value is specified, the report is still generated, but the word processing
program does not launch. The report is stored in the op_adm n/ t np directory.

The value of this preference changes only at start-up.

Type string

Default Value
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4 |con Database Editor

The icons you see in the itguru interface are organized into icon database files,
with the suffix .icons. Many icon databases are included as part of itguru; you
can also create your own icon databases.

You can modify icon databases; you can also modify icons. Use the Icon
Database Editor to modify the icon database. Use the Image Editor to modify
individual icons. You cannot create one icon file, but you can create an icon
database file that contains one icon.

Note—You cannot save an individual icon while in the Image Editor. To write
the data related to an individual icon to disk, close the Image Editor and choose
the Save operation in the Icon Database Editor to save the entire database.

The icon databases included with itguru are stored in several locations. For
example, the database Cisco.icons (which has icons that represent Cisco
products) is in <r el di r >/ nodel s/ vendor _nodel s/ Ci sco_Syst ens.
Other icon databases are in the appropriate model directory or in the sys
directory. When you create an icon database, itis stored in your default directory
(the first directory listed in your mod_dirs preference, typically op_models).

The table below lists common tasks related to icon databases and icons, with
cross-references to other parts of this manual.

Table 4-1 Common lcon Tasks

Task Reference
Create a new icon database Icon Database Editor Menus on page ITR-4-2
Cut, copy, paste, or delete an icon Icon Database Editor Menus on page ITR-4-2

in an icon database

Create a new icon Icon Database Editor Menus on page ITR-4-2

Edit an existing icon Image Editor on page ITR-4-3

End of Table 4-1

IT Guru/Release 11.0

ITR-4-1



4—I|con Database Editor

Reference Guide

Icon Database Editor Menus

The Icon Database Editor provides operations for managing icons. You access
these operations from the menu bar, which contains the following menus:

File—contains operations that relate to high-level functions such as opening,
closing, and saving icon databases. These operations are summarized in
section the User Interface chapter of the IT Guru User Guide.

Edit—contains operations that allow you to cut, copy, or paste individual
icons in the icon database. The Edit menu also includes two operations that
are specific to the Icon Database Editor:

— New Icon adds a new icon of the default design to the database. You can
then edit and rename this template icon in the Image Editor.

— Delete Icon deletes the icon from the database.

Windows—lists all open editor windows and allows you to make one active,
as described in the User Interface chapter of the IT Guru User Guide.

Help—provides access to context-sensitive help, product documentation and
tutorial, the License Manager, and other options, as summarized in the User
Interface chapter of the IT Guru User Guide.

Right-clicking on an icon in the database brings up the Icon pop-up menu, which
provides access to the following operations:

Table 4-2 Icon Pop-Up Menu Operations

Menu item Description

Edit Opens the Image Editor with the selected icon

Set Name Allows you to enter or edit the name of the icon

Delete Deletes the icon

Cut Removes the icon from the workspaces and places it on

the clipboard

Copy Places a copy of the icon on the clipboard

End of Table 4-2

Right-clicking on the workspace brings up the Workspace pop-up menu, which
provides access to the New Icon or Paste operations.

ITR-4-2
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Image Editor

With the Image Editor, you can import, edit, and export icons. You access these
operations from the menu bar, which contains the following menus:

» File—contains operations that relate to high-level functions such as closing,
importing, exporting, and saving icons. These operations are summarized in
section File Menu on page ITR-4-6.

» Edit—contains operations that allow you to edit the appearance of an icon in
the icon database, as summarized in section Edit Menu on page ITR-4-8.

* View—contains operations that allow you to change the representation of the
icon on your screen, as summarized in section View Menu on page ITR-4-9.

» Options—contains operations that allow you to change the font or colors
used and to create or delete a transparency for the icon.

The Tool Palette

The Tool Palette displays when you right-click on the icon you want to edit and
choose Edit from the pop-up menu.

Figure 4-1 Icon Editor Tool Palette

Dropper
Hand —
) m— Lasso
Selection — i "
Spray can
Fill — % pray
Text

Eraser — &

Pencil — f

Filled ellipse
Ellipse -~ Filled rectangle
Rectangle ecently used colors
— oreground/background colors

Line width palette
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The Tool Palette contains the following editing tools for creating and editing an
icon.

Table 4-3 Tool Palette Summary (Part 1 of 2)

Tool Description

Hand Repositions an oversize image. Select and drag the oversize
image with the Hand Tool to reposition the image.

Dropper Picks up the color from a pixel.

Click anywhere in the image editing pane or the Color Palette to
pick up a color. The color you pick up is displayed in the
Foreground Color Box.

To pick up a background color, press the Control key when you
click the Dropper Tool.

Selection Selects a rectangular area of an image for editing.

To select the entire image editing pane, double-click the
Selection Tool in the Tool Palette.

Lasso Selects an irregular area.

Fill Fills the enclosed area of an image with the foreground color.
Spray Can Draws the foreground color with a “spray” pattern

Eraser Replaces the color of an image with the background color.

Drag the Eraser over the area you want to erase. Press the Shift
key before erasing to constrain the Eraser Tool horizontally or
vertically.

To clear the entire editing area, click in the image editing pane,
and then double-click the Eraser Tool in the Tool Palette.

Text Places text into the image.

Click in the image editing pane with the Text Tool to open an
Image Text Window. Text entered in the Image Text Window
appears as a selection in the image.

Pencil Draws or erases one pixel at a time.

Click in the image editing pane with the Pencil Tool to draw or
erase a pixel. If the Pencil Tool is used on an image area that
contains the foreground color, the Pencil Tool draws the
background color. Otherwise, the Pencil Tool draws the
foreground color.

Drag the Pencil Tool to draw a continuous line. Use Fat Bits
mode to draw one pixel at a time.

Line Draws straight lines.

Drag the Line Tool in the image editing pane to draw a straight
line. Press the Shift key during the drag operation to constrain
the line horizontally, vertically, or to a 45-degree angle.
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Table 4-3 Tool Palette Summary (Part 2 of 2)

Tool

Description

Ellipse

Draws an ellipse.

Drag the Ellipse Tool in the image editing pane to draw an
ellipse. Press the Shift key during the drag operation to
constrain the ellipse to a circle.

Filled Ellipse

Draws a ellipse filled with the foreground color.

Drag the Filled Ellipse Tool in the image editing pane to draw a
filled ellipse. Press the Shift key during the drag operation to
constrain the ellipse to a circle.

Rectangle

Draws a rectangle.

Drag the Rectangle Tool in the image editing pane to draw a
rectangle. Press the Shift key during the drag operation to
constrain the rectangle to a square.

Filled Rectangle

Draws a rectangle filled with the foreground color.

Drag the Filled Rectangle Tool in the image editing pane to draw
a filled rectangle. Press the Shift key during the drag operation
to constrain the rectangle to a square.

Line width palette

Specifies the width of any lines drawn with the line tool or the
border of an ellipse or rectangle.

Recently used colors

Contains the 16 colors most recently used in your image. When
you select a new color, it is added to the bottom of the palette
and a color is deleted from the top.

To make a color in the palette the foreground color, left-click on
it. To make it the background color, right-click on it.

Foreground/background
colors

To select a new foreground or background color, click and hold
the color box. When the Color Palette displays, drag the pointer
to a new color.

End of Table 4-3
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File Menu

The File menu contains operations that relate to high-level functions.

Table 4-4 File Menu Summary

Menu item

Description

Reference

Close

Closes the Image Editor and places a
copy of the edited icon in memory. When
the icon database is saved (written to
disk), the edited icon will be saved.

Import

Imports an image.

Importing an Image on
page ITR-4-6

Export

Exports the image.

Exporting an Image on
page ITR-4-7

Set Size

Sets the size of the image, in pixels. The
size of the image editing pane does not
change automatically when you change
the size of the image. Use the zoom
options to change the pane size so you will
see the entire image in the pane.

Revert

Returns the image to the one shown when
the Image Editor was opened (the version
in the Icon Editor's memory).

End of Table 4-4

Importing an Image

To import an image, follow these steps.

Procedure 4-1

Importing an Image

1 From the File Menu, choose Import...

0 The Open dialog box displays.

2 Use the Filters option in the file chooser to specify an image format.

3 Select the file you want to import.

0 The imported image is displayed in the Image Editor.

End of Procedure 4-1

ITR-4-6
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Exporting an Image

To export an image, follow these steps.

Procedure 4-2 Exporting an Image

1 From the File Menu, choose Export...

O The Save As dialog box displays.
2 Specify the exported image format by selecting it from the Filters menu item.

3 Enter the exported file’s name. You may want to include the format as part of the
file name.

O The file is saved with a suffix that indicates the image format.

End of Procedure 4-2
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Edit Menu

The Edit menu contains operations that allow you to change the appearance of

an icon.

Table 4-5 Edit Menu Summary

Menu item Description Reference

Undo Undoes the last editing operation. —

Redo Redoes the last undo. —

Cut Cuts the selected pixels, placing them in —
the clipboard.

Copy Copies the selected pixels to the clipboard. —

Paste Pastes the pixels stored in the clipboard. —

Clear Deletes the selected pixels without storing —
them in the clipboard.

Rotate Rotates the selected pixels one-quarter —

turn counter-clockwise.

Flip Horizontal

Flips the selected pixels around a vertical
axis.

Flip Vertical

Flips the selected pixels around a
horizontal axis.

Mask Selection

Masks the selected area, as described in
the Create Transparency discussion. See
Creating a Transparency on page ITR-4-
13.

Crop to Selection

Crops to the selected area. Pixels outside
the selection are discarded.

End of Table 4-5

ITR-4-8
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View Menu

The View menu contains operations that allow you to change the way the icon
is displayed in the Image Editor.

Table 4-6 View Menu Summary (Part 1 of 2)

Menu item

Description

Reference

Fat Bits

Magnifies the image so each pixel can be
viewed. When Fat Bits is disabled, the
image returns to its actual size. (The
default magnification is five times the size
of the image.)

Draw From Center

Defines the starting point for certain
drawing tools. Normally, the line, ellipse,
and rectangle tools begin drawing an item
from the end (or perimeter) of the item.
Draw From Center specifies that drawing
begins at the center of the item.

Show Grid

Displays the image in a grid. Individual
pixels are outlined with the grid pattern.
When the bit size displayed is smaller than
three pixels, the grid is not shown.

Show Position

Displays the coordinates of an image. The
origin of the image is the lower left corner.

X: The position of the item on the X axis
Y: The position of the item on the Y axis

DX: The change in X as you draw or move
an item

DY: The change in Y as you draw or move
an item

Len: The distance between the starting
point of the operation and the current
position

Ang: The arc, in degrees, described from
the starting point as you draw or move an
item

IT Guru/Release 11.0
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Table 4-6 View Menu Summary (Part 2 of 2)

Menu item Description Reference
Preview Displays the entire image in a separate —
Preview Window. If you use the Hand Tool
to pan through an oversize image, the
visible area of the image is outlined in the
Preview Window.
Zoom In Magnifies the image. Select repeatedly to —
continually increase the magnification.
Zoom Out Decreases the magnification of the image. —
Select repeatedly to continually decrease
the magnification.
End of Table 4-6

ITR-4-10

IT Guru/Release 11.0



Reference Guide

4—I|con Database Editor

Options Menu

The Options menu contains operations that allow you to change the font or
colors used and to create or delete a transparency for the icon.

Table 4-7 Options Menu Summary

Menu item

Description

Reference

Choose Font

Allows you to choose the font desired

Edit colors

Allows you to select, edit, and install a
pre-defined palette, or to create and
save a custom palette.

Color Palette Editor on
page ITR-4-11

Create Transparency

Creates a pane where you define the
transparency to be used with the icon.

Transparencies and
Masks on page ITR-4-
13

Delete Transparency

Deletes an existing transparency.

End of Table 4-7

Color Palette Editor

Use the Color Palette Editor to

« Edit individual colors in the Color Palette

» Save edited color palettes

 Install different color palettes

Procedure 4-3 describes how to select and edit colors in a palette.

Procedure 4-3 Editing Colors in a Palette

1 Selectthe color or series of colors by clicking on the color in the palette or dragging
the cursor over a series of colors.

O An outline appears around the selected colors.

2 Click on an editing button to start or complete an operation using the color(s) you
selected (see Table 4-8 on page ITR-4-12).

End of Procedure 4-3
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Table 4-8 lists the operations you can do with the editing buttons in the Color Palette.

Table 4-8 Editing Buttons

Button

Description

New

Creates a new color. You can then use the other buttons to edit the color.

Delete

Deletes the selected color.

Pick...

Brings up the Color Chooser. See the “Color Chooser” section in the User
Interface chapter of the IT Guru User Guide.

Ramp

Creates a spectrum of shades (very light to very dark) of one color. This can
be useful if you want to give subtle shading to a figure. See Creating and
Installing a Shade Spectrum on page ITR-4-12 for instructions.

Blend

Creates a color that is a blend of two others. To create the blended color,
select three contiguous colors, then click on the Blend button. The middle
color becomes a blend of the two flanking colors.

Contrast

Changes the selected color to be its opposite on the color wheel. Red, for
example, becomes green.

Lighter

Adds white to the selected color.

Darker

Adds black to the selected color.

Warmer

Adds a warm shade (red, orange, or yellow) to the selected color.

Cooler

Adds a cool shade (blue, purple, green) to the selected color.

Remap To
Closest Color

Controls how the colors in an image are mapped when a new color palette
is installed.

If Remap To Closest Color is checked, the colors of the image are mapped
to the closest colors in the newly-installed palette. This default behavior
minimizes changes to an image when installing a new palette.

If Remap to Closest Color is not checked, colors are mapped according to
their position on the palette. For example, if the color in the top-left cell of

the old palette is black, and the color in the same position in the new palette
is green, all black pixels in the image become green.

End of Table 4-8

Procedure 4-4 describes how to create a shade spectrum and install it as color palette.

Procedure 4-4 Creating and Installing a Shade Spectrum

1 Determine the number of different shades you want use (five in this example) and
the color of the spectrum (orange in this example).

2 Dragging from left to right, select seven color cells, making sure that the left-most
cell is orange.

ITR-4-12
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3 Click on the Ramp button.

O The seven cells are recolored. The left-most cell is white. The right-most cell is
black. The five cells in between range from light orange to dark orange.

4 Click on the Install button.

O The color palette is installed. The Color Palette Editor closes and the image in
the Image Editor changes to reflect the newly installed color palette.

End of Procedure 4-4

Transparencies and Masks

To understand the role of transparencies, consider the following:
* Anicon displays against the background of the object palette or editor.

* The icon itself is composed of the figure you designed, overlaid on a black
rectangle.

The transparency is a black and white copy of your icon that sits in a separate
layer underneath the icon. It controls what parts of the background are visible

and which are hidden. White areas of the transparency allow the background to
display. Black areas prevent the background from displaying, making your icon
the visible layer.

One common use of a transparency is to mask the icon’s black rectangle, as
shown below.

Figure 4-2 Using a Transparency To Hide the Black Background

No transparency. Black rectangle of icon displays.

big_blue_car

E With transparency. Black rectangle is hidden, gray background
displays.

big_blue_car

The Mask Selection operation on the Edit menu helps you create an effective
transparency.

Procedure 4-5 Creating a Transparency

1 Open the icon in the Image Editor.

O The image displays in one pane of the Image Editor.

2 Choose Create Transparency from the Options menu.

O A second pane (the transparency pane) appears to the right of the first pane.
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3 Use the selection tool to demarcate the area you want to mask.

4 Choose Mask Selection from the Edit menu.
O A mask of the selection appears in the transparency pane.

5 Choose Close from the File menu.

O The Image Editor closes and the newly-masked icon appears in the Icon
Database Editor.

6 Choose Save from the File menu of the Icon Database Editor to save the changed
icon.

End of Procedure 4-5
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5 Distributions

Distributions are used to generate a series of stochastic numeric values. There
are two types of distributions:

» Predefined distributions supplied with Guru
» User-defined distributions created with the PDF Editor (described in
Chapter 6 PDF Editor on page ITR-6-1)

A list of the predefined distributions appears in Table 5-1, along with their
supported arguments. For more information on the mathematical framework of
these distributions, consult the textbook Fundamentals of Applied Probability
Theory, by Dr. Alvin Drake, published in 1967 by McGraw-Hill.

Table 5-1 Predefined Distributions (Part 1 of 2)

Name First Argument Second Argument
bernoulli mean outcome <none>

binomial num_samples p_success
chi_square mean outcome <none>

constant outcome <none>

erlang scale shape
exponential mean outcome <none>

extreme location mode_scale
fast_normal mean outcome outcome variance
gamma scale shape

geometric prob_success <none>

laplace mean scale

logistic mean scale

lognormal mean outcome outcome variance
normal mean outcome outcome variance
pareto location shape

poisson mean outcome <none>

power function shape scale

IT Guru/Release 11.0
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Table 5-1 Predefined Distributions (Part 2 of 2)

Name First Argument Second Argument
rayleigh scale <none>

triangular min max

uniform minimum outcome maximum outcome
uniform_int minimum outcome maximum outcome
Weibull shape parameter scale parameter
End of Table 5-1

Figure 5-1 Bernoulli PMF Definition

(1-P)
Py(Xo) = P

0
0<P<l1
mean: E(x) = P

variance: 62 = P(1 —P)

Figure 5-2 Bernoulli PMF Shape
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Figure 5-3 Binomial PMF Definition

f(x) = (D pan—x 0 <x<n (xaninteger)

mean: E(Xx) = n

( ) p Arg 1: num_samples = n (positive integer)
. Arg 2: p_success =pwhere0<p<1
variance: o

>N

= npq

q=1-p

Figure 5-4 Binomial PMF Shape
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Figure 5-5 Chi-Square PDF Definition

f(%o) = 2
0
n=123, ...
mean: E(x) = n

variance: 62 = 2n

Figure 5-6 Chi-Square PDF Shape

ﬂ[hi Square

|:(I_1 _ 1)!:|_12—n/2x n/2)— le_Xo/2 Xg > 0

otherwise

Arg 1: mean_outcome =n

Arg 2: <none>
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Figure 5-7 Constant PMF Definition

_ 1 x0=C
Px(%0) = 0 otherwise

mean: E(x) = C Arg 1: outcome =C
Arg 2: <none>

variance: 2 = 0

Figure 5-8 Constant PMF Shape

—#]{Constant PMF
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Figure 5-9 Erlang PDF Definition

X
C'(Q)C_le_g /(b(e =1 >0
fu(Xo0) = b %o
0 otherwise
b>0 c=12,3,...
mean: E(x) = bc
Arg 1: scale = Db
variance: 62 = ¢(b’) Arg 2: shape = ¢

Figure 5-10 Erlang PDF Shape
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Figure 5-11 Exponential PDF Definition

—ax,

fu(Xo) =

a>0
mean: E(x) = a™!

variance: 62 = a=2

Figure 5-12 Exponential PDF Shape

ﬂExponential \

x>0

otherwise

Arg 1: mean_outcome=1/a
Arg 2: <none>
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Figure 5-13 Extreme Value (Gumbel) PDF Definition

f(x) = (1/b)exp[«(x—a)/b] x exp{—exp[—(x—a)/b]} —w<x<w®

Arg 1: location = a
Arg 2:scale=b>0

mean: E(x) = a—bF'(l)

. 202
variance: 62 = b’ II°/6

r'(1) = —0.57721 I'(1) is the first derivative of the gamma function with
respecttonatn=1

Figure 5-14 Extreme Value (Gumbel) PDF Shape

ﬂExtreme ¥alue PDF
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Figure 5-15 Gamma PDF Definition

f(x) = (x/b)° " [exp(=x/b)]/bI(c) 0<x<ow

I'(c) isthe gamma function with argument c

mean: E(x) = bc

Arg1:scale=b>0
Arg 2: shape=c>0

. 2
variance: 62 = b’c

Figure 5-16 Gamma PDF Shape

+|Gamma
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Figure 5-17 Geometric PMF Definition

f(x) = pq"

mean: E(x) = q/p

. 2
. 2 —
variance: 62 = q/p

x 20 (xaninteger)

q=1-p

Arg 1: prob_success=0<p<1
Arg 2: (ignored)

Figure 5-18 Geometric PMF Shape
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Figure 5-19 Laplace (Double Exponential) PDF Definition

f(x) = —Lexp(—b(_a

) —00 <X <0
2b b

mean: E(x) = a

Arg 1: mean = a (all real)

2 a2
variance: ¢ = 2b Arg 2: scale =b > 0

Figure 5-20 Laplace (Double Exponential) PDF Shape

ﬂLaplace PDF
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Figure 5-21 Logistic PDF Definition

exp[(x—a)/b]
b{1+exp[(x—a)/b]}>

f(x) =

—0 <X <

mean: E(x) = a

Arg 1: mean=a
variance: ©2 = b2 /3 Arg 2: scale=b >0

Figure 5-22 Logistic PDF Shape

~#]Logistic PDF
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Figure 5-23 Lognormal PDF Definition

2
. %expjln%& >0
(%) = XAN2mo 20
0

otherwise

2
Arg 1: mean = " *° /2
2 2
Arg 2: outcome_variance = (e>* "7 )% - 1)
Figure 5-24 Lognormal PDF Shape
ﬂLognormal
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Figure 5-25 Normal and Fast Normal PDF Definition
o ([Xo—E(®)]?/(207))

f.(xy) = o

—0 < E(x) <0

Arg 1: mean_outcome = E(X)
Arg 2: outcome_variance = o’

c,>0

Note—fast_normal and normal model the same distribution. The normal distribution is calculated using
the Box-Muller Transform method. It provides greater resolution than fast_normal, but may result in
slower simulations. The fast_normal distribution is table-based, with results truncated beyond 10
standard deviations. It is provided for speed and backward compatibility with releases prior to 6.0, in

which it was the normal distribution.

Figure 5-26 Normal and Fast Normal PDF Shape
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Figure 5-27 Pareto PDF Definition

+ 1
f(x) = ca®/x" asx<®

mean: E(x) = ca/(c—1) C>1

Arg 1: location=a >0
variance: 62 = ca’/[(c=1)’(c=2)] C>2 Arg 2: shape = ¢ >0

Figure 5-28 Pareto PDF Shape
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Figure 5-29 Poisson PMF Definition

a>0
mean: E(x) = a

variance: ©2 = a

Figure 5-30 Poisson PMF Shape

ﬂPoisson PMF

*0

=012,...

Arg 1: mean_outcome = a

Arg 2: <none>
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Figure 5-31 Power Function PDF Definition

Cox®T! 0<x<b
flx) = & <x<

bC

mean: E(x) = be/(c+1) Arg 1: shape = ¢

variance: 62 = b’c/[(c +2)(c +1)’] Arg 2: scale =b >0

Figure 5-32 Power Function PDF Shape

ﬂPowerfunction
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Figure 5-33 Rayleigh PDF Definition

f(x) = (x/b2)exp[=x>/(2b)]

1
mean: E(x) = b(TE/2)2

variance: o2 = (2—71:/2)b2

Figure 5-34 Rayleigh PDF Shape

0<x<w

Arg1:scale=b>0
Arg 2: <none>
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Figure 5-35 Triangular (Symmetrical) PDF Definition

(4!x—a!
2

fx) = 1 7
4(b—-x)
(b-a)’

mean: E(x) = (a+b)/2

2
. a—b
variance: 62 = L—2—4—)—

a+b
< x < —
asXxX=s 2
a—Jzil’sXsb

Arg 1: location lower limit =a
Arg 2: location upper limit = b

Figure 5-36 Triangular (Symmetrical) PDF Shape

ﬂTriangular
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Figure 5-37 Uniform PDF Definition

1/(b—a) a<x,<b
fu(Xo) = 0
0 otherwise

—on<a<b<o

mean: E(x) = (a+b)/2

Arg 1: min_outcome = a
Arg 2: max_outcome = b

variance: ¢2 = (b—a)2/12

Figure 5-38 Uniform PDF Shape

ﬂUniﬁer PDF
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Figure 5-39 Uniform Integer PMF Definition

x, = 0,x1,£2
P (xg) = 1/(1+b—a) 0~ BT
< <
a_xo_b
a=0,z=%I,£2,
b = 0,+£1,+2, a<b
mean: E(x) = (a+b)/2
1 Arg 1: min_outcome = a
variance: ¢2 = E[(b—a)(Z +b—a)] Arg 2: max_outcome = b

Figure 5-40 Uniform Integer PMF Shape

ﬂUniform Integer PMF
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Figure 5-41 Weibull CDF Definition

1 _e—(ﬁ)“ if(x > 0)
f(x) =
0 otherwise
where o >0
Arg 1: shape = a
and B>0 Arg 2: scale = B

Figure 5-42 Weibull CDF Shape

ITR-5-22
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6 PDF Editor

Note—This editor is available only when the Multi-Vendor Import (MVI) module
is active.

In this editor, you create, edit, and view probability density functions (PDFs). A
probability density function defines the probability weighting for every possible
outcome over a range of possible outcomes. PDFs are used as values for
various attributes to model a wide variety of probabilistic events and variations
within a network. For example, a PDF might model the likelihoods associated
with packet interarrival times or the probability of transmission errors.

To represent a PDF, OPNET uses a PDF table (a list of discrete
outcome-property pairs that approximates the continuous PDF). In the editor,
you manipulate this table via a graphical display of the points in it.

Figure 6-1 PDF Graph
iﬁ-]PDF Editor: unnamed ;lglil

File Edit PDF ‘Windows Help

Probability Density [outcome]

0.875

0.750 /—\\
0.625 \
0.500

3
\
0.375 ‘\\
e
0.250 ——
0125
0.000 I I I I I
0 1 2 3 4 5
outcome
|
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Menus
The PDF Editor provides many operations for creating and working with network
models. You access these operations from the PDF Editor menu bar, which
contains the following menus:
Table 6-1 PDF Editor Menus
Menu Description Reference
File Contains operations that relate to high-level File Menu Operations on
functions such as opening and closing page ITU-4-26
projects, saving scenarios, importing models,
and printing graphics and reports.
Edit Contains operations that allow you to edit the Edit Menu Operations on
preferences that control program operation page ITU-4-29
and to manipulate text and objects
PDF Contains operations that modify how a PDF PDF Menu on page ITR-6-3
curve is displayed
Windows Lists all open editor windows and allows you Windows Menu on
to make one active page ITU-4-36
Help Provides access to context-sensitive help, the  Help Menu Operations on
product documentation and tutorials, and page ITU-4-37
information about the program
End of Table 6-1
Note—The editor menus on your machine may vary from those described here,
particularly if there has been any Ul customization or use of ETS.
There are also several operations available within the PDF Editor that do not
appear on a menu. These operations are used to create and edit a PDF, as
described in Edit PDF Table on page ITR-6-8.
The following tables list the items in the PDF Editor menus and give a reference
to where you can get more information about each operation. The standard File,
Edit, Windows, and Help menus are described in System Menus on
page ITU-4-26.
ITR-6-2 IT Guru/Release 11.0



Reference Guide

6—PDF Editor

PDF Menu

Table 6-2 PDF Menu Summary

The PDF menu includes operations that modify how a PDF curve is displayed.

Menu item Description Reference

Smooth Rounds out the sharp edges and spikes in a graph. Smooth on page ITR-6-8

Normalize Scales a graph either down or up so that the total probability =~ Normalize on page ITR-6-6
for all outcomes is unity (1).

Add Impulse Adds an impulse to a PDF. Add Impulse on page ITR-6-5

Set Sampling Resolution

Determines how many discrete elements are used to
approximate a continuous function.

Set Sampling Resolution on
page ITR-6-7

Set Abscissa Lower Bound

Modifies the lower bound for the horizontal (x) axis of the
displayed graph.

Set Abscissa and Ordinate
Bounds on page ITR-6-6

Set Abscissa Upper Bound

Modifies the upper bound for the horizontal (x) axis of the
displayed graph.

Set Abscissa and Ordinate
Bounds on page ITR-6-6

Set Ordinate Lower Bound

Modifies the lower bound for the vertical (y) axis of the
displayed graph.

Set Abscissa and Ordinate
Bounds on page ITR-6-6

Set Ordinate Upper Bound

Modifies the upper bound for the vertical (y) axis of the
displayed graph.

Set Abscissa and Ordinate
Bounds on page ITR-6-6

Model Documentation

Lets you add information about the PDF curve and its use to
the model.

End of Table 6-2

IT Guru/Release 11.0
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Toolbar Buttons

The PDF Editor has toolbar buttons for frequently-used operations.

Figure 6-2 Toolbar Buttons (PDF Editor)

Cu L EEEEE

Table 6-3 lists the name of each toolbar button—the name appears as a tooltip
when you rest the cursor on the button—and its equivalent menu command.

Table 6-3 Toolbar Buttons in the PDF Editor

Button Name in the Toolbar Equivalent Menu Command
1 Smooth the Function PDF > Smooth...
2 Normalize PDF > Normalize
3 Add an Impulse to the Function PDF > Add Impulse...
4 Set Sampling Resolution PDF > Set Sampling Resolution...
5 Set Abscissa Lower Bound PDF > Set Abscissa Lower Bound...
6 Set Abscissa Upper Bound PDF > Set Abscissa Upper Bound...
7 Set Ordinate Lower Bound PDF > Set Ordinate Lower Bound...
8 Set Ordinate Upper Bound PDF > Set Ordinate Upper Bound...
End of Table 6-3

ITR-6-4
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PDF Menu Operations

This section contains descriptions and procedures for using the operations
available from the PDF menu in the PDF Editor. The items that appear on this

menu are described below in alphabetical order.

Figure 6-3 PDF Menu

FOF  Windows Help

Smoath. ..
Maormalize
add Impulse. ..

Set Sampling Resolution, ..

Set Abscissa Lower Bound. ..
Set Abscissa Upper Bound. ..
Set Qrdinake Lower Bound. ..
Set Ordinake Lpper Bound. ..

Maodel Documentation

Add Impulse

This operation allows you to add one or more impulses to a probability
distribution function. An impulse is a fixed amount of probability mass
associated with a single outcome value. It can be thought of as a sharp, narrow
spike in the PDF that gives one particular outcome the specified probability of

occurring. More than one impulse can be added to a PDF.

Figure 6-4 PDF Before and After Adding an Impulse
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Normalize

This operation proportionally scales down or scales up a PDF so that the total
probability for all outcomes is unity (1).

Figure 6-5 PDF Before and After Normalizing

Set Abscissa and Ordinate Bounds

The Set Bounds operations modify the upper and lower bounds for the
horizontal and vertical axes of a graph.

Figure 6-6 Using the Set Bounds Operation

ITR-6-6 IT Guru/Release 11.0
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The Set Bounds operations change only the scale and visible portion of an
existing graph. The underlying data table—that is, the set of pairs of data points
with ordinate/abscissa values—remains unchanged.

Note—Increasing the abscissa range causes an proportional increase in the
PDF sample count. A drastic increase in the abscissa range (say, from 5 to
5,000) may cause OPNET to run out of memory. For this reason, a dialog box
appears to confirm your choice whenever you enter a bound that would more
than double the current abscissa range.

Set Sampling Resolution

This operation sets the sample count for a graph. The sample count determines
how many sample elements, or discrete elements, will be used to approximate
a continuous function.

In the context of a PDF, the sample count is the number of discrete outcomes
for which a probability weighting is assigned. The default sample count is 500.
Based on the user’s graphically-defined PDF, OPNET assigns probability
weightings to 500 evenly-spaced outcomes between the low and high bounds
of the horizontal axis, inclusive.

The Set Sampling Resolution operation can be used either before a function has
been created graphically or after a function has been created or read in. After
the sampling count is set, OPNET redraws the graph at the new resolution.

Figure 6-7 PDF with Different Resolutions
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Smooth

This operation rounds out the sharp edges and spikes in a graph. The
smoothing algorithm works by sliding a “window” forward along the abscissa of
the graph. A dialog box prompts you for the size (in points) of this window; the
default setting is three points.

Figure 6-8 Line Graph Before and After Smoothing
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Edit PDF Table

This operation allows you to edit a PDF table by changing the shape of the PDF
graph. Because the PDF Editor uses a graphical approach for defining a PDF,
the resulting data is, inevitably, somewhat imprecise.

Procedure 6-1 Editing a PDF Table

1 Choose File > New... or File > Open... and select PDF from the pull-down menu.

0 The PDF Editor opens.

2 Use the Edit Line Graph procedure (described in Edit Line Graph on page ITR-6-9)
to specify the line graph.

3 Modify the graph with any of the following operations (all explained in this chapter):

» Use the Set Abscissa Lower Bound, Set Abscissa Upper Bound, Set Ordinate
Lower Bound, and Set Abscissa Upper Bound operations (Set Abscissa and
Ordinate Bounds on page ITR-6-6) to set the upper and lower values for the
PDF. By default, the empty line graph first displayed is set to have a domain of
outcomes from 0 to 5 and a range of probability densities from 0 to 1.

Note—Upper and lower bounds for the ordinate—the probability density—must be
greater than or equal to zero. Also note that upper and lower bounds may be set
either before or after a PDF is defined. If the bounds are set after a PDF is defined,
OPNET does not change the PDF, but redraws the line graph to match the new

range of the ordinate and the new domain of the abscissa.

ITR-6-8
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» Use the Set Sampling Resolution operation (Set Sampling Resolution on
page ITR-6-7) to set the number of discrete points along the horizontal axis of the
curve. The sampling resolution can be set either before or after a PDF is defined.
The default PDF sample count is 500.

» Use the Add Impulse operation (Add Impulse on page ITR-6-5) to add one or
more probability impulses to the PDF.

» Use the Smooth operation (Smooth on page ITR-6-8) to round out sharp edges
in the function.

» Use the Normalize operation (Normalize on page ITR-6-6) to scale the entire
range of probabilities, so that the overall probability for all events is one (1).

End of Procedure 6-1

Edit Line Graph

The Edit Line Graph operation is used within several editors to enter new data
points on a line graph (such as an antenna pattern or a PDF curve). Graphs are
specified as a series of connected linear segments. Each segment is defined by
clicking on its end points. When a new line segment is drawn, any pre-existing
line segments spanning the same abscissa (the same range of x-coordinates)
are replaced.

Procedure 6-2 Drawing a Line Graph

1 Position the cursor so that the point of the arrow rests where the line graph should
begin, then left-click.

Piobabilty Density foutcome)

0 1 2 3 4 5
outcome

T B|

O The editor places a single data point to define the first vertex, as shown in this
enlarged view:

0125 '{:&

0.000
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2 Move the cursor so that the point of the arrow rests where the next vertex should
be, then left-click.

O The editor draws a series of data points from the previous vertex, extending up
to and including the current vertex.

1

3 For each additional vertex, move the cursor to the appropriate location and
left-click until the line graph is fully defined.

O For each vertex, the editor draws a series of data points from the previous
vertex, extending up to and including the current vertex.

End of Procedure 6-2

ITR-6-10 IT Guru/Release 11.0
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Procedure 6-3 Modifying a Line Graph

1 If the graph you want to change is not already displayed, read it using the File >
Open... operation.

O The graph appears. For example:

Probabilty Density fautcome]
1.000
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0250 — "
-
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2 To establish the first vertex in the new line segment:
2.1 Move the cursor inside the border of the graph.
2.2 Position the point of the arrow where the new line segment should begin.
2.3 Left-click the mouse.

O The editor draws a single data point at this vertex. It also erases any other data
point at the same abscissa (x-coordinate). The erased data point is shown
circled in the illustration below:

Probabilty Density fautcome]
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3 Move the cursor to the next desired vertex of the modified line graph and left-click.

O The editor draws a series of data points from the previous vertex, extending up
to and including the current vertex. It also erases any other data points at the
affected abscissas (x-coordinates).

Piobabilty Density foutcome)
1.000
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4 For each additional vertex you want to change, move the cursor to the appropriate
location and left-click.

O In each case, the editor draws the new line segment, and erases any other data
points at the same abscissas (x-coordinates)

Probabilty Density fautcome]
1.000

0a7s

0750

0625

0500

0375

—
.,

End of Procedure 6-3
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Index
Symbols asterisk (*). See name wildcard
* (asterisk). See name wildcard async_cmd_mode preference, ITR-2-47
.icons suffix, ITR-4-1 async_cmd_port preference, ITR-2-47
async_cmd_trace preference, ITR-2-47
A .atc.m file type suffix, ITR-1-22
abscissa attr_reqs_file preference, ITR-3-23
i auto_fire preference, ITR-3-47
setting bounds, ITR-6-6 auto_play preference, ITR-3-41
.ac file type suffix, ITR-1-21 —Play p ’
.ac.i file type suffix, ITR-1-21
.ace.f file type suffix, ITR-1-21 B
.ace.hm file type suffix, ITR-1-21 backup directory (bk), ITR-1-13
.ace.ic.txt file type suffix, ITR-1-21 backup_interval environment attribute, ITR-1-13
.ace.mt.txt file type suffix, ITR-1-21 backup_interval preference, ITR-2-44
.ace.gpb file type suffix, ITR-1-21 to ITR-1-22 backup_max_count environment attribute,
.ace.qps file type suffix, ITR-1-21 ITR-1-13 t0 ITR-1-14
.ace.rt.txt file type suffix, ITR-1-21 backup_max_count preference, ITR-2-45
.ace_dict file type suffix, ITR-1-21 bagkups
.ad.m file type suffix, ITR-1-21 file name formats, ITR-1-14
adding interval, ITR-1-13
keyboard shortcut, ITR-1-27 version, 'TR'l'_13
optional operation, ITR-1-27 to ITR-1-28 beep_count_confirm preference, ITR-2-43
administration directory (op_admin), ITR-1-12 beep_count_error preference, ITR-2-43
organization, ITR-1-13 Bernoulli distribution, ITR-5-2
.af file type suffix, ITR-1-21 bgutil_errlog_incident_limit preference, ITR-3-48
.agents file type suffix, ITR-1-22 bgutil_gbu_bucket_size preference, ITR-3-48
.ah file type suffix, ITR-1-22 bgutil_gbu_bucket_type preference, ITR-3-48
.alias file suffix, ITR-1-22 bgutil_gbu_file_list preference, ITR-3-48
aliases_verify preference, ITR-3-47 bgutil_gbu_from_time preference, ITR-3-48
all preference, ITR-3-13 bgutil_gbu_overwrite preference, ITR-3-49
an_mono_sym preference, ITR-3-47 bgutil_gbu_to_time preference, ITR-3-49
anim atte_mpts preference, ITR-3-21 bgutil_ignore_alias_case preference, ITR-3-49
anim_hist preference, ITR-3-22 bin directory. See binary directory
anim_host preference, ITR-3-22 binary directory (bin), ITR-1-7
anim_port preference, ITR-3-22, ITR-3-41 bind_shobj_flags preference, ITR-2-29
anim_timeout preference, ITR-3-22 bind_shobj_flags_devel preference, ITR-2-29
anim_view preference, ITR-3-23 bind_shobj_flags_optim preference, ITR-2-30
annot_fonts.large preference, ITR-2-46 b?”d—ShObl:—l?bS preference, ITR-2-30
annot_fonts.medium preference, ITR-2-46 bind_shobj_libs_devel preference, ITR-2-30
annot_fonts.small preference, ITR-2-47 bind_shobj_libs_optim preference, ITR-2-31
Annotate Model bind_shobj_prog preference, ITR-2-31
fonts, ITR-2-8 bind_static_flags preference, ITR-2-31
app_name preference, ITR-3-13 bind_static_flags_devel preference, ITR-2-31
apply_all_aliases preference, ITR-3-47 bind_static_flags_optim preference, ITR-2-32
<<arch> directory. <italic>See architecture directory bind_static_libs preference, ITR-2-32
arch_suffix preference, ITR-2-16 bind_static_libs_devel preference, ITR-2-32
architecture (file name suffix), ITR-1-20 bind_static_libs_optim preference, ITR-2-33
architecture codes (table), ITR-1-20 bind_static_prog preference, ITR-2-33
architecture directory (<arch>), ITR-1-7 binomial distribution, ITR-5-3
organization, ITR-1-7 bk directory. See backup directory
.as file type suffix, ITR-1-22 .bkg.i file type suffix, ITR-1-22
assignment precedence. See precedence Blend operation (Color Palette Editor), ITR-4-12
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.bmp file type suffix, ITR-1-22
boolean value

on command line, ITR-2-4
browser_prog preference, ITR-2-48
buffered_tfile_types preference, ITR-2-45
buttons. See also icons.

C
c preference, ITR-3-23
C shell
environment variable syntax, ITR-2-5
C++ code
compiling, ITR-2-29
.cds file type suffix, ITR-1-22
check_newer_process_model_files preference, ITR-2-33
check_subnet_bounds preference, ITR-2-48
checksum preference, ITR-3-14
child_id preference, ITR-3-23
chi-square distribution, ITR-5-4
.cml file type suffix, ITR-1-22
code type (file name suffix), ITR-1-20
code_editor_prog preference, ITR-2-48
collect_model_deps_in_file preference, ITR-3-24
color
user interface, ITR-2-73
Color Palette Editor (Image Editor), ITR-4-11
command line flag
dash-preceded value, ITR-2-4
negative value, ITR-2-4
preferences, ITR-2-3
wildcard, ITR-2-13
comment
in environment file, ITR-2-9
comments_add preference, ITR-3-14
comments_del preference, ITR-3-14
comments_print preference, ITR-3-14
comp_flags_c++_specific preference, ITR-2-33
comp_flags_c_specific preference, ITR-2-34
comp_flags_common preference, ITR-2-34
comp_flags_devel preference, ITR-2-35
comp_flags_mt preference, ITR-2-35
comp_flags_optim preference, ITR-2-36
comp_globals_export preference, ITR-2-36
comp_per_process_errors preference, ITR-2-37
comp_prog preference, ITR-2-37
comp_prog_cpp preference, ITR-2-37
comp_target_type.development_parallel_32 preference,
ITR-3-49
comp_target_type.development_parallel_64 preference,
ITR-3-49
comp_target_type.development_sequential_32 preference,
ITR-3-50
comp_target_type.development_sequential_64 preference,
ITR-3-50

comp_target_type.optimized_parallel_32 preference,
ITR-3-50

comp_target_type.optimized_parallel_64 preference,
ITR-3-51

comp_target_type.optimized_sequential_32 preference,
ITR-3-51

comp_target_type.optimized_sequential_64 preference,
ITR-3-51

comp_trace_info preference, ITR-2-37

compatibility models directory (compat), ITR-1-11

configs directory. See configuration directory

configuration directory (configs), ITR-1-8

console preference, ITR-2-48

console_exit_pause preference, ITR-2-16

constant distribution, ITR-5-5

Contrast operation (Color Palette Editor), ITR-4-12

contrib directory. See contributed models directory

contributed models directory (contrib), ITR-1-11

core file, ITR-2-38

core_dump preference, ITR-2-38

cosim preference, ITR-3-24

cosimulation
controlling speed, ITR-3-33

creation_mode preference, ITR-2-48

.csv file type suffix, ITR-1-22

D

dbx UNIX debugger, ITR-2-38

dconfirm preference, ITR-2-16

debug preference, ITR-3-24

debug_mk preference, ITR-2-38

default model directory, ITR-1-19

.demand.d file type suffix, ITR-1-22

.demand.m file type suffix, ITR-1-22

dev32, ITR-1-20

dev64, ITR-1-20

development preferences, ITR-2-28

diag_enable preference, ITR-2-43

diagnostics preferences, ITR-2-43

.dict file type suffix, ITR-1-22

disable_message_confirmations preference, ITR-2-49

disable_message_tips preference, ITR-2-49

disable_object_operations preference, ITR-2-49

disable_object_palette_configuration preference, ITR-2-49

disable_object_palette_model_properties_display
preference, ITR-2-49

disk_cleanup.clean_automatically preference, ITR-3-51

disk_cleanup.clean_duplicate_scenarios preference,
ITR-3-52

disk_cleanup.clean_duplicate_scenarios_days preference,
ITR-3-52

disk_cleanup.clean_error_log preference, ITR-3-52

disk_cleanup.clean_error_log_days preference, ITR-3-52

disk_cleanup.clean_session_log preference, ITR-3-53

disk_cleanup.clean_session_log_days preference, ITR-3-53
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disk_cleanup.clean_temporary_files preference, ITR-3-53 environment database (env_db), ITR-2-7
disk_cleanup.clean_temporary_files_days preference, editing, ITR-2-7

ITR-3-53 ignoring, ITR-2-24
display preference, ITR-2-50 environment file, ITR-2-8
distribution, ITR-5-1 comments, ITR-2-9

predefined, ITR-5-1 example, ITR-2-9
doc directory. See documentation directory location, ITR-2-10
documentation specifying, ITR-2-17

setting viewer path name, ITR-2-76 syntax, ITR-2-7
documentation directory (doc), ITR-1-9 envp preference, ITR-2-19
double exponential distribution, ITR-5-11 Eraser tool (Image Editor Tool Palette), ITR-4-4
doubleclickinterval preference, ITR-2-50 Erlang distribution, ITR-5-6
drag_obj_threshold preference, ITR-2-50 error log (err_log), ITR-3-44
Dropper tool (Image Editor Tool Palette), ITR-4-4 access by op_vuerr, ITR-3-43
duration preference, ITR-3-24 .esd.m file type suffix, ITR-1-22
dynamic preference, ITR-2-8, ITR-2-11 etc directory. See miscellaneous directory

automatic promotion, ITR-2-14 .ets file suffix, ITR-1-8, ITR-1-27

displaying value, ITR-2-17 .ets file type suffix, ITR-1-22

multiple assignment, ITR-2-12 .ets.so file type suffix, ITR-1-22

properties, ITR-2-11 ets_options preference, ITR-3-54

event_order_method preference, ITR-3-25

E event_speed_parameter preference, ITR-3-25, ITR-3-54
.edge file suffix, ITR-1-22 exception handling, ITR-2-20
edit line graph (antenna pattern editor), ITR-6-9 expanded_subnets_iconic preference, ITR-2-54
edit_attr_undo_warning_prompt preference, ITR-3-54 expanded_subnets_thickness preference, ITR-2-54
edit_lock preference, ITR-3-15 exponential distribution, ITR-5-7
edit_lock_mode preference, ITR-2-79 external text editor, ITR-2-53
edit_pad.default_height preference, ITR-2-51 extreme value distribution, ITR-5-8
edit_pad.default_width preference, ITR-2-51
edit_pad.drag_and_drop preference, ITR-2-51 F
edit_pad.font preference, ITR-2-51 f preference, ITR-3-15
edit_pad.selection_background_color preference, ITR-2-51 fast normal distribution, ITR-5-14
edit_pad.selection_color preference, ITR-2-52 file
edit_pad.show_line_number preference, ITR-2-52 name
edit_pad.text_background_color preference, ITR-2-52 architecture code, ITR-1-20
edit_pad.text_color preference, ITR-2-52 file name
edit_pad.word_wrap preference, ITR-2-52 code type, ITR-1-20
edit_unlock preference, ITR-3-15 versioning in, ITR-1-19
editor file preferences, ITR-2-44

external, ITR-2-53 file system, ITR-1-2
editor_config preference, ITR-2-53 file_import_read_suppress preference, ITR-3-54
editor_keep preference, ITR-2-53 file_read_abort_suppress preference, ITR-2-45
editor_prog preference, ITR-2-53 Fill tool (Image Editor Tool Palette), ITR-4-4
.ef file suffix, ITR-2-9 Filled Ellipse tool (Image Editor Tool Palette), ITR-4-5
.ef file type suffix, ITR-1-22 Filled Rectangle tool (Image Editor Tool Palette), ITR-4-5
ef preference, ITR-2-17 find preference, ITR-3-15
.el file type suffix, ITR-1-22 .fl.m file type suffix, ITR-1-22
Ellipse tool (Image Editor Tool Palette), ITR-4-5 fl.x file type suffix, ITR-1-22
.em.x file type suffix, ITR-1-22 flow_import_errlog_incident_limit preference, ITR-3-55
ema_verbose preference, ITR-2-38 FLS—See Licensing, ITR-2-78
emacs editor, ITR-2-53 fn_x_<font>_<size> preferences, ITR-2-7
endsim_memstats preference, ITR-3-25 fn_x_annot_<size> preferences, ITR-2-8
env_db preference, ITR-2-18 font
env_db. See environment database display, ITR-2-7
enva preference, ITR-2-18 model annotation, ITR-2-8
IT Guru/Release 11.0 ITR-IX-3
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font preference, ITR-2-54

force_posix_locale preference, ITR-2-45

Foreground/background colors (Image Editor Tool Palette),
ITR-4-5

from_f preference, ITR-3-16

from_mf preference, ITR-3-16

fsbitmap file prefix, ITR-1-15

FTP (OPNET site), ITR-1-11

fully_serialized_event_execution_ids preference, ITR-3-26

fully_serialized_event_ids preference, ITR-3-26

fully_serialized_ici_ids preference, ITR-3-26

fully_serialized_packet_ids preference, ITR-3-27

G
gamma distribution, ITR-5-9
.gdf file type suffix, ITR-1-22
geocentric_model preference, ITR-2-20
geometric distribution, ITR-5-10
.gif file type sulffix, ITR-1-22
graphic user interface

preferences, ITR-2-46
GUI. See graphic user interface
Gumbel distribution, ITR-5-8

H

.h file suffix, ITR-1-8

Hand tool (Image Editor Tool Palette), ITR-4-4
handle_exception preference, ITR-2-20

Harvard Network Device Test Laboratories, ITR-1-11
.hcon.I file type suffix, ITR-1-22

header files, ITR-1-8

header_add preference, ITR-3-16

header_print preference, ITR-3-17

header_repair preference, ITR-3-17

header_update preference, ITR-3-17

help preference, ITR-2-20

hierarchical naming, ITR-2-12

.hip file type suffix, ITR-1-22

HNDTL, ITR-1-11

hpov_default_server preference, ITR-3-55

.html file type suffix, ITR-1-23
html_export_max_image_width preference, ITR-2-54
http_port preference, ITR-2-54

I
i0 architecture code, ITR-1-20
.ia file type suffix, ITR-1-23
.ic.m file type suffix, ITR-1-23
icon

missing, ITR-1-9
icon database

files, ITR-4-1

closing, ITR-4-2

opening, ITR-4-2
saving, ITR-4-2

precedence, ITR-1-8

program (<program>.icons), ITR-1-9

specifying directories, ITR-2-22

system (sys.icons), ITR-1-9

user, ITR-1-9
Icon Database Editor

operations, ITR-4-2
icon directory (icons), ITR-1-8
icon editor. See Icon Database Editor, Image Editor
icon_autosizing.disable preference, ITR-2-55
icon_autosizing.large_element_count preference, ITR-2-55
icon_autosizing.max_neighbors preference, ITR-2-55
icon_dbs environment attribute, ITR-1-9
icon_dbs preference, ITR-2-55
icons

closing, ITR-4-6

colors of, ITR-4-11

creating, ITR-4-2

deleting, ITR-4-2

displaying, ITR-4-9

exporting, ITR-4-6 to ITR-4-7

font used, ITR-4-11

importing, ITR-4-6

modifying, ITR-4-2, ITR-4-8

naming, ITR-4-2

reverting, ITR-4-6

setting the size, ITR-4-6

transparency of, ITR-4-11
icons directory. See icon directory
.icons file type suffix, ITR-1-23
image directory (images), ITR-1-9
Image Editor

operations, ITR-4-3
.image file type suffix, ITR-1-23
image_capture.border_width preference, ITR-2-56
image_capture.include_window_title preference, ITR-2-56
image_capture.screen_hot_key preference, ITR-2-56
image_capture.show_in_browser preference, ITR-2-56
image_capture.window_hot_key preference, ITR-2-57
.imp.log file type suffix, ITR-1-23
import_default_interface_type preference, ITR-3-55
import_default_machine_type preference, ITR-3-55
import_mem_stats_log preference, ITR-3-56
impulse, ITR-6-5
include directory (include), ITR-1-8
installation, ITR-3-5
ip_address_change_notify_limit preference, ITR-3-56

J

javascript_enable preference, ITR-3-56
jitd_cmd_line preference, ITR-3-27
jitd_enable preference, ITR-3-27

ITR-1X-4
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K
kernel_type preference, ITR-2-39

L
Laplace distribution, ITR-5-11
Lasso tool (Image Editor Tool Palette), ITR-4-4
LD_LIBRARY_PATH system environment variable, ITR-1-7
lib directory. See library directory
library directory (lib), ITR-1-7
license_server_kill preference, ITR-3-9
licenses, ITR-3-7
Licensing

preferences, ITR-2-78
line graph

drawing, ITR-6-9

editing, ITR-6-9

modifying, ITR-6-11

using before and after smoothing, ITR-6-8
Line tool (Image Editor Tool Palette), ITR-4-4
Line width palette (Image Editor Tool Palette), ITR-4-5
livelock_thresh preference, ITR-3-27
Ik.d file type suffix, ITR-1-23
Ik.m file type suffix, ITR-1-23
load_image preference, ITR-2-57
log_endsim_perf preference, ITR-3-28
log_file preference, ITR-3-28
logistic distribution, ITR-5-12
lognormal distribution, ITR-5-13
lower abscissa bound

setting, ITR-6-6
lower ordinate bound

setting, ITR-6-6
Ipr UNIX command, ITR-2-78

M
m preference, ITR-3-17, ITR-3-42
.m.conv file type suffix, ITR-1-23
.ma file type suffix, ITR-1-23
ma_errlog_incident_limit preference, ITR-3-56
manage license mode, ITR-3-6
manage_licenses preference, ITR-3-6, ITR-3-57
.map.i file type suffix, ITR-1-23
map_backing_store preference, ITR-3-42
mark_nondefault_attrs preference, ITR-2-57
mark_nondefault_attrs.changed_color preference, ITR-2-57
mark_nondefault_attrs.intended_color preference, ITR-2-58
Mask Selection operation (Image Editor), ITR-4-13
max_log_entries preference, ITR-3-28
.mce.m file type suffix, ITR-1-23
.md.m file type suffix, ITR-1-23
mem_clear preference, ITR-2-21
mem_optimize preference, ITR-2-21
mem_track preference, ITR-3-28 to ITR-3-29

of simulation executable, ITR-2-40
mem_track_object preference

of simulation executable, ITR-2-40
memory access exceptions, ITR-2-20
memory allocation

optimized, ITR-2-21
memstat_autogen preference, ITR-3-29
memtag_all preference, ITR-3-29
memtag_list preference, ITR-3-30
message file

in tmp directory, ITR-1-15

name format, ITR-1-15
mf preference, ITR-3-18
.mid file type suffix, ITR-1-23
.mif file type suffix, ITR-1-23
miscellaneous directory (etc), ITR-1-8
missing icon, ITR-1-9
mod_dirs environment attribute, ITR-1-17

directory precedence, ITR-1-18

icon databases, ITR-1-8

usage, ITR-1-18
mod_dirs preference, ITR-2-22
model directories, ITR-1-10, ITR-1-17

compat, ITR-1-11

contributed, ITR-1-11

default, ITR-1-19

organization, ITR-1-17

search order, ITR-1-18

specifying, ITR-2-22

standard, ITR-1-10

tutorial, ITR-1-11

vendor models, ITR-1-11
model security

information, ITR-3-17

transferring registration, ITR-3-16
model_assistant_adjust_view_after_apply preference,

ITR-3-57
model_assistant_configuration_file preference, ITR-3-57
model_name preference, ITR-2-58
modeler.splash_image preference. See splash_image

preference
models directory (models), ITR-1-10
models directory (op_models)

creation, ITR-1-17
move_delta preference, ITR-2-58
mtdev32, ITR-1-20
mtdev64, ITR-1-20
mtopt32, ITR-1-20
mtopt64, ITR-1-20

N
name
hierarchical, ITR-2-12
wildcard, ITR-2-13
command line, ITR-2-13
wildcard (example), ITR-2-13
named_locks preference, ITR-2-80
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.nd.d file type suffix, ITR-1-23

.nd.m file type suffix, ITR-1-23

.nds file type suffix, ITR-1-23

negative value, ITR-2-4

net_name preference, ITR-3-30

net_report_link_detail_attrs preference, ITR-3-57

net_report_link_summary_attrs preference, ITR-3-58

net_report_link_tooltip_alias preference, ITR-3-58

net_report_node_detail_attrs preference, ITR-3-58

net_report_node_summary_attrs preference, ITR-3-58

net_report_node_tooltip_alias preference, ITR-3-59

netbiz_show_promote_button preference, ITR-2-58

network_add_world_map_to_new_models preference,
ITR-2-59

network_diff.default_live_spec preference, ITR-3-59

network_diff.default_report_spec preference, ITR-3-59

network_diff.output dir preference, ITR-3-59

network_diff.suppress_live_legend preference, ITR-3-59

network_layout.adjust_unconnected_groups preference,
ITR-2-59

network_layout.max_overlap_links_to_bend preference,
ITR-2-59

network_layout.use_simple_threshold preference, ITR-2-59

network_links_infer_threshold preference, ITR-2-60

network_palette preference, ITR-3-60

network_palette.fixed_subnet_icon preference, ITR-3-60

network_palette.group_aggregation preference, ITR-3-60

network_palette.keep_above preference, ITR-3-61

network_palette.mobile_subnet_icon preference, ITR-3-61

network_palette.only_one preference
of opnet, ITR-3-61

network_palette.satellite_subnet_icon preference
of opnet, ITR-3-61

network_path_add_subnet_single_left_click preference,
ITR-2-60

network_positions_in_deg_min_sec preference, ITR-2-60

network_show_links_to_parent_subnet_objects preference,
ITR-2-60

network_use_trx_prompt preference, ITR-2-61

network_visualization.minimized_icon_pixel_threshold
preference, ITR-2-61

network_visualization.minimized_icon_size preference,
ITR-2-61

network_visualization.show_demand_labels preference,
ITR-2-61

network_visualization.show_labels_icon_pixel_threshold
preference, ITR-2-62

network_visualization.show_link_arrowheads preference,
ITR-2-62

network_visualization.show_link_labels preference, ITR-2-62

network_visualization.show_node_labels preference,
ITR-2-62

network_visualization.show_path_labels preference,
ITR-2-63

new_env_db preference, ITR-2-23

nmx_no_dynamic preference, ITR-3-62

no_env_db preference, ITR-2-24

noprompt keyword, ITR-2-14

noprompt preference, ITR-2-24

normal distribution, ITR-5-14

notepad editor, ITR-2-53

.nt.log file suffix, ITR-1-23

.nt.m file type suffix, ITR-1-23

.nt.so file type suffix, ITR-1-23
nt_model_post_conversion_library preference, ITR-3-62
nt_model_post_conversion_proc preference, ITR-3-62
nt_model_pre_conversion_library preference, ITR-3-62
nt_model_pre_conversion_proc preference, ITR-3-63
ntgfx file prefix, ITR-1-15

ntrep file prefix, ITR-1-15

num_collect_values preference, ITR-3-30, ITR-3-63
num_err preference, ITR-3-45

@)
obj_dbox_headers preference, ITR-2-63
.of file type suffix, ITR-1-23
op_admin directory. See administration directory
op_clrtmp script, ITR-3-3
op_clrtmp.bat batch file, ITR-3-3
op_edicon. See Icon Database Editor, Image Editor
op_flse program, ITR-3-4
op_install shell script, ITR-3-5
op_license_manager shell script, ITR-3-6
op_license_serverprogram, ITR-3-7
op_license_utilprogram, ITR-3-8
op_manfile program, ITR-3-10
operations summary, ITR-3-11
preferences, ITR-3-12
op_runsim program, ITR-3-20
preferences, ITR-3-21
op_vuanim program, ITR-3-40
preferences, ITR-3-41
op_vuerr
program, ITR-2-38
op_vuerr program
preferences, ITR-3-45
operations
Icon Database Editor, ITR-4-2
Image Editor, ITR-4-3
OPNET
installation procedure, ITR-3-5
OPNET directory (<opnet_dir>), ITR-1-4
organization, ITR-1-4
ownership, ITR-1-4
sharing, ITR-1-4
OPNET FTP site, ITR-1-11
<opnet_dir> directory. See OPNET directory
opnet_dir preference, ITR-2-25
opnet_port preference, ITR-3-30
opnet_user_home preference, ITR-2-25
opt32, ITR-1-20
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opt64, ITR-1-20
optimized memory allocation, ITR-2-21
optional operation

adding, ITR-1-27 to ITR-1-28
.orb file type suffix, ITR-1-23
orbit_draw_style preference, ITR-2-63
ordinate

setting bounds, ITR-6-6
.0s file type suffix, ITR-1-23
os_file preference, ITR-3-31
.ot file type suffix, ITR-1-23
.off file type suffix, ITR-1-23
.ov file type suffix, ITR-1-24
ov_diff_tolerance preference, ITR-2-40
ov_file preference, ITR-3-31
ov_frag_size preference, ITR-3-31
ov_mem_size preference, ITR-2-41
.ovd file type suffix, ITR-1-24

P
.pa.m file type suffix, ITR-1-24
panels_close_behavior preference, ITR-2-64
panels_tile_columns_size preference, ITR-2-64
panels_tile_rows_size preference, ITR-2-64
panels_tile_sizing_automatic preference, ITR-2-64
panels_tile_spacing preference, ITR-2-65
panels_tile_x_size preference, ITR-2-65
panels_tile_y_size preference, ITR-2-65

parallel_sim.event_execution_time_window preference,
ITR-3-31

parallel_sim.num_processors preference, ITR-3-32, ITR-3-63

Pareto distribution, ITR-5-15
password
encrypting, ITR-2-2
.path.d file type suffix, ITR-1-24
.path.m file type suffix, ITR-1-24
.pb.m file type suffix, ITR-1-24
.pbs.m file suffix, ITR-1-24
.pd.m file type suffix, ITR-1-24
.pd.s file type suffix, ITR-1-24
PDF
arguments, ITR-5-1
PDF editor
using toolbar buttons, ITR-6-4
.pdf file suffix, ITR-1-24
PDF. See probability density function (PDF)
PDF—See probability density function (PDF).
Pencil tool (Image Editor Tool Palette), ITR-4-4
per_module_random_stream preference, ITR-3-32
.pf.m file type suffix, ITR-1-24
Pick... operation (Color Palette Editor), ITR-4-12
Poisson distribution, ITR-5-16
portchk preference, ITR-3-9
PostScript file
name format

print output, ITR-1-15
power function distribution, ITR-5-17
.ppl.m file type suffix, ITR-1-24
.pps.m file type suffix, ITR-1-24
.pr.m file type suffix, ITR-1-24
precedence
of model directories, ITR-1-18
of preferences, ITR-2-1
preference, ITR-2-10
predefined distributions, ITR-5-1
preference
assignment mechanisms, ITR-2-3
command line flag, ITR-2-3
dash-preceded value, ITR-2-4
environment database, ITR-2-7
environment file, ITR-2-8
negative value, ITR-2-4
shell variable, ITR-2-5
common, ITR-2-1
data types, ITR-2-2
definition, ITR-2-1
displaying all
alphabetic order, ITR-2-18
precedence order, ITR-2-19
dynamic, ITR-2-8, ITR-2-11 to ITR-2-12
automatic promotion, ITR-2-14
displaying value, ITR-2-17
runtime prompt, ITR-2-14
wildcard, ITR-2-13
font, ITR-2-8
fonts, ITR-2-8
hierarchical name, ITR-2-12
name wildcard, ITR-2-13
precedence, ITR-2-1, ITR-2-10, ITR-2-19
program-specific, ITR-2-1
scope, ITR-2-1
spaces in name, ITR-2-9
static, ITR-2-8, ITR-2-11
displaying value, ITR-2-26
syntax
command line, ITR-2-4
environment file, ITR-2-7
shell variable, ITR-2-5 to ITR-2-6
wildcard, ITR-2-13
unassigned
automatic promotion, ITR-2-14
preference sets, ITR-2-27
development, ITR-2-28
diagnostics, ITR-2-43
file, ITR-2-44
GUI, ITR-2-46
Licensing, ITR-2-78
printing, ITR-2-78
standard, ITR-2-15
user lock, ITR-2-79
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web report, ITR-2-80

XML, ITR-2-82
preferences, ITR-2-7
primary model directory

definition, ITR-1-19
print_graph_method preference, ITR-2-79
print_page_limit preference, ITR-2-79
printcmd preference, ITR-2-78
printername preference, ITR-2-79
printing

preferences, ITR-2-78
.prj file type suffix, ITR-1-24
probability density function (PDF)

before and after adding an impulse, ITR-6-5

before and after normalizing, ITR-6-6

description, ITR-6-5

editing, ITR-6-8

editor, ITR-6-1

graph, ITR-6-1

menu, ITR-6-3, ITR-6-5

normalizing, ITR-6-6

table

editing, ITR-6-8

with different resolutions, ITR-6-7
probe preference, ITR-3-32
probe_error_enable preference, ITR-3-32
probe_start_time preference, ITR-3-33
probe_stop_time preference, ITR-3-33
product preference, ITR-3-63
product_options preference, ITR-3-64
prof_output preference, ITR-2-41
prof_output_separator preference, ITR-2-41
prof_track preference, ITR-2-41
prof_track_func preference, ITR-2-42
prof_track_recurse preference, ITR-2-42
program abort, ITR-3-43
program fault, ITR-3-43
program icon database (<program>.icons). See icon

database, program
program_banner preference, ITR-2-65
program_resources preference, ITR-2-65
progress_bar_positioning preference, ITR-2-42
project_backup_on_dont_save preference, ITR-2-66
project_editable_attributes preference, ITR-2-66
project_readonly preference, ITR-2-66
promotion

of dynamic attribute, ITR-2-14
.prop.d file type suffix, ITR-1-24
.prop.p file type suffix, ITR-1-24
.prop.r.so file type suffix, ITR-1-24
ptc file prefix, ITR-1-15
Purify

suppressing memory optimization, ITR-2-21
.py file type suffix, ITR-1-24
.pyc file type suffix, ITR-1-24

R
Ramp operation (Color Palette Editor), ITR-4-12
rand_num_ext_res preference, ITR-3-33
Rayleigh distribution, ITR-5-18
realtime_ratio preference, ITR-3-33
rec_err_suppress preference, ITR-2-44
recent_files_limit preference, ITR-2-66
Recently used colors (Image Editor Tool Palette), ITR-4-5
record_gstats preference, ITR-3-34
recoverable error, ITR-3-43
Rectangle tool (Image Editor Tool Palette), ITR-4-5
register preference, ITR-3-18
rehash operation
and model storage, ITR-1-19
release directory (<reldir>), ITR-1-5
organization, ITR-1-5
release number
in file names, ITR-1-13
Remap To Closest Color operation (Color Palette Editor),
ITR-4-12
.pbr.m file suffix, ITR-1-24
report_top_n preference, ITR-2-66
reports preference, ITR-3-34
.repos file type suffix, ITR-1-24
.repos.so file type suffix, ITR-1-24
repositories preference, ITR-3-34, ITR-3-64
root
ownership of <opnet_dir>, ITR-1-4
.rspdb file suffix, ITR-1-24
runtime prompt
for preference, ITR-2-14

S
sl architecture code, ITR-1-20
sample count, ITR-6-7
sampling resolution

setting, ITR-6-7
.sce.f file type suffix, ITR-1-24
.sce.m file type suffix, ITR-1-25
.sce.t file type suffix, ITR-1-25
.sce.x file type suffix, ITR-1-25
scenario_name preference, ITR-2-67
.scf file type suffix, ITR-1-25
.sched.log file type suffix, ITR-1-25
sconfirm preference, ITR-2-26
.sd file type suffix, ITR-1-25
.sddb file suffix, ITR-1-25
seed preference, ITR-3-35
.sel.f file type suffix, ITR-1-25
select_live_network preference, ITR-2-67
Selection tool (Image Editor Tool Palette), ITR-4-4
self_desc_validate preference, ITR-2-67
.seq file type suffix, ITR-1-25
set bounds operation

using, ITR-6-6
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.selset file type suffix, ITR-1-25
setting

color, ITR-2-73

documentation viewer path name, ITR-2-76
shade spectrum, creating. See Ramp operation (Color

Palette Editor)
shell variable

disabling automatic parsing, ITR-2-6

preferences, ITR-2-5
shortcuts

adding, ITR-1-27
show_ca_count preference, ITR-2-67
show_compilation_output preference, ITR-2-42
show_compilation_success_dialog preference, ITR-2-42
show_import_help preference, ITR-3-64
show_map_edit_mode_help_msg preference, ITR-3-65
show_units preference, ITR-2-68
.sim file type suffix, ITR-1-25
sim_duration_default preference, ITR-2-68
sim_packet_sharing preference, ITR-3-35
sim_process_priority preference, ITR-3-36
sim_time_quantum preference, ITR-3-36
site_position_cache_size preference, ITR-3-36
sla_compute_all_violations preference, ITR-3-36
sla_reports preference, ITR-3-37
smooth, ITR-6-8
software release

file names, ITR-1-13
specifying

boolean value on command line, ITR-2-4

dash-preceded value on command line, ITR-2-4

negative value on command line, ITR-2-4
splash_image preference, ITR-2-68
split_start_radio_transmission preference

of simulations, ITR-3-37
Spray Can tool (Image Editor Tool Palette), ITR-4-4
spreadsheet_prog preference, ITR-3-65
standard models directory (std), ITR-1-10

organization, ITR-1-10
standard preferences, ITR-2-15
static preference, ITR-2-8, ITR-2-11

displaying value, ITR-2-26

properties, ITR-2-11
static_bk_util.archive_dir preference, ITR-3-65
std directory. See standard models directory
suite preference, ITR-3-18
.supr.xml file type suffix, ITR-1-25
symmetrical distribution, ITR-5-19
syntax

preference

command line flag, ITR-2-4
shell variable, ITR-2-5 to ITR-2-6

sys directory. See system directory
sys.icons. See icon database, system
sys/unix/bin directory, ITR-1-7

system directory (sys), ITR-1-5
organization, ITR-1-6
sharing, ITR-1-5
specifying, ITR-2-25

system icon database (sys.icons). See icon database, system

system_window_behavior preference, ITR-2-68

T
.sched file suffix, ITR-1-25
temporary file

name formats, ITR-1-15
temporary file directory (tmp), ITR-1-14

clearing, ITR-3-3

contents, ITR-1-15
text editor

external, ITR-2-53
Text tool (Image Editor Tool Palette), ITR-4-4
.tim file suffix, ITR-1-25
title_autoplacing.directions preference, ITR-2-69
titte_autoplacing.disable preference, ITR-2-69
titte_autoplacing.try_small_font preference, ITR-2-69
tmp directory. See temporary file directory
Tool Palette (Image Editor), ITR-4-3
tool_name preference, ITR-2-69
tool_open_save_behavior preference, ITR-2-70
tool_open_start_dir preference, ITR-2-70
tool_override_dir_behavior preference, ITR-2-70
toolbar button, ITR-6-4

PDF editor, ITR-6-4
tooltip.annot_attributes preference, ITR-2-71
tooltip.demand_attributes preference, ITR-2-71
tooltip.link_attributes preference, ITR-2-71
tooltip.object_update preference, ITR-2-71
tooltip.path_attributes preference, ITR-2-72
tooltip.site_attributes preference, ITR-2-72
tooltip_delay preference, ITR-2-72
top_n_results_min_significant_digits preference, ITR-3-65
topology

node layout during import, ITR-2-59
traffic_archive_dir preference, ITR-3-65 to ITR-3-67
traffic_default_interval preference, ITR-3-66
traffic_import_suppress_unrecognized_sources_dialog

preference, ITR-3-66
traffic_preprocessor_args preference, ITR-3-66
traffic_servers preference, ITR-3-67
Transparencies (Image Editor), ITR-4-13
triangular distribution, ITR-5-19
trj file type suffix, ITR-1-25
tutorial models directory (tutorial), ITR-1-11
tutorial_top preference, ITR-2-72

U

ui.hide_all_windows preference, ITR-2-73

ui.remember_window_sizes_and_positions preference,
ITR-2-73
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ui_colors.tool_back preference, ITR-2-73
ui_colors.tool_fore preference, ITR-2-73

ui_colors.transparent_pixel_color preference, ITR-2-74

ui_fonts.header preference, ITR-2-74
ui_fonts.large preference, ITR-2-74
ui_fonts.medium preference, ITR-2-74
ui_fonts.small preference, ITR-2-74
ui_fonts.tiny preference, ITR-2-75
ui_layout.hide_buttons preference, ITR-2-75
undo_stack_size preference, ITR-3-67
uniform distribution, ITR-5-20
uniform integer distribution, ITR-5-21
UNIX

tmp directory, ITR-1-14
unix/bin directory, ITR-1-7
update_interval preference, ITR-3-37
upper abscissa bound

setting, ITR-6-6
upper ordinate bound

setting, ITR-6-6
.urep.xml file type suffix, ITR-1-25
use_metric preference, ITR-3-67
use_network_editor_warning preference, ITR-3-67
use_scenario_prompt preference, ITR-3-67
use_startup_wizard preference, ITR-3-68
use_tooltip_as_link_title preference, ITR-2-75
user icon database. See icon database, user
user lock preferences, ITR-2-79
user_lock preference, ITR-3-18
user_lock_devname preference, ITR-2-80
user_unlock preference, ITR-3-18

\%

.val.r file type suffix, ITR-1-25

.val.rpt file type suffix, ITR-1-25

.val.rr file type suffix, ITR-1-25

.val.xrpt file type suffix, ITR-1-25
value_notch_filter_tolerance preference, ITR-3-68
.vd.m file type suffix, ITR-1-25

.vdf file type suffix, ITR-1-25

vector_buf_size preference, ITR-3-42

Vendor models directory (vendor_models), ITR-1-11
verbose_cell_size_report preference, ITR-3-37
verbose_event_report preference, ITR-3-38
verbose_event_timing_report preference, ITR-3-38
verbose_load preference, ITR-3-38

verbose_mk preference, ITR-2-43

verbose_packet_report preference, ITR-3-38
verbose_parallel_speedup_report preference, ITR-3-39
verbose_report preference, ITR-2-75
verbose_session_log preference, ITR-2-46
verbose_sim preference, ITR-3-39

version (file name suffix), ITR-1-19

version_set preference, ITR-3-19

vi editor, ITR-2-53

W
warning (error type), ITR-3-43
warning_suppress preference, ITR-2-44
warnings

suppressing during compilation, ITR-2-44
.wdomain.d file type suffix, ITR-1-25
.wdomain.m file type suffix, ITR-1-25
web report preferences, ITR-2-80
Weibull distribution, ITR-5-22
wildcard. See name wildcard
win_height preference, ITR-2-76
win_width preference, ITR-2-76
win_x preference, ITR-2-76
win_x_inset preference, ITR-2-77
win_x_stagger preference, ITR-2-77
win_y preference, ITR-2-77
win_y_inset preference, ITR-2-77
win_y_stagger preference, ITR-2-77
window_icon preference, ITR-2-78
word_processing_prog preference, ITR-3-68
wrap_world_links preference, ITR-2-78
.wrec file type suffix, ITR-1-26
wrep_graph_enable preference, ITR-2-80
wrep_graph_height preference, ITR-2-81
wrep_graph_width preference, ITR-2-81
wrep_overwrite_reports preference, ITR-2-81
wrep_storage_dir preference, ITR-2-81

X

xml file type suffix, ITR-1-26

XML preferences, ITR-2-82
xml_export_postproc_function preference, ITR-2-82
xml_export_postproc_library preference, ITR-2-82
xml_export_postproc_verbose_attrs preference, ITR-2-82
xml_import_postproc_function preference, ITR-2-82
xml_import_postproc_library preference, ITR-2-83

xsl file type suffix, ITR-1-26
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